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�Scope



Description



This document provides a description of the concept of operation, requirements analysis, preliminary design and detailed design involved in implementation of the Tactical Automated Mission Planning System version 6.2 (TAMPS 6.2) integration of the Defense Intelligence Agency (DIA) Modernized Integrated Data Base version 2.0 (MIDB 2.0) product.  The integration of MIDB 2.0 into TAMPS 6.2 is being accomplished under the TAMPS 6.2 Statement of Requirements (SOR) 96-01a.



This SOR is highly interdependent with the MP LAN SOR (SOR 95-47) and the JSIPS-N Integration SOR (SOR 97-11).  The MP LAN SOR, among other tasks, has the responsibility to set up and maintain connections (both network and database) between the TAMPS CVIC Server and the Joint Maritime Command Information System (JMCIS) Central Database Server (CDBS), which will be used as the central point of processing in a TAMPS MP LAN/JMCIS configuration.  The JSIPS-N Integration SOR is interdependent with the MP LAN and MIDB SORs, since JSIPS-N will be depending on MP LAN to provide connectivity to the JSIPS-N workstations and the TAMPS server/client workstations and it will be depending on MIDB for connectivity to the TAMPS MIDB for GMI and target data.  JSIPS-N will be a consumer as well as a producer of TAMPS MIDB data.

Meaning of “Object Hierarchy”



Throughout this document, references are made to the TAMPS Object Hierarchy.  The following discussion is presented merely to clarify what we mean when we say “integrated into the Object Hierarchy”.  This has often been a point of misinterpretation, since numerous areas of TAMPS software create “in-line” objects that are static memory structures representing a pseudo-database/datatable.  While these types of objects do emulate the Object Hierarchy, they are not truly integrated into the Object Hierarchy, since a TAMPS DBA cannot modify the data attributes or actions of these objects.



If a data set is integrated into the object hierarchy, it means that objects are created with the TAMPS Object Editor and delivered with TAMPS Core to represent the data set.  This can be very extensive or very simplistic, depending on the data set and the requirements.  The Object Hierarchy is defined by a set of records in data base tables, defining the specific objects and query support data such as table joins.  These tables include the DD_QUERY, DD_CONDITIONS and DD_USER_COLUMNS, among others.



The TAMPS Query Tool is used to create a data base query on a single object in the Object Hierarchy.  Software can be written to retrieve results from data base tables, but this memo does not consider objects to be anything other than an “Object Editor - produced” object.  If you don’t need to use the TAMPS Query Tool to create a query to return results from a data base table, then there is no need to create an object which includes that table.  One other reason to create an object is when a different symbol is needed to represent a data entity.  In this case, a query will be built against one object, and the results will be displayed using the symbol defined for that object.  This object would have children defined with different symbols.  The “symbol specific” function would be used on the bucket containing the results to change the symbol to be the symbol used to define the children.  For example, we could define HAT as an object with children of SKULL CAP, BASEBALL CAP, DR SEUSS HAT, etc., assigning appropriate symbols to each object.  We could create a query against HATS to return all hats and use Symbol Specific to change the symbols to the specific ones defined for the children objects.  There is nothing to preclude creating a query against any object, but requirements determine the number of queries created and delivered with TAMPS Core.



An object is a definition of an data base entity with certain attributes and relationships to other objects.  An object has the following basic data:



Unique Name

Type (spatial or text)�Spatial objects have a single symbol defined for graphic display, a data base table used to extract the position of the object for graphic display, the data base columns used for quick amplifying information on the object, and the data base column used for pick resolution.

Data base tables which comprise the object

Columns within the data base tables which comprise the object

Data base column which is used to define the object

Value(s) of the data base column which is used to define the object

Relationship of the object with another object (child of a parent or an orphan)�This relationship data is important, since an object inherits many of its attributes from its parent.



The integration of the MIDB 2.0 product into the TAMPS 6.2 product will integrate the MIDB General Military Intelligence (GMI) database schema into the TAMPS Object Hierarchy.  This will provide the TAMPS user the extensibility and flexibility necessary to accomplish the various intelligence tasks involved in mission planning.  It will also allow for future growth in intelligence data queries and mission/threat situational awareness, since the queries and the objects can be modified and “tweaked” by sufficiently skilled TAMPS users.

MIDB Production, Query Processing and the TAMPS Object Hierarchy



Since the MIDB 2.0 product is a Government Off-The-Shelf (GOTS) product and we are trying to minimize the customization of that product, parts of the MIDB application software package will only be partially integrated into the TAMPS architecture.  The GMI data will be available through TAMPS Object Hierarchy  data objects as well as through the MIDB Query Processing data views provided as part of the MIDB product.  The dual path is required in order to integrate the MIDB Production software (which will be used to support the TAMPS Add/Edit capability), which requires a query capability in order to retrieve the correct data record from the MIDB GMI database.  While we could fully integrate the MIDB Production software into the TAMPS and use our query tool, the risk and cost was felt to be too high for the schedule available in the TAMPS 6.2 time frame.



�Concept of Operations (CONOPS)

Purpose



The purpose of this section is to describe how  the Modernized Integrated Data Base version 2.0 (MIDB 2.0) will be integrated into the Tactical Automated Mission Planning System version 6.2 (TAMPS 6.2). MIDB 2.0 replaces MIIDS/IDB as the national/theater production environment for general military intelligence (GMI) data. MIDB 2.0 also expands the role of its database schema to provide for additional tactical intelligence data, as opposed to the MIIDS/IDB national intelligence view; including local observation data, track data (time-dependent observation data), and target data.  MIDB 2.0 provides a set of Defense Intelligence Agency (DIA) approved software for processing (load, extract, query, add, modify, delete) the intelligence data.  Since the TAMPS Program is committed to being consistent with DOD standard databases and products, the DIA software used at the production sites, along with the intelligence database schema, will be used by TAMPS 6.2.



In the past, the Modernized Integrated Intelligence Data System/Integrated Data Base (MIIDS/IDB) has been the national/theater source for threat data within TAMPS.  Moreover, a single producer (AIC) has provided this data in a format readable by TAMPS software.  With the advent of MIDB 2.0, TAMPS, conceivably, will be able to receive intelligence data loads from any DIA approved MIDB 2.0 Shared Production Program (SPP) site; realistically, we expect TAMPS to still depend on the two major theater intelligence centers (AIC and JICPAC).  This means that TAMPS will no longer be tied to one intelligence center for initial data loads or transaction loads.  It will also allow the theater intelligence centers to produce theater loads for those TAMPS sites that need theater specific data, as long as that theater continues to provide later updates to the site.



In order to limit the affect of future MIDB database schema changes and software deliveries, TAMPS will provide the capability to install the MIDB software and databases separately from the TAMPS Core “cold start” procedures.  This will allow “patch” deliveries of DIA software as well as limit the affect of MIDB schema changes on TAMPS users.  It will also allow the TAMPS software to be installed on a workstation that does not have the necessary hard disk space and memory for running the MIDB products.   Because of this, MIDB will be treated somewhat differently than most Core libraries and applications.  All interfaces between MPMs, TAMPS Core and the MIDB software will be through a TAMPS-MIDB Application Programmer’s Interface (API).  Some of this interface will be public to all applications (both Core and MPM), but parts of it will be an internal interface between Core and MIDB.  Also, all objects within the Object Hierarchy representing MIDB database tables will be installed as part of the MIDB installation.  When the MIDB is not loaded on a TAMPS workstation, the Object Hierarchy objects, affected menu items, queries, and HMI will be unavailable for use.  Queries (including those referenced directly from the TAMPS menus, such as threat queries) will be available for selection by the operator, but will display an error message indicating that MIDB has not been installed.

Impact Analysis

Users

There are three general categories of TAMPS users: System Administrator, Data Base Administrator, and Mission Planner.  Most of the impacts from the MIDB integration will be felt by the System Administrator and the Database Administrator.  The impacts to the Mission Planner, other than some minor HMI changes, should be minimal.

System Administrators



Since MIDB is planned to be “installable”, the System Administrator will be required to install the TAMPS MIDB software package.  The SA will have the option of installing MIDB as part of the TAMPS arctic start process or at a later time, when the system is fully operational.  If the MIDB is not installed at arctic start, then the SA will be capable of installing the MIDB database and application software at run time from the TAMPS installation media.  Depending on the TAMPS installation type, one of three types of MIDB systems, a Server MIDB, a workstation MIDB, or a remote MIDB, will be installed. When the SA installs MIDB, the menu items and HMI related to MIDB query and maintenance will become available when next executed. Any current applications, either on the workstation or on the MP LAN (if configured for LAN operations) would have to be stopped and restarted.  Because of this and the possibility of system performance degradation during installation, it is likely that the MIDB would have to be installed in a system maintenance mode and not during normal run-time operations (the installation scripts will verify that the system is in the proper state).  One of the changes implied by the installable nature of MIDB is that the Sybase database file system will no longer be a “raw” Unix partition, the database will live on a regular Unix file system in a “container” file.  This allows for significant flexibility in defining our database layout, as well as allows for ad hoc allocation of file system space for database growth.



Although MIDB has its own access control methodology, that will not be used as a method of access control for TAMPS users.  A new TAMPS privilege will be added to indicate which TAMPS users should have access to the MIDB Editor applications.   The SA will have the added responsibility to assign the correct MIDB roles and privileges to users when creating user accounts.  In a JMCIS configuration, the SA will also have the responsibility of coordinating with the JMCIS SA to set up user access to the JMCIS CDBS MIDB.

Database Administrators



One of the TAMPS DBAís many roles is to ensure that threat and target data in TAMPS is as accurate as possible to support mission planning.  Currently, this involves loading IDB data from tape, requesting and processing tactical IDB updates from JMCIS, and manually updating IDB and targets.  In a stand-alone TAMPS environment, the workload will not be any different, only the tools will change.  



Loading from tape will have to be more selective because of the size and complexity of MIDB.  TAMPS currently loads a country of data at a time, and every record from every table for that country.  However, most MPMs and users access a very limited amount of this data.  DIA has recommended that systems selectively load the required tables.  Filtration by country code is under development by the producer and is expected to be available in time for TAMPS 6.2 utilization.



In a TAMPS MP LAN/JMCIS environment (further known as the ìafloatî configuration), the DBAís workload will be lowered with respect to threat data maintenance.  While in an ìafloatî configuration, all updates to the MIDB intelligence data will be performed against the JMCIS CDBS, and the TAMPS CIVIC Server’s MIDB will be updated via a Sybase Replication server installed on the JMCIS CDBS, thereby eliminating the need for maintenance of threat data on both JMCIS and TAMPS.  This means that the DBA will not have to request tactical updates from the JMCIS CDBS and then apply those updates to the TAMPS database. 



Sybase Replication as a networked method of theater data support will eventually be available from the supporting theater, but it is not addressed in this document due to the immaturity of this within the MIDB environment.  In the currently envisioned ìafloatî configuration, there will be replication between JMCIS and TAMPS.  IDBTFs and manual updates will be processed by the JMCIS CDBS MIDB and updates will be replicated to the TAMPS CVIC Server MIDB.  For a stand-alone (ìashoreî) TAMPS configuration, the capability will exist to process IDBTFs via tape or from files resident on a disk drive.  We plan on using the DIA Data Exchange (DEX) software for both afloat and ashore bulk data loads or data extractions.



Manual updates to the MIDB will use DIA provided tools to support the “Add/Edit” capability currently provided with TAMPS.  The current TAMPS “Add/Edit” tools will be replaced by the DIA software.  In an ìafloatî configuration, ìadd/editî operations will be performed against the JMCIS CDBS MIDB, no modifications will be made directly to the TAMPS CIVIC Server’s MIDB. 



Archive/Restore capability for MIIDS/IDB will be modified to support MIDB; however, every attempt will be made to keep the user interface and processing the same.



It is expected that the Object and Query tools currently used in TAMPS will be used with appropriate modifications for MIDB tables.



Any attempted access to the MIDB, whether query, load, edit, dump/restore, when the MIDB has not been installed will display an error dialog indicating that the MIDB has not been installed. 

Mission Planners

Whether  utilizing MIIDS/IDB or MIDB, the planner expects the threat data to be accurate on the local TAMPS display on which the planning is being performed.  Currently, display of threat data is accomplished through several menu items under the “Threat/Intel” menu option off of the MPM main menu bar.  The same methodology is planned with MIDB.  The names appearing in the menu list may require change although a concerted effort will be made to map these menu items to MIDB equivalent data to minimize training impact.  Some of the query sub-menus may change due to consolidation of data within MIDB, e.g., the SAM query menu’s “Fixed”, “Tactical”, and “Unit” sub-options will most likely be replaced with a single list of SAMs (i.e., SA-2, SA-3, SA-8, etc.), the AAA query menu’s “Facility”, “Unit Equipment”, and “Fire Control Radars” sub-options will also be replaced by a single list of AAA equipment.  The “Air” OOB query menu will have the “Select” pushbutton replaced with a cascade menu, since the “Select” pushbutton has hidden this functionality from most users.



Since we are not integrating the MIDB mapping software, there should be no change to what the planner sees on the MPM’s map when an object is displayed through the TAMPS Display Manager software.  The data behind the symbol should still be the same “kind” of data, although individual field names will change due the conversion from the MIIDS/IDB schema to the MIDB schema.



The Amp Info functionality will display different field names than those used in MIIDS/IDB.  These changes are not expected to particularly impact the planners as the names are at least as intuitive as those currently used. One of the planned improvements for Amp Info will be normalization of the Location fields on the Amp Info display,  currently the Lat/Lon data is displayed as character strings with separate hemisphere data in an intuitive format.  Since MIDB added a new format for its internal storage of location data, we had to support the new format or provide a standard location display for all spatial objects.  The latter choice makes more sense.  The standard location display in Amp Info dialogs will match the user’s chosen defaults and will be applicable across all types of spatial data within TAMPS.



The threat equipment codes, which drives the Range Ring and Radar Terrain Mask generation functions is available in MIDB.  These two functions should not be affected, although the object definitions for applicable objects will have to be modified.  The mission planner shouldn’t notice any difference.



The OOB Report (Output->Reports->System->OOB) will be removed from TAMPS, as it does not provide any more detail (and can often give incorrect data) than displaying the OOB data on the MPM map and creating a text report through the use of the Clutter/Declutter Tool.  The Target Report will remain, although the columns available will change.



Currently, we plan on maintaining the capability to create and/or process OBREP and TACELINT message traffic.  There has been some discussion about the validity of the current message generation software and, if it is determined that the software is inaccurate, then there will be more major changes required.



When MIDB added tactical intelligence data support, it also added target and weaponeering tables which were not provided with IDB. Target definitions are considerably more detailed than in TAMPS and provide some of the supporting fields for SPWM/JMEM data fill.  Since a mission planner still requires the capability to add & modify target data, there will be two target data sets, one within control of the MIDB software and one within control of the TAMPS software.  Both target data sets will use the MIDB target data schema.  The MIDB target data set will be used to support external target data creators (i.e., JSIPS-N, CTAPS, RAAP), while the TAMPS target data set will support the mission planner who needs to create a “local” target record.  When a planner selects an MIDB target for use in a mission, that target will be copied into the TAMPS target data set and an association will be created between the mission and the TAMPS target data set.  In order to ensure that the most recent target is being used when a planner opens a previously created mission, an “obsolete data” check capability will be added that will compare target data in the mission to the MIDB target data set and warn the planner if the MIDB target record is more recent than the TAMPS target record.  Creation of target data by the mission planner will use the current “User Defined Target” HMI, although some fields will be added in order to support the more detailed target schema supported by MIDB.



Operating Locations

The biggest difference in operating locations, as far as MIDB is concerned, will be in a JMCIS-connected TAMPS vice a standalone TAMPS.  

Ashore (Standalone)

The TAMPS 6.2 standalone (“ashore”) configuration consists of a high-end desktop (currently, a SparcUltra 2) workstation without LAN connectivity to any other TAMPS workstation.  All of its local databases are used as the source of data for queries as well as the repository of data for updates.  The MIDB data installed on a workstation will be a limited subset of the whole MIDB, as disk space will be at a premium (note that the whole database schema WILL be loaded).  All updates to the MIDB will be via the DIA production editors or via IDBTF loads from tape or disk, through the DEX software.  Threat scenario data load and selection will continue to be supported.  No connectivity to external C4I systems will be supported, including JMCIS, CTAPS, JSIPS-N, and RAAP.



Data Base Schema

The current TAMPS SQL Server will be separated into two servers, one will contain the TAMPS database and all supporting “internal” data tables along with the DAFIF data tables, the other SQL server will contain the MIDB databases and tables along with the NID database and tables.  The responsibility of separating the database server falls under SOR 95-47 MP LAN. The TAMPS Intel SQL Server will contain MIDB and NID.  The MIDB database schema is controlled by DIA; therefore, changes made to MIDB will have to be reflected in the TAMPS MIDB schema.



Initial Data Population

There will be an MIDB tape product available from AIC and JICPAC (and possibly other theater support centers) and TAMPS will be capable of loading this tape product.



Maintenance of the data base

TAMPS will initially populate its local MIDB with national data. Updates to MIDB will be made manually, through the DIA production editors.  If the site requires operation with the latest version of theater MIDB data, IDBTFs may be processed to accomplish this.



Targets

The MIDB target data will be populated by either the DBA or the planner through manual updates.  The TAMPS Planner Target HMI will be modified to support the new data required for the MIDB target tables.  The TAMPS DBA Target HMI will be replaced in deference to the MIDB Target production editor HMI.



Scenario/Exercise Data

The capability to manually enter exercise/scenario data will be provided.  The ability to query against a given scenario data set will be provided.



Afloat (as well as those locations with JMCIS connectivity)

In an ìafloatî configuration, the interface to JMCIS for threat updates becomes simple.  The JMCIS CDBS MIDB will be the single point of modification and all updates will be replicated to the TAMPS Server MIDB.  TAMPS 6.2 will only be inter-operable with JMCIS 3.0 (a.k.a. JMCIS 98) or later, since both systems are required to have identical MIDB database schema.



Data Base Schema

The MIDB database schema is controlled by DIA; therefore, changes made to MIDB will have to be reflected in the TAMPS MIDB schema.  The TAMPS Intel and JMCIS CDBS SQL Servers will contain all MIDB databases and tables.  They will need to have exactly the same size, structure, unique indices, and primary keys.  The TAMPS Intel SQL server will be running on the TAMPS CVIC Server system.  All applications running on the TAMPS CVIC server or a TAMPS client workstation, will direct MIDB queries to the TAMPS Intel SQL server and MIDB updates to the JMCIS CDBS SQL server (in a JMCIS-connected environment) or the TAMPS Intel SQL server (in an environment without JMCIS).  The TAMPS Intel SQL Server will also need to maintain a smaller, limited copy of the main MIDB data, this copy will have the standard MIDB schema; however, it will only contain the data appropriate for aircraft mission planning -- facility, equipment, unit, targets, and local observation data.  This data will be the data that is backed up and sent to the client workstations.



Initial Data Population

There will be an MIDB tape product available from AIC and JICPAC (and possibly other theater support centers) and both TAMPS and JMCIS will be capable of loading this tape product.  In a replicated environment from the JMCIS CDBS to the TAMPS CVIC Server, data will be loaded to the JMCIS CDBS and then loaded to TAMPS.  Preferably, the TAMPS load will be done by dumping on JMCIS and restoring on TAMPS, but this may not be supported by Sybase.



Maintenance of the data base

While connected to the MP LAN in a JMCIS-connected environment, all updates are made to the JMCIS CDBS MIDB.  TAMPS DBAs will enter intelligence updates from TAMPS workstations, with the edits actually going to the JMCIS CDBS MIDB.  All of the updates made to the JMCIS MIDB will be replicated back to TAMPS.



Targets

The MIDB target data will be populated by either the DBA or the planner through manual updates.  The TAMPS Planner Target HMI will be modified to support the new data required for the MIDB target tables. The capability to accept updates from JMCIS will also be supported.  



Scenario/Exercise Data

Exercise/scenario data, if loaded and maintained on JMCIS, will also be replicated down to TAMPS.  The capability to manually enter exercise/scenario data will be provided.



Updates

Initial distribution of MIDB data will be via tape, with updates provided via IDBTFs.  Eventually, replication will be available from the theaters or agencies supporting systems.  Currently, the capability exists within JMCIS to connect to AIC and download IDBTFs for processing into JMCIS.  It is expected that this capability will be expanded for the MIDB environment to include connection to any supporting theater for downloading of IDBTF files.  These IDBTF files will be used to update the MIDB in JMCIS.  Updates to JMCIS will be replicated to the TAMPS CVIC Server.





Performance and Sizing



TEMP Thresholds



The TAMPS TEMP identifies two performance requirements directly or indirectly on which this SOR has bearing.



The first is that a load/reload of IDB data (hence MIDB) must not exceed 6 hours for an operational load.  Typically, this includes Worldwide tables and at least two country codes.  The load times for MIIDS/IDB have been reduced in TAMPS 6.1 from 7 hours (on DTC-2) to approximately 3 hours using Worldwide tables and North and South Korea as a benchmark. A selective load capability, as well as a selective “produce the load” capability at the theater production centers should reduce the risk of exceeding 6 hours for required data fields. With the advent of Mission Planning LAN, MIDB 2.0 data will be stored in a separate database from the rest of TAMPS.  This is expected to significantly increase the speed of a recovery load, and dump of the MIDB 2.0 database.  The dump/restore time for a 600MB database is expected to be less than 1 hour, far exceeding the TAMPS reload time requirements.  Currently approximately 600MB is allocated for IDB data.  For a complete load of the MIDB 2.0 tables (e.g. CVIC server), approximately  16 GB of storage are required with a potential of 20 GB for queueing of tactical updates and history table growth.



The second requirement is that mission plan development time (not including download) for a single aircraft mission shall not exceed two hours.  Queries for data within the confines of a standard TAMPS op area from the MIDB 2.0 database are not expected to significantly impact this planning time, nor are they expected to significantly change from current.  Queries based upon world-wide data sets can be expected to take longer than geographically limited queries, this has nothing to do with a change in database, but rather the amount of data stored in a world-wide data set.  Current timing for these queries is unknown, and is dependent on too many different variables to even hazard a guess until some timing tests can be performed.  However, considering the geographic limitations of a tactical mission, this SOR should not adversely affect the time to plan a tactical mission.



RAM and hard disk utilization



The following table was generated from data presented at the MIDB Developer’s Conference in February 1997.   These numbers are for a theater-level production facility, which would be performing a very large number of edits to the MIDB.  It is not clear exactly what the corresponding requirements are for TAMPS, which will be performing comparatively few edits to the MIDB data. It was also not clear to what extent these numbers represented a minimum operable configuration, as opposed to a recommended configuration. Although the TAMPS systems do not meet the RAM and disk space sizes presented, we do not feel that this will prevent TAMPS use of the MIDB.  These numbers are presented here for information.



Table � STYLEREF 3 \n �1.4.3�-� SEQ Table \* ARABIC \r 1 �1� Processing Allocation

Type�CPU Type�RAM�DISK SPACE��Workstation�2 - Sparc 20�256 MB�9 GB��Server�6 - Sparc 1000�1024 MB�20 GB��



System Hardware and Software Requirements

System Hardware

The MIDB 2.0 software and database require considerably more space than the MIIDS/IDB database.  This is primarily due to the change in schema definition and the expansion of the scope of data that DIA is planning on storing in the MIDB.  Due to this change in schema, the requirements for TAMPS workstations has increased.  A stand-alone workstation will require approximately 8 GB of hard disk space for the MIDB database (including database logs) along with 600 MB disk space for the MIDB software.  The TAMPS CVIC Server will require at least 16 GB of disk storage, with a margin of 20 GB for database and application software growth.  Current TAMPS requirements are for only 600MB of IDB data. There is insufficient space on current TAMPS hardware (ACE and DTC-2) to accommodate this growth without significant impacts to storage of other mission critical mapping products.

Operating System

MIDB software for loading, which will  largely be reused, is only available for Solaris 2.5.1.  NO HP support is currently available.

Commercial-Off-The-Shelf (COTS) Application Software

MIDB software requires Sybase SQL Server 11, Sybase Replication Server 11, Perl 5.002, and ICS/Motif 1.2.4.  The MIDB maintenance software currently uses the new Sybase “ct lib” interface vice the now obsolete “db lib.”  All new TAMPS queries to MIDB are planned to use an ODBC interface to reduce the dependency of TAMPS on Sybase for future releases of TAMPS.  At this time, a vendor has not yet been selected.  Since ODBC is a translation layer that allows interoperability between applications and differing vendor’s database servers, the actual calls to the database server by the ODBC driver will be in the database server’s “native” library calls.

Government-Off-The-Shelf (GOTS) Application Software

The DIA MIDB application software will be integrated into the TAMPS 6.2 product on a piece-by-piece basis.  Currently, we are planning to integrate the following parts of the MIDB application software:

Table � STYLEREF 3 \n �1.4.4�-� SEQ Table \* ARABIC \r 1 �1� MIDB Application Software

MIDB CSCI/CSC�Reason��Production Software (IPU)�Add/Edit��Query Software (IQU)�Support for Add/Edit��Brokered Login Trusted Services (BLTS) �Required for IPU/IQU access to database��Data Exchange (DEX) �Data import/export��Installation

The System Generation software will allow for installation of three MIDB configurations corresponding to a TAMPS server (full MIDB database), a TAMPS workstation (partial MIDB database), and a TAMPS remote (no MIDB database, only MIDB application software) configuration.  The MIDB configuration will be determined from the TAMPS installation type.  System Generation will allow the SA to NOT install the MIDB at sysgen time.  MIDB Installation can then be accomplished at some later time.

Description of Processing

The MIDB database (as a whole) includes several databases and TAMPS specifically interfaces with the GMI database.  The replication from JMCIS MIDB to TAMPS MIDB will be established for the GMI data.

JMCIS-TAMPS MIDB High Level Operational Data Flow

The JMCIS and TAMPS database receive the initial database load from the national theater producers.  Once on-line, the JMCIS MIDB database is considered the “gold” database.  JMCIS will accept changes to the MIDB data by processing IDBTFs from the national/theater producers, updates from the OBS and TRACK tables via the JMCIS review tool, updates from CTAPS and/or RAAP, and manual updates from the TAMPS DBAs through the TAMPS CVIC Server.  Any changes to the JMCIS MIDB data is then replicated back to the MIDB data on the TAMPS CVIC Server.  All TAMPS Client users access the MIDB data resident on the TAMPS Server.  The TAMPS MIDB database will accept and process TAMPS Client queries.



�

Figure � STYLEREF 4 \n �1.4.5.1�-� SEQ Figure \* ARABIC \r 1 �1� JMCIS-TAMPS MIDB Data Flow

TAMPS MIDB Context Diagram - Query

All users of the MIDB data will have access to the data programmatically through the TAMPS Application Interface.  The DIA Editors will be used to provide the DBA the capability to add, modify, and delete data in the MIDB tables.
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TAMPS MIDB Context Diagram - Update

The TAMPS MIDB database is updated via the Sybase Replication Server using the MP LAN. All updates to the TAMPS MIDB database are received from the JMCIS CDBS MIDB database.  Any updates by the MPMs, TERPES applications or JSIPS-N Core Extension are sent to the JMCIS database using the MP LAN. The TAMPS Application Interface provides the capability for planners to send updates to the JMCIS database or to use the DIA software to update the JMCIS database through HMI screens. 
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�Applicable Documents



Government Documents



Specifications



None

Standards



Microsoft Open Data Base Connectivity Standard, Version 2.1 (or greater)

Other Publications



Intelligence Systems Board ltr CMS95-01270, Modernized Integrated Data Base (MIDB) Data Structures and Selected Migration Systems, 13 Oct 95

Defense Intelligence Agency, Modernized Integrated Data Base (MIDB) Version 2.0 Data Base Design Document, January 1997.

Defense Intelligence Agency, Modernized Integrated Data Base (MIDB) Replication Architecture Plan, Initial Draft, November 95

Defense Intelligence Agency, Modernized Integrated Data Base (MIDB) Re-Design, Version 2.0, January 96

Defense Intelligence Agency, Modernized Integrated Data Base (MIDB) Re-Design Support Information, Version 2.0, January 96

Defense Intelligence Agency, Modernized Integrated Data Base (MIDB) Version 2.0a, June 96

Defense Intelligence Agency, Replication Server Conference Minutes, February 96

Defense Intelligence Agency Message 131419Z SEP 96, Subj: Termination of MIIDS/IDB at DIA

Sterling Software, Modernized Integrated Data Base (MIDB 2.0) Software Installation Plan (SIP), Version 1.00 (DRAFT), March 1997

TAMPS Test and Evaluation Master Plan (TEMP) (Rev A)

TAMPS 6.2 SOR 95-47 Software Design Notebook

TAMPS 6.2 SOR 97-10 Software Design Notebook



Non-Government Documents



ODBC SDK 2.1 Programmer’s Reference, Microsoft Corporation



�Requirements



Required States and Modes



There are no specific states and modes within TAMPS.



Statements of Functionality



CS0037	System generation shall support installation of TAMPS application software and databases, including construction of TAMPS database schema.



	TAMPS MIDB Installation CSC



 The System Generation CSC shall use the TAMPS MIDB Installation CSC to install the MIDB system.

 The TAMPS MIDB Installation CSC shall install the TAMPS subset of the MIDB software.

 The TAMPS MIDB Installation CSC shall install the MIDB Brokered Login Trusted Services (BLTS) software.

 The TAMPS MIDB Installation CSC shall install the BLTS server software on the system.

 The TAMPS MIDB Installation CSC shall install the BLTS client software on the system.

 The TAMPS MIDB Installation CSC shall install required “start-up” scripts  on the system to start the BLTS applications.

 The TAMPS MIDB Installation CSC shall install the MIDB Production System software.

 The TAMPS MIDB Installation CSC shall install the MIDB Data Exchange System software.

 The TAMPS MIDB Installation CSC shall install the MIDB Data Query System software.

 The TAMPS MIDB Installation CSC shall install the MIDB database schema.

 The TAMPS MIDB Installation CSC shall support three types of database  installation.

 The TAMPS MIDB Installation CSC shall support a “server” MIDB  installation.

 The “server” MIDB installation shall install all MIDB tables.

 This installation shall support a complete load of MIDB data.

 This installation shall support scenario data.

 The TAMPS MIDB Installation CSC shall support a “workstation” MIDB installation. 

 The “workstation” MIDB installation shall install all MIDB tables.

This installation shall be support  a subset of MIDB data.

 This installation shall support scenario data.

 The TAMPS MIDB Installation CSC shall support a “remote” MIDB installation.

 The “remote” MIDB installation shall install only the MIDB application software.

 The “remote” MIDB installation shall require a connection to a “server” or “workstation” MIDB installation.

 NOTE: The “remote” MIDB installation may be used in those situations where a TAMPS workstation will always be connected to a MIDB database server.

 The TAMPS MIDB Installation CSC shall provide the capability to install the MIDB database and software separately from system generation.

 The TAMPS MIDB Installation CSC shall check for required disk space.

 If the TAMPS MIDB Installation CSC cannot find the required disk space for the selected installation, it shall inform the user and exit the install process without installing the MIDB database and software.

 The TAMPS MIDB Installation CSC shall accept user input to define the parameters of the MIDB installation.

 The TAMPS MIDB Installation CSC shall assign a unique MIDB Server ID to the system.

 The TAMPS MIDB Installation CSC shall use the MIDB Server ID when generating a database record’s surrogate key. 

 The TAMPS MIDB Installation CSC shall ensure that the MIDB surrogate key counters are initialized such that newly generated surrogate keys will not conflict with any surrogate key previously generated.

 In a JMCIS environment (e.g., TAMPS-Afloat), the TAMPS MIDB Installation CSC shall initialize access to the MIDB database stored on the JMCIS system.





CS0230	Allow the system administrator to add, modify, and delete accounts through a menu driven interface.



	TAMPS System Administration CSC



 The TAMPS System Administration CSC shall ensure that created user accounts have appropriate permissions for the MIDB databases.

 In a JMCIS environment (e.g., TAMPS-Afloat), the TAMPS System Administration CSC shall ensure that created user accounts have appropriate permissions for the JMCIS MIDB databases.

 The TAMPS System Administration CSC shall ensure maintenance access to the MIDB is restricted to the TAMPS Database Administrator (DBA) role.

 The TAMPS System Administration CSC shall restrict MIDB archive operations to the TAMPS DBA role.

 The TAMPS System Administration CSC shall restrict MIDB restore operations to the TAMPS DBA role.

 The TAMPS System Administration CSC shall restrict MIDB load operations to the TAMPS DBA role.

 The TAMPS System Administration CSC shall restrict MIDB maintenance operations to the TAMPS DBA role. 

In a MP-LAN environment, the TAMPS MIDB Installation CSC shall support generation of a subset of the currently loaded MIDB GMI data for copying to client workstation databases.

In an MP-LAN environment, the TAMPS MIDB Installation CSC shall allow the Database Administrator to specify the subset of MIDB GMI data to be copied to the client workstation databases.





CT0480	To support inter-operability with other Mission Planning, Intelligence, Imagery, and Weaponeering systems, TAMPS shall use the DIA produced MIDB schema, tables, and software to support its general military intelligence (GMI) data needs.



CT0483	TAMPS shall support the ability to operate against exercise/scenario intelligence data.



	Intelligence Data Processing



 	GMI Data CSC



 The GMI Data CSC shall support mission planning against operational data.

 The GMI Data CSC shall support mission planning against scenario data.

 The GMI Data CSC shall support storage of data for up to 17 different scenarios at the same time.

 The GMI Data CSC shall limit query access to 1 (one) scenario at a time.

 The GMI Data CSC shall limit create access to 1 (one) scenario at a time.

 The GMI Data CSC shall limit modify access to 1 (one) scenario at a time.

 The GMI Data CSC shall limit delete access to 1 (one) scenario at a time.

Deleted.

 The GMI Data CSC shall provide the DBA the capability to add a set of scenario data.

 The GMI Data CSC shall provide the DBA the capability to remove a set of scenario data.

 The GMI Data CSC shall allow the DBA to allow access to a set of scenario data.

 The GMI Data CSC shall allow the DBA to stop access to a set of scenario data.

 The GMI Data CSC shall support query and maintenance of the following data sets:

 Equipment  - This data set provides the structure for equipment such as Surface-to-Air Missiles, Radars (including parametric data), Anti-Aircraft Artillery, Aircraft, Helicopters, and various other types of equipment.  This data set holds information on where the specific piece of equipment is located, e.g., SA-2F at this location, SA-2F at that location, etc.  It also provides the structure for holding associated ELINT Notations, as well as parametric data.

 Equipment Index - This data set provides the structure for equipment such as Surface-to-Air Missiles, Radars (including parametric data), Anti-Aircraft Artillery, Aircraft, Helicopters, and various other types of equipment.  However, this data set does not hold any type of location data.  It simply has information on a piece of equipment, e.g., SA-2F.

 Unit - This data set provides the structure for command, combat, and combat support units.

 Facility - This data set provides the structure for facilities such as Surface-to-Air Missile sites, Radar sites, Anti-Aircraft Artillery sites, and Airfields.  This data set holds information on where the specific facility is located, e.g., SAM site at this location, SAM site at that location, etc.

 Target - This data set consists of the data elements required to support target aimpoint definition, as well as target lists, and weaponeering information.

 Observation - This data set provides the structure for locally observed data, it contains data elements that support detailed ELINT parametric data.

 Track - This data set provides the structure for time-dependent analysis of Observation data.  The current CONOPS for Observation/Track data is that uncorrelated observations go into the Observation data set, while correlations are added to the Track data set.

 The GMI Data CSC shall provide the data elements required (equipment code and position data) to support radar terrain mask calculations for radar entries.

 The GMI Data CSC shall provide the data elements required (equipment code and position data) to support range ring calculations for surface-to-air missile (SAM) entries.

 The GMI Data CSC shall provide the data elements required (equipment code and position data) to support range ring calculations for anti-aircraft artillery (AAA) entries.



CT0671	TAMPS shall provide the planner the capability to create and maintain a set of threat data separate and distinct from the MIDB data.



	Interim Threat CSC



 The Interim Threat CSC shall support creation of threat data.

 The Interim Threat CSC shall support storage of threat data.

 The Interim Threat CSC shall support display of threat data.

 The Interim Threat CSC shall use the Overlay Manager to support graphic display of query results.

 The Interim Threat CSC shall use the Text Tool to support textual display of query results.

 The Interim Threat CSC shall support modification of existing records.

 The Interim Threat CSC shall support deletion of existing records.

 The Interim Threat CSC shall provide ownership designation of records to restrict modification and deletion to the data originator.

 The Interim Threat CSC shall support creation of Range Rings based upon Interim Threat data.

 The Interim Threat CSC shall support creation of Radar Terrain Masks based upon Interim Threat data.

 The TAMPS DBA shall be capable of deleting any Interim Threat data.

 The TAMPS DBA shall be capable of updating the MIDB database with data available from the TAMPS Interim Threat database.

  The Interim Threat CSC shall automatically delete the record from the Interim Threat database once the DBA updates the MIDB GMI database with that record.



CT0485	TAMPS shall provide the capability to load MIDB data from any DIA approved MIDB 2.0 production facility.



	MIDB Data Load CSC



 The MIDB Data Load CSC shall support loading GMI data into an empty MIDB GMI database.

 The MIDB Data Load CSC shall support overwriting an existing MIDB GMI database with new GMI data.

 The MIDB Data Load CSC shall support bulk GMI data updates to an existing MIDB GMI database.

 The MIDB Data Load CSC shall support loading of operational GMI data.

 The MIDB Data Load CSC shall support loading of exercise/scenario GMI data.

 The MIDB Data Load CSC shall be able to process Sybase Bulk Copy (BCP) files.

 The MIDB Data Load CSC shall be able to process Standard Extract Format (SEF) files.

 The MIDB Data Load CSC shall be able to process IDB Transaction Files (IDBTFs) files.

 The MIDB Data Load CSC shall support loading GMI data from standard TAMPS mass storage devices.

 The MIDB Data Load CSC shall support loading GMI data to the client workstations from the TAMPS server attached via the Mission Planning LAN.

 The MIDB Data Load CSC shall support updating the client workstations from the TAMPS server attached via the Mission Planning LAN.

 In a JMCIS environment (e.g., TAMPS-afloat), the MIDB Data Load CSC shall process updates from the JMCIS CDBS replication server to the TAMPS Server via the Mission Planning LAN-JMCIS LAN connection.

 The MIDB Data Load CSC shall provide a report to the DBA on any data that cannot be loaded.

 In a JMCIS environment (e.g., TAMPS-afloat), the MIDB Data Load CSC shall provide a report to the DBA on any replication failures.

 The MIDB Data Load CSC shall support selective (profiled) extraction of data.

 The MIDB Data Load CSC shall support selective (profiled) insertion of data.

 The MIDB Data Load CSC shall allow the DBA to define new data profiles.

 The MIDB Data Load CSC shall provide a default profile to support an MIDB Server configuration.

 The MIDB Data Load CSC shall provide a default profile to support an MIDB Workstation configuration.



CT0525 	TAMPS shall provide the capability to query for intelligence data and display the results.



 	MIDB Query CSC



 The MIDB Query CSC shall use the Overlay Manager to support graphic display of query results.

 The MIDB Query CSC shall use the Text Tool to support textual display of query results.

 The MIDB Query CSC shall use the Object Hierarchy to support querying for data.

 The MIDB Query CSC shall provide the capability to query for operational data. 

 The MIDB Query CSC shall provide the capability to query for scenario data.

 The MIDB Query CSC shall restrict the queries to only one set of scenario data at a time.

 The MIDB Query CSC shall require the user to select the data set that the query is run against.

 The MIDB Query CSC shall use operational data by default.

 The MIDB Query CSC shall support the following pre-defined queries:

 The MIDB Query CSC shall support pre-defined queries for the following data:

 Airfields

 To the major types of airfields

 Including an all types option

 Anti-Aircraft Artillery (AAA) sites/equipment

 To the level of the type of gun

 Including an all types option

 Surface-to-Air Missiles (SAM)

 To the level of the individual SAM equipment

 Including an all types option

 Radars

 To the level of radar type

 Including an all types option

 Units

 To the level of unit primary mission

 DELETED

 Aircraft

 Fixed wing aircraft

 Rotary wing aircraft.

 Ships

 Targets

 The MIDB Query CSC shall support spatial objects for the following data:

 Airfields

 To the major types of airfields

 AAA sites/equipment

 To the level of the type of gun

 SAMs

 To the level of the individual SAM equipment

 Radars

 To the level of radar type

 Surface-to-Surface Missiles

 Units

 To the primary mission/echelon level

 Aircraft

 Fixed wing

 Rotary wing

 Ships

 Targets

 The MIDB Query CSC shall support text objects for the following data:

 Radar ELINT Notations

 Remarks

 Equipment

 The MIDB Query CSC shall by default retrieve the “best” data from the database.  Best data is defined as data that matches all other conditions of the query as well as the following:

The most recent update to a record that is marked as a “local” update

Any other record that does not have any “local” updates

 The MIDB GMI Query CSC shall provide the capability to retrieve historical data instead of “best” data.



CT0540	TAMPS shall provide the capability to manually maintain the MIDB GMI data.



 	GMI Editor CSC



 In a standalone environment (e.g., TAMPS-ashore), the GMI Editor CSC shall perform all edits against the workstation’s MIDB database.

 In an MP LAN environment (e.g., TAMPS-afloat, without JMCIS connectivity), the GMI Editor CSC shall perform all edits against the TAMPS Server’s MIDB database.

 The GMI Editor CSC shall support being disabled when connected to the MP LAN.

 The GMI Editor CSC shall support being enabled when disconnecting from the MP LAN.

 In a JMCIS environment (e.g., TAMPS-afloat), the GMI Editor CSC shall perform all edits against the JMCIS MIDB database.

 The TAMPS Server MIDB database shall be used only for processing of TAMPS query requests.

 Updated data from the JMCIS MIDB shall be replicated to the TAMPS MIDB.

 The TAMPS Server MIDB database shall only accept updates from the JMCIS server.

 The GMI Editor CSC shall provide the capability to create data.

 The GMI Editor CSC shall provide the capability  to modify data.

 The GMI Editor CSC shall provide the capability to delete data.



CT0550	TAMPS MPMs shall have programmatic access to the MIDB GMI data.



	GMI Application Interface CSC



 The GMI Application Interface CSC shall provide the capability to query for Facility data.

 The GMI Application Interface CSC shall provide the capability to query for Equipment data.

 The GMI Application Interface CSC shall provide the capability to query for Unit data.

 The GMI Application Interface CSC shall provide query capability for data based upon geographic bounding rectangle and threat type.

 The GMI Application Interface CSC shall provide the capability of specifying the returned data items within the data set.



CT1098	To support inter-operability with other Mission Planning, Intelligence, Imagery, and Weaponeering systems, TAMPS shall use the MIDB target data schema to support its target data needs.



	Target Data Processing



	Target Data CSC



 The Target Data CSC shall use the Overlay Manager to support graphic display of query results.

 The Target Data CSC shall use the Text Tool to support textual display of query results.

 The Target Data CSC shall use the Object Hierarchy to support querying for data.

 The Target Data CSC shall support storage of target data.

 The Target Data CSC shall support retrieval of target data.

 The Target Data CSC shall support modification of target data.

 The Target Data CSC shall define a target by  its geospatial coordinates and a unique identifier.

 The Target Data CSC shall provide the capability to convert a coordinate from any TAMPS defined datum to a coordinate in any other TAMPS defined datum.

 The Target Data CSC shall perform datum conversions with no more than 1%  computational error. 

 The Target Data CSC shall display the target location in the current application’s selected horizontal datum.

 The Target Data CSC shall be capable of defining target location coordinates to 1/100 of an arc-second.

 The Target Data CSC shall store target location coordinates to the precision specified when the target record was created.

 The Target Data CSC shall retrieve target location coordinates at the same precision in which it was stored.

 The Target Data CSC shall display target location coordinates at the current application’s selected level of precision.

 The Target Data CSC shall provide the capability to store the horizontal datum in which the target was defined.

 The Target Data CSC shall provide the capability to retrieve the horizontal datum in which the target was defined.

 The Target Data CSC shall provide the capability to store a target’s horizontal location accuracy value and associated unit of measurement.

 The Target Data CSC shall provide the capability to retrieve a target’s horizontal location accuracy value and associated unit of measurement.

 The Target Data CSC shall provide the capability to store a target’s vertical location accuracy value and associated unit of measurement.

 The Target Data CSC shall provide the capability to retrieve a target’s vertical location accuracy value and associated unit of measurement.

 The Target Data CSC shall provide the capability to display a target’s horizontal accuracy value and associated unit of measurement.

 The Target Data CSC shall provide the capability to display a target’s vertical accuracy value and associated unit of measurement.

 The Target Data CSC shall provide the capability to store a target’s confidence data.

 The Target Data CSC shall provide the capability to retrieve a target’s confidence data.

 The Target Data CSC shall provide the capability to display a target’s confidence data.

 The Target Data CSC shall support storage of target data provided by the JTIM (Joint Service Imagery Production System - Navy (JSIPS-N)--TAMPS Interface Module) Core Extension.

 The Target Data CSC shall support retrieval of target data provided by the JTIM Core Extension.

 The Target Data CSC shall support display of target data provided by the JTIM Core Extension.

 The Target Data CSC shall differentiate TAMPS targets from other target records within the target tables.

 The Target Data CSC shall differentiate TAMPS planner targets from TAMPS DBA targets.

 The Target Data CSC shall provide a capability to associate targets and missions.



 CT1100	TAMPS shall provide the capability to load target data.



	Target Data Load CSC



 The Target Data Load CSC shall provide the capability to load target records.

 The Target Data Load CSC shall be able to load target data separately from other MIDB data sets.

 The Target Data Load CSC shall be able to load target data from standard TAMPS external mass storage devices.

 The Target Data Load CSC shall be able to load target data to the client workstations from the TAMPS server attached via the TAMPS Mission Planning LAN.

 Unused.

 The Target Data Load CSC shall be capable of accepting target data from other MIDB 2.0-compliant C4I systems (e.g., RAAP, CTAPS, JSIPS-N).

 The Target Data Load CSC shall support loading data in Sybase BCP format.

 The Target Data Load CSC shall support loading data in the IDB Standard Extract Format (SEF).

 The Target Data Load CSC shall support bulk updates performed via replacement by deleting all existing target data and inserting new target data.

 The Target Data Load CSC shall support bulk updates performed via addition by adding new data to an existing target data set and ensuring no duplicate records are added.

 The Target Data Load CSC shall support bulk updates performed manually by allowing the DBA to review existing target records and modify updatable fields.



CT1115	TAMPS shall provide the capability to manually maintain target data.



	Target Editor CSC



 The Target Editor CSC shall provide the capability to manually maintain target data.

 The Target Editor CSC shall support creating new target records.

 When a target is created from within the DBA application, the Target Editor CSC shall add a new target record to the TAMPS MIDB target data table.

 When a target  is created within a TAMPS MPM, the Target Editor CSC shall add a new target record to the TAMPS target data table.

 The Target Editor CSC shall support creation of a target by graphical selection through the Overlay Manager of any spatial object within the TAMPS Object Hierarchy.

NOTE: Use of a spatial object entity as the source of a new target record will automatically transfer all applicable data from the source to the new target, this includes (but is not limited to/by): location data (latitude, longitude, grid, grid system, elevation, datum, precision, confidence), BE Number, entity name, and entity type.

 The Target Editor CSC shall support creation of a target by selection of any point on the application map.

 The Target Editor CSC shall support creation of a target by text entry of required data.

 The Target Editor CSC shall support modifying existing targets.

 The Target Editor CSC shall allow the DBA modify any updatable field of any existing target record.

 The Target Editor CSC shall allow a planner to modify any updatable field of that planner’s target records.

 If a planner modifies a record that the planner does not own (either owned by a different planner, the DBA, or the record is from a source external to TAMPS), then the Target Editor CSC shall create a new record that will contain the modifications to the data.

 The Target Editor CSC shall support deleting existing targets.

The Target Editor CSC shall allow the DBA to delete any planner or DBA created targets.

 The Target Editor CSC shall limit a planner’s ability to delete targets to those targets created by the planner.

 In a JMCIS environment (e.g., TAMPS-afloat), the Target Editor CSC shall perform all MIDB Target edits against the JMCIS MIDB database.

 The TAMPS Server MIDB database shall be used only for processing of MIDB target query requests.

 Updated target data from the JMCIS MIDB shall be replicated to the TAMPS MIDB target data.

 The TAMPS Server MIDB database shall only accept updates from the JMCIS server.



CT1120	TAMPS MPMs shall have programmatic access to the target data.



	Target Application Interface CSC



 The Target Application Interface CSC shall provide MPMs with target creation functions.

The Target Application Interface CSC shall provide MPMs with target query functions.

The Target Application Interface CSC shall provide the capability of specifying the required data items to return from a query.

The Target Application Interface CSC shall provide query capability for target data based upon geographic bounding rectangle and target type.

The Target Interface CSC shall provide MPMs with target modification functions.

The Target Application Interface CSC shall provide MPMs with target deletion functions.

 The Target Application Interface CSC shall allow an MPM to remove a target from the application’s display.

 The Target Application Interface CSC shall allow an MPM to delete a target from the target tables within the limits described in the Target Editor CSC requirements.



CT1180	TAMPS shall provide the capability to plan attack and strike missions for both aircraft and precision guided munitions against  a target.



	Target Planning CSC



 The Target Planning CSC shall allow a planner to create multiple target references within a route.

 The Target Planning CSC shall allow a planner to remove a target reference from a route.

 The Target Planning CSC shall allow a planner to modify a target reference within a route.

 The Target Planning CSC shall allow a planner to create Offset Aimpoints with a target as the referenced location.

 The Target Planning CSC shall allow a planner to select a pre-defined target as the intended point of attack within a route.

 The Target Planning CSC shall allow a planner to create a new target as the intended point of attack within a route.

 The Target Planning CSC shall provide the capability to store a target’s relationship to a route/mission.

 The Target Planning CSC shall provide the capability to retrieve a target’s relationship to a route/mission.

 The Target Planning CSC shall alert planners when a target used in a route has been modified.



CT2300	TAMPS shall provide the capability to access and display both geographic and text data from the TAMPS databases.



	TAMPS Data Query Processing



	Data Query CSC



 The Data Query CSC shall determine the location of spatial object data using the Lat/Lon table specified for that object in the Object Editor.

 The Data Query CSC shall support the use of the ILAT/ILON columns as used in the MIDB GMI database to determine the location of spatial object data.

 The Data Query CSC shall support the use of the WGS-84 lat/lon columns as used in the DAFIF database to determine the location of spatial object data.

 The Data Query CSC shall support the use of the lat_radian/lon_radian columns in the TAMPS tailored databases to determine the location of spatial object data.

 The Data Query CSC shall constrain queries of a spatial object to the active geographic filter, or to the current operating area if there is no active geographic filter.

 The Data Query CSC shall provide the capability to specify that the results of a query of a spatial object will be displayed as symbols on the application map. 

 The Data Query CSC shall use the symbol information specified in the Object Editor for the object being queried and the currently selected symbol set when displaying query results as symbols on the application map.

 The Data Query CSC shall provide the capability to specify that the results of a query of a spatial object will be displayed in a text window.

 The Data Query CSC shall provide the capability to specify that the results of a query of a spatial object will be displayed both as symbols on the application map, and in a text window.

 The Data Query CSC shall display the results of a query of a text object in a text window.

 The Data Query CSC shall allow for a query to be saved.

 The Data Query CSC shall allow the user to select and execute a pre-defined query from the application menu.

 The Data Query CSC shall allow the DBA to add queries to the list of queries available off the main menu.

 The Data Query CSC shall allow the DBA to remove queries from the list of queries available off of the main menu.

 The Data Query CSC shall allow the user to select the query to be retrieved from a list of available queries for a specified object.

 The Data Query CSC shall allow the user to retrieve a query for execution.

 The Data Query CSC shall allow the user to execute the retrieved query.

 The Data Query CSC shall allow the user to add the retrieved query to the list of commonly used queries for that user.

 The Data Query CSC shall allow the user to select the query to be executed from the list of commonly used queries for that user.

 The Data Query CSC shall allow a user to remove a query from the list of commonly used queries for that user.

 The Data Query CSC shall allow the user to retrieve a query for editing.

The Data Query CSC shall allow the user to retrieve a query for deletion.

 The Data Query CSC shall allow the retrieved query to be deleted.

 The Data Query CSC shall allow a planner to delete a query that was saved by that planner.

 The Data Query CSC shall allow the DBA to delete a system query that was saved by a DBA.

 The Data Query CSC shall not allow any deletions of system queries installed by the System Installation CSC.

 The Data Query CSC shall provide the capability for a sub-query to be run against selected object data to retrieve additional information not provided by the original query.

 The Data Query CSC shall allow the user to specify that a scenario/exercise database should be used for queries.

 The Data Query CSC shall allow the user to specify which scenario/exercise database queries should be run against for queries.

 The Data Query CSC shall allow the user to specify that the operational database should be used for queries.

 The Data Query CSC shall use the operational database for queries by default.



CT2306	TAMPS shall provide the capability to access the various TAMPS databases through creation of geographic and text objects and association with a defined or operator created database query.



CT2307	The geographic and text objects shall be capable of supporting queries that require data from more than one data table or more than one database.



	Object Editor CSC



 The Object Editor CSC shall provide the DBA with the capability to create new objects.

 The Object Editor CSC shall provide the DBA with the capability to create a new object which contains a subtype of an existing object by applying a filter condition to the existing object.

 The Object Editor CSC shall allow a filter condition on a single column (the Object Determinator) of the available columns for that object.

 The Object Editor CSC shall allow one or more values to be specified for the Object Determinator of an object.

 The Object Editor CSC shall consider a data record to be of a specified object type if the value in the Object Determinator column matches any one of the values specified in the Object Editor.

 The Object Editor CSC shall allow a wild card character  in an Object Determinator value to indicate that any following combination of characters is a filter condition match.

 The Object Editor CSC shall provide the DBA with the capability to store objects.

 The Object Editor CSC shall provide the DBA with the capability to retrieve objects.

 The Object Editor CSC shall provide the DBA with the capability to delete objects.

 The Object Editor CSC shall provide the DBA with the capability to modify objects.

 The Object Editor CSC shall provide the DBA with the capability to associate different symbols from different symbol sets to the same object.

 The Object Editor CSC shall allow only one active symbol set at a time.

 The Object Editor CSC shall use the TAMPS symbol set by default.

 The Object Editor CSC shall provide the capability to review the complete object hierarchy.

 The review capability within the Object Editor CSC shall not allow a DBA or planner to create, delete, or modify any object.

 The Object Editor CSC shall allow objects to include data elements from any of the MIDB GMI data tables.

 The Object Editor CSC shall allow objects to include data elements from any of the MIDB target data tables.

 The Object Editor CSC shall provide the capability to access data across multiple tables within a single object.

 The Object Editor CSC shall provide the capability to access data across multiple databases within a single object.



CT2320	TAMPS shall provide an interface for the creation of SQL statements to search the TAMPS databases with user ability to select and enter query logic requiring minimal knowledge of database table schema or SQL syntax.



	Query Tool CSC



 The Query Tool CSC shall allow a filter condition to be placed on any data element included within the object being queried.

 The Query Tool CSC shall allow at least the following comparisons in a filter condition:  equal to, not equal to, greater than, greater than or equal, less than, less than or equal, like, not like, between, not between, in, and not in.

 The Query Tool CSC shall, if more than one filter condition is specified in the query, allow the filter conditions to be connected with “and”, “or”, “and not”, or “or not”, and shall allow conditions to be grouped using parentheses.

 The Query Tool CSC shall allow a filter condition to contain a specific value to be used in the comparison.

 The Query Tool CSC shall allow a filter condition that will request a value to be used in the comparison from the user at the time of query execution.

 The Query Tool CSC shall allow a filter condition to contain a specific value that will be used as a default value when a value is requested from the user at the time of query execution.

 The Query Tool CSC shall, if the comparison to be used in the filter condition is “like” or “not like”, allow a wild card character to indicate that any following combination of characters is a filter condition match.

 The Query Tool CSC shall always retrieve the data elements referenced in the ìAmp Infoî and ìLabelî actions of an object.

 The Query Tool CSC shall allow additional data elements to be selected to be retrieved by the query.

 The Query Tool CSC shall process queries which retrieve or filter on data elements from more than one table or database.

 The Query Tool CSC shall perform the database joins such that if a data element (other than the Object Determinator for that object) is not present in the database, other data elements for that object will still be retrieved. 

 The Query Tool CSC shall allow a query to be executed and the results displayed without requiring that the query be saved.

 The Query Tool CSC shall, after executing a query, allow the query to be edited.

 The Query Tool CSC shall, after executing a query, allow the query to be saved.

 The Query Tool CSC shall allow the queries created to be assigned a name, saved and retrieved for later use.

 The Query Tool CSC shall restrict a user from saving a query that would replace an existing query.

 The Query Tool CSC shall not allow replacement of an existing system query installed by the System Installation CSC.

 The Query Tool CSC shall allow an existing query being edited to be assigned a new name and saved as a new query.



	TAMPS Database Utilities



CT2740	TAMPS shall provide the capability to archive and restore databases for data backup and recovery purposes.



	Database Archive CSC



 The Database Archive CSC shall provide the capability to archive a data set as a database dump file, or as a set of BCP files.

 The Database Archive CSC shall provide the capability to restore a data set from an archive file set.

 The Database Archive CSC shall support archiving the MIDB data.

 The Database Archive CSC shall support restoring the MIDB data.



	Database Utilities CSC



CT2825	TAMPS shall provide the DBA with the capability to backup and restore tactical data updates.



 The Database Utilities CSC shall support the backup of tactical updates made to the GMI data in the local MIDB database.

 The Database Utilities CSC shall support the restoration of tactical updates made to the GMI data in the local MIDB GMI database.



CT2990	TAMPS shall provide the DBA with information on the size of each data set within the database.



 The Database Utilities CSC shall provide the DBA with sizing information on the GMI data in the MIDB database.

 The Database Utilities CSC shall provide the DBA with sizing information on  the target data in the MIDB GMI database.

 The Database Utilities CSC shall provide the DBA with sizing information of the reference data in the MIDB database.



CT3020	TAMPS shall provide the DBA a data removal utility to remove a database in its entirety or to remove specific files from a dataset which results in update of status information.



 The Database Utilities CSC shall support the deletion of GMI data from the MIDB database.

 The Database Utilities CSC shall support the deletion of target data from the MIDB database.

 DELETED



	TAMPS System Utilities



CS0410	No Change

CS0420	No Change

CS0430	No Change



	Alerts CSC



 The Alerts CSC shall send warning alerts whenever there is an update to data that could affect Radar Terrain Mask (RTM) calculations.

 The Alerts CSC shall warn upon updates to Digital Terrain Elevation Data (DTED) that could affect RTM calculations.

 The Alerts CSC shall warn upon updates to MIDB GMI data that could affect RTM calculations.

 The Alerts CSC shall warn upon updates to the Naval Identification Database (NID) data that could affect RTM calculations.

 The Alerts CSC shall send warning alerts whenever there is an update to data that could affect Range Ring calculations.

 The Alerts CSC shall warn upon updates to Digital Terrain Elevation Data (DTED) that could affect Range Ring calculations.

 The Alerts CSC shall warn upon updates to MIDB GMI data that could affect Range Ring calculations.

 The Alerts CSC shall warn upon updates to the Naval Identification Database (NID) data that could affect Range Ring calculations.

 The Alerts CSC shall support alerts sent from the MIDB application software.

 The Alerts CSC shall generate alerts based upon the data in the MIDB alert.

 The Alerts CSC shall inform the user to refer to the MIDB alert application to determine the nature of the alert message.

 The Alerts CSC shall only forward MIDB alerts to the TAMPS DBA alert queue.



�Requirements Trace

Requirements Trace DataBase (RTDB) Updates



RTDB #�RTDB Statement��CC0840�No Change��CC0860�No Change��CC0870�No Change��CD1045�The threat range ring sub-function shall use data from the TAMPS tactical databases to perform calculations.��CD1047�Threat  range ring calculation data shall include threat descriptive information from the MIDB and NID.��CS0037�System generation  shall support installation of TAMPS application software and databases, including construction of TAMPS database schema.��CS0230�TAMPS shall allow the system administrator to add, modify, and delete accounts through a menu driven interface.��CP1175�The threat assessment sub-function shall use data from the TAMPS tactical databases to perform calculations.��CP1176�The threat assessment calculation data shall include mission route information and threat descriptive information from the MIDB and NID.��CT0480�To support inter-operability with other Mission Planning, Intelligence, Imagery, and Weaponeering systems, TAMPS shall use the MIDB schema, tables, and software to support its GMI data needs.��CT0483�TAMPS shall support the ability to operate against exercise/scenario intelligence data.��CT0485�TAMPS shall provide the capability to load MIDB GMI data from any DIA approved production facility.��CT0525�TAMPS shall provide the capability to query the GMI data and display the results.��CT0540�TAMPS shall provide the capability to manually maintain the MIDB GMI data.��CT0550�TAMPS MPMs shall have programmatic access to the MIDB GMI data.��CT0671�TAMPS shall provide the  planner the capability to create and maintain  a set of threat data separate and distinct from the MIDB GMI data.��CT1098�To support inter-operability with other Mission Planning, Intelligence, Imagery, and Weaponeering systems, TAMPS shall use the MIDB target data schema to support its target data needs.��CT1100�TAMPS shall provide the capability to load MIDB target data.��CT1115�TAMPS shall provide the capability to manually maintain target data.��CT1120�TAMPS MPMs shall have programmatic access to the target data.��CT1180�TAMPS shall provide the capability to plan attack and strike missions for both aircraft and precision guided munitions against  a target.��CT2300�TAMPS shall provide the capability to access and display both geographic and text data from the TAMPS databases.��CT2306�TAMPS shall provide the capability to access the various TAMPS databases through creation of geographic and text objects  and association with a defined or operator created database query.��CT2307�Geographic and text objects shall be capable of supporting queries that require data from more than one data table or more than one database.��CT2320�TAMPS shall provide an interface for the creation of queries to search the TAMPS databases with user ability to select and enter query conditions requiring minimal knowledge of database table schema or SQL syntax.��CT2740�TAMPS shall provide the capability to archive and restore the MIDB data tables.��CT2825�TAMPS shall provide the DBA with the capability to backup and restore tactical data updates.��CT2990�TAMPS shall provide the DBA with information on the size of each data set within the database.��CT3020�TAMPS shall provide the DBA a data removal utility to remove a database in its entirety or to remove specific files from a dataset which results in update of status information.��CS0410�No Change��CS0420�No Change��CS0430�No Change��

Requirements Administrative Actions



RTDB #�Action�SRS Paragraph �CSC�Remarks��CC0840�N/C���OBREPs��CC0860�N/C���OBREPs��CC0870�N/C���OBREPs��CD1045�DEL���Duplicate CD1047/CD1048��CD1047�MOD�3.2.3.2.7�Interim Threat���CD1048�MOD�3.2.3.4.5.2.2, 3.2.3.4.5.3.2�MIDB Query

MIDB Query���CP1170�DEL���Duplicate CP1175/CP1176��CP1175�MOD�3.2.3.2.8�Interim Threat���CP1176�MOD�3.2.3.4.5.4.2�MIDB Query���CR0101�N/C�����CR0102�N/C�����CS0037�MOD�3.2.1�MIDB Installation���CS0230�MOD�3.2.2�System Administration���CS0410�N/C�����CS0420�N/C�����CS0430�N/C�����CS0680�FIX���Duplicated in RTDB��CT0072 �DEL���Break into separate  SRS stmts��CT0480 �DEL���Duplicate CT0485��CT0485 �MOD�3.2.3.3.6, 3.2.3.3.7�Data Load���CT0490 �MOV���Move to new hi-level rqmt��CT0492�DEL���Duplicate CT0490��CT0495�MOD�����CT0497�DEL���Duplicate CT0495��CT0500 �SRS�3.2.3.3.9�Data Load���CT0505�DEL���Duplicate CT0500��CT0510 �DEL���Duplicate CT0515��CT0515�DEL���not feasible by CC��CT0520 �DEL���Duplicate CT0525��CT0525�MOD�3.2.3.4�MIDB Query���CT0527�SRS�3.2.5.1.2�Object Editor���CT0530 �DEL���Up to MIDB��CT0531�DEL���Duplicate CT0530��CT0533�SRS�3.2.3.4.7�MIDB Query���CT0534�DEL���Duplicate CT0533��CT0535�DEL���Duplicate CT0537��CT0537�SRS�3.2.5

3.2.5.3.1�Data Query Processing

Query Tool���CT0540 �MOD�3.2.3.3.3, 3.2.3.3.6, 3.2.3.3.8, 3.2.3.3.11, 3.2.3.3.12

3.2.3.5�Data Load









MIDB Editor���CT0542�SRS�3.2.3.3.8, 3.2.3.3.3�Data Load���CT0544�SRS�3.2.3.3.6, 3.2.3.3.3�Data Load���CT0546�SRS�3.2.3.5�MIDB Editor���CT0548�SRS�3.2.3.3.11, 3.2.3.3.12�Data Load���CT0550 �SRS�3.2.3.3.13�Data Load���CT0552�DEL���Duplicate CT 0550��CT0555 �SRS�NONE����CT0557�DEL���Duplicate CT0555��CT0560 �DEL���Duplicate CT0542��CT0565 �DEL���not feasible by CC��CT0567�DEL���Duplicate CT0565��CT0580 �DEL���Duplicate CT0585��CT0585�SRS�3.2.3.3.2, 3.2.3.3.3�Data Load���CT0590 �DEL���Ambiguous��CT0600 �SRS�3.2.4.2.10

3.2.4.3.4.1�Target Data Load

Target Editor�targets��CT0601�DEL���Duplicate CT0601��CT0602 �DEL���OBE��CT0610 �DEL���OBE��CT0615 �DEL���RAAP��CT0630 �DEL���RAAP��CT0650 �DEL���RAAP��CT0660 �DEL���OBE��CT0670 �SRS�NONE����CT0670.0020�DEL���Duplicate CT1098��CT0670.0030�DEL���Duplicate CT1136��CT0670.0040�MOD�3.2.3.1�GMI Data���CT0670.0060�SRS�NONE,

 3.2.3.1.2.4,

3.2.3.5.5�

GMI Data

MIDB Editor���CT0670.0080�SRS�NONE,

 3.2.3.3.3, 3.2.3.3.6�

Data Load���CT0670.0100�SRS�3.2.3.3.11�Data Load���CT0670.0120�DEL�����CT0671�MOD�3.2.3.2�Interim Threat���CT0671.0010�DEL���Duplicate CT0671��CT0672�SRS�3.2.3.2.1, 3.2.3.2.4, 3.2.3.2.5�Interim Threat���CT0673�DEL���Duplicate CT0673.0010��CT0673.0010�SRS�3.2.3.2.10�Interim Threat���CT0674�DEL���Duplicate CT0674.0010��CT0674.0010�SRS�3.2.3.2.11�Interim Threat���CT0675�SRS�3.2.3.2.1, 3.2.3.2.2, 3.2.3.2.3�Interim Threat���CT0676�SRS�3.2.3.2.2, 3.2.5.3.1�Interim Threat,

Query Tool���CT0955�DEL���NERF��CT0960�DEL���“��CT0975�DEL���“��CT0980�DEL���“��CT0985�DEL���“��CT0995�DEL���“��CT1010�DEL���“��CT1020�DEL���“��CT1098�MOD�3.2.4�Target Data Processing���CT1099�SRS�3.2.4.1.1

3.2.4.1.2

3.2.4.1.3�Target Data���CT1100�MOD�3.2.4.2.1-

3.2.4.2.11�Target Data Load���CT1115�MOD�3.2.4.3.1

3.2.4.3.3

3.2.4.3.4

3.2.4.3.4.1�Target Editor���CT1135�SRS�3.2.4.3.3 -

3.2.4.3.3.2�Target Editor���CT1136�SRS�3.2.4.3.4

(3.2.3.3.3, 3.2.3.3.6)�Target Editor���CT1137�DEL���Duplicate CT1150/60��CT1150�SRS�3.2.4.2.9�Target Data Load���CT1160�SRS�3.2.4.2.10�Target Data Load���CT1170�SRS�3.2.4.2.11�Target Data Load���CT1180�MOD�3.2.4.1.11�Target Data���CT1184�SRS�3.2.4.1.17-

3.2.4.1.20�Target Data���CT1188�SRS�3.2.4.1.24 -

3.2.4.1.25�Target Data���CT1190�SRS�3.2.4.1.1-

3.2.4.1.3�Target Data���CT2306�MOD�3.2.5.2�Object Editor���CT2306.0020�N/C���TERPES requirement��CT2306.0040�N/C���TERPES requirement��CT2307 �MOD�?? 3.2.6.8-3.2.6.11����CT2308�SRS�3.2.5.2.9-

3.2.5.2.9.1

3.2.5.2.9.2�Object Editor���CT2309�SRS�3.2.5.1,

 3.2.5.3�Data Query���CT2310�SRS�3.2.5.2.10-

3.2.5.2.10.1�Object Editor���CT2320�MOD�3.2.5.3�Query Tool���CT2330�SRS�3.2.5.3.1-

3.2.5.3.1.6�Query Tool���CT2340�SRS�3.2.5.3.1.1�Data Query���CT2350�SRS�3.2.5.3.1.2�Query Tool���CT2360�SRS�3.2.5.1.2�Data Query���CT2370�SRS�3.2.5.3.1.3-

3.2.5.3.1.5�Data Query���CT2380�SRS�3.2.5.3.1.6�Data Query���CT2390�SRS�3.2.5.1.3-

3.2.5.1.6, 

3.2.5.3.3�Data Query



Query Tool���CT2400�SRS�3.2.5.1.3.1�Data Query���CT2410�SRS�3.2.5.1.9,

 3.2.5.1.9.1,

 3.2.5.1.13,

3.2.5.1.13.1,

3.2.5.3.5-

3.2.5.3.6,

 3.2.5.3.6.2�Data Query







Query Tool���CT2420�SRS�3.2.5.3.5,

 3.2.5.3.6.2�Query Tool���CT2430�SRS�3.2.5.3.6����CT2440�SRS�3.2.5.1.12,

 3.2.5.1.9.1,

 3.2.5.1.13,

 3.2.5.1.13.1,

 3.2.5.1.11,

 3.2.5.1.11.1�Data Query���CT2450�SRS�3.2.5.1.9.4�Data Query���CT2460�SRS�3.2.5.1.8.1,

 3.2.5.1.11.2�Data Query���CT2470�SRS�3.2.5.1.8.2�Data Query���CT2480�SRS�3.2.5.1.8.3,

3.2.5.1.11

3.2.5.1.12,

3.2.5.1.13�Data Query���CT2490�SRS�3.2.5.1.8.2,

3.2.5.1.9.2�Data Query���CT2500�SRS�??3.2.5.11.1.2,

??3.2.5.11.2,

3.2.5.3.6.1�



Data Archive���CT2510�SRS�3.2.5.3.6.2�Query Tool���CT2740 �MOD�3.2.6.1����CT2750 �DEL��Data Archive�new��CT2755 �DEL���new��CT2820 �SRS�3.2.6.1.1�Data Archive�Need other DB SRS reqmts��CT2830�DEL���Duplicate CT2820��CT2840�SRS�3.2.6.1.1�Data Archive���CT2850 �SRS�3.2.6.1.1�Data Archive���CT3010�CLA���Is this reqmt obsolete?��



Allocation Trace Matrix

The following table maps the RTDB requirements to this SOR’s statements of functionality  (SRS Paragraph) and then to the CSC/CSU level.  The RTDB column indicates the high level RTDB requirement and for clarity the requirement has only been allocated to the highest level SRS paragraph number.  The following SRS paragraph numbers are also allocated to the preceding RTDB requirement(s).  The CSC/CSU column indicates the current allocation for each requirement.  When the current TAMPS functionality already exists for the requirement, the source file or the function name have been supplied.



RTDB #�SRS Paragraph �CSC/CSU�Remarks��CS0037�3.2.1�MIDB Installation CSC�Header���3.2.1.1�MIDB installation����3.2.1.2�MIDB installation����3.2.1.2.1�MIDB installation�BLTS���3.2.1.2.1.1�MIDB installation�BLTS���3.2.1.2.1.2�MIDB installation�BLTS���3.2.1.2.1.3�MIDB installation

System Startup

System Shutdown

User Login�startup scripts for BLTS���3.2.1.2.2�MIDB installation�Production Software���3.2.1.2.3�MIDB installation�DEX Software���3.2.1.2.4�MIDB installation�Data Query Software���3.2.1.2.5�MIDB installation�MIDB schema���3.2.1.2.5.1�MIDB installation����3.2.1.2.5.1.1�MIDB installation����3.2.1.2.5.1.1.1�MIDB installation�server���3.2.1.2.5.1.1.2�MIDB installation�server���3.2.1.2.5.1.1.3�MIDB installation�server���3.2.1.2.5.1.2�MIDB installation����3.2.1.2.5.1.2.1�MIDB installation�workstation���3.2.1.2.5.1.2.2�MIDB installation�workstation���3.2.1.2.5.1.2.3�MIDB installation�workstation���3.2.1.2.5.1.3�MIDB installation����3.2.1.2.5.1.3.1�MIDB installation�remote���3.2.1.2.5.1.3.2�MIDB installation�remote���3.2.1.2.6�MIDB installation����3.2.1.2.6.1�MIDB installation����3.2.1.2.6.2�MIDB installation����3.2.1.2.7�MIDB installation����3.2.1.2.8�MIDB installation����3.2.1.2.8.1�MIDB installation����3.2.1.2.8.2�MIDB installation����3.2.1.2.9�MIDB installation��������CS0230�3.2.2�System Administration CSC�Header���3.2.2.1�MIDB installation,

User Administration�database permissions���3.2.2.2�MIDB installation,

User Administration�JMCIS MIDB permissions���3.2.2.3�User Administration�TAMPS DBA role���3.2.2.3.1��archive���3.2.2.3.2��restore���3.2.2.3.3��load���3.2.2.3.4�User Administration�restrict maintenance to TAMPS DBA�������CT0480�3.2.3

3.2.3.1�Intelligence Data Processing

GMI Data CSC�Header

Header���3.2.3.1.1�DBA - threat scenarios�operational data�������CT0483�3.2.3.1.2�DBA - threat scenarios�scenario���3.2.3.1.2.1�DBA - threat scenarios�storage 17 scenarios���3.2.3.1.2.2�DBA - threat scenarios�query 1 scenario���3.2.3.1.2.3�DBA - threat scenarios�create 1 scenario���3.2.3.1.2.4�DBA - threat scenarios�modify 1 scenario���3.2.3.1.2.5�DBA - threat scenarios�delete 1 scenario���3.2.3.1.2.6�Deleted�maximum 5 Mb size���3.2.3.1.2.7�DIA Editor�add records to scenario���3.2.3.1.2.8�DIA Editor�delete records from scenario���3.2.3.1.2.9�DBA - threat scenarios�access to scenario data���3.2.3.1.2.10�DBA - threat scenarios�stop access to scenario data�������CT0480�3.2.3.1.3�DIA Editor�query/maintain data���3.2.3.1.3.1�DIA Editor

MPM - Threat OOB Query �equipment���3.2.3.1.3.2�DIA Editor

MPM - Threat OOB Query �equipment index���3.2.3.1.3.3�DIA Editor

MPM - Threat OOB Query �unit���3.2.3.1.3.4�DIA Editor

MPM - Threat OOB Query �facility���3.2.3.1.3.5�DIA Editor�target���3.2.3.1.3.6�DIA Editor�observation���3.2.3.1.3.7�DIA Editor�track���3.2.3.1.4�ert_int_rtm_init()�RTM���3.2.3.1.5�edt_mera_cb()�range rings - SAM���3.2.3.1.6�edt_mera_cb()�range rings - AAA�������CT0671�3.2.3.2�Interim Threat CSC�Header���3.2.3.2.1�dil_AddInterimThreat.c�create���3.2.3.2.2�TAMPS_INTERIM_THREAT�storage���3.2.3.2.3�dil_DisplayInterimThreats.c�display���3.2.3.2.3.1�dil_DisplayInterimThreats.c�graphic display ���3.2.3.2.3.2�dil_DisplayInterimThreats.c�textual display���3.2.3.2.4�dil_EditThreat.c�modify���3.2.3.2.5�dil_DeleteThreat.c�delete���3.2.3.2.6�dil_EditThreat.c�ownership���3.2.3.2.7� edt_mera_cb()�range rings���3.2.3.2.8�ert_int_rtm_init()�RTMs���3.2.3.2.9�dil_DeleteThreat.c�DBA delete���3.2.3.2.10�dil_DbaAddInterimThreatToIdb.c�DBA update���3.2.3.2.11�dil_DbaAddInterimThreatToIdb.c�automatic delete�������CT0485�3.2.3.3�MIDB Data Load CSC�Header���3.2.3.3.1�DIA DEX�load empty database���3.2.3.3.2�DIA DEX�overwrite database���3.2.3.3.3�DIA DEX�bulk data updates���3.2.3.3.4�DIA DEX�load operational data���3.2.3.3.5�DIA DEX�load scenario data���3.2.3.3.6�DIA DEX�process bcp files���3.2.3.3.7�DIA DEX�process SEF files���3.2.3.3.8�DIA DEX�process IDBTF’s���3.2.3.3.9�DIA DEX�mass storage devices���3.2.3.3.10�DIA DEX�load via MP LAN���3.2.3.3.11�DIA DEX�update via MP LAN���3.2.3.3.12�DIA DEX

JMCIS MIDB baseload�replication from JMCIS���3.2.3.3.13�DIA DEX�report unloaded data���3.2.3.3.14�DIA DEX�report replication errors���3.2.3.3.15�DIA DEX�selective extraction���3.2.3.3.16�DIA DEX�selective loading���3.2.3.3.17�DIA DEX�new profiles���3.2.3.3.18�DIA DEX�default profile���3.2.3.3.19�DIA DEX�workstation configuration�������CT0525�3.2.3.4�MIDB Query�Header���3.2.3.4.1�MPM - Threat OOB Query�use Overlay Manager���3.2.3.4.2�MPM - Threat OOB Query�text display of query���3.2.3.4.3�MPM - Threat OOB Query�use Object Hierarchy���3.2.3.4.3.1�DBA - Threat Scenarios �default to operational data���3.2.3.4.3.2�DBA - Threat Scenarios �scenario data���3.2.3.4.3.3�DBA - Threat Scenarios �one scenario���3.2.3.4.3.4�DBA - Threat Scenarios �select dataset���3.2.3.4.3.5�DBA - Threat Scenarios �default operational data���3.2.3.4.4�DBA - Query Tool�pre-defined queries���3.2.3.4.4.1 

to

3.2.3.4.4.1.8�DBA - Query Tool����3.2.3.4.5�DBA - Query Tool�spatial objects���3.2.3.4.6�DBA - Query Tool�text object���3.2.3.4.7�DBA - Query Tool�retrieve “best” data���3.2.3.4.8�DBA - Query Tool�retrieve historical data�������CT0540�3.2.3.5�MIDB Editor CSC�Header���3.2.3.5.1�MP-LAN workstation connect/disconnect�standalone environ���3.2.3.5.2��use TAMPS Server���3.2.3.5.2.1�MP-LAN workstation connect/disconnect�disabled from LAN���3.2.3.5.2.2�MP-LAN workstation connect/disconnect�disconnect from LAN���3.2.3.5.3�JMCIS MIDB server,

MP-LAN workstation connect/disconnect�edits performed on JMCIS db���3.2.3.5.3.1�DBA - Query Tool�TAMPS Server���3.2.3.5.3.2�MP-LAN workstation connect/disconnect�replication from JMCIS���3.2.3.5.3.3�MP-LAN workstation connect/disconnect�updates from JMCIS���3.2.3.5.4�DIA Editor

aet_CreateRefOAPDialog()�create data���3.2.3.5.5�DIA Editor

adt_target.c

adt_tgData.c�modify data���3.2.3.5.6�DIA Editor

adt_target.c

adt_tgData.c�delete data�������CT0550�3.2.3.6�GMI Application Interface CSC�Header���3.2.3.6.1�dit_getMIDBData()�query for facility���3.2.3.6.2�dit_getMIDBData()�query for equipment���3.2.3.6.3�dit_getMIDBData()�query for unit���3.2.3.6.4�dit_getMIDBData()�query with geo area and threat type���3.2.3.6.5�dit_getMIDBData()�return query data�������CT1098�3.2.4

3.2.4.1�Target Data Processing

Target Data CSC�Header

Header���3.2.4.1.1�MPM - target query�display query results���3.2.4.1.2�MPM - target query�text display���3.2.4.1.3�MPM - target query�use OH���3.2.4.1.4�MPM - save msn�store target data���3.2.4.1.5�MPM- open msn

MPM - planner target update�retrieve target data���3.2.4.1.6�MPM - planner target update�modify target data���3.2.4.1.7�MPM - planner target update�geo coordinates���3.2.4.1.8�MPM - planner target update�convert datum���3.2.4.1.9�MPM - planner target update�< 1% convert error���3.2.4.1.10�MPM - target query�display loc coordinates���3.2.4.1.11�MPM - planner target update�define 1/100 arc sec���3.2.4.1.12�MPM - planner target update�store loc coord���3.2.4.1.13�MPM - target query�get loc coord���3.2.4.1.14�MPM - target query�display loc coordinates���3.2.4.1.15�MPM - planner target update�store horiz datum���3.2.4.1.16�MPM - target query�get horiz datum���3.2.4.1.17�MPM - planner target update�store horiz loc accuracy���3.2.4.1.18�MPM - target query�get horiz loc accuracy���3.2.4.1.19�MPM - planner target update�store vert loc accuracy���3.2.4.1.20�MPM - target query�get vert loc accuracy���3.2.4.1.21�MPM - target query�display horiz accuracy���3.2.4.1.22�MPM - target query�display vert accuracy���3.2.4.1.23�MPM - planner target update�store confidence���3.2.4.1.24�MPM - target query�get confidence���3.2.4.1.25�MPM - target query�display target confidence���3.2.4.1.26�MPM - target query�store JTIM target���3.2.4.1.27�MPM - target query�retrieval by JTIM���3.2.4.1.28�MPM - target query�display JTIM target���3.2.4.1.29�MPM - target query�TAMPS target vs others���3.2.4.1.30�MPM - planner target update�DBA vs planner targets���3.2.4.1.31�MPM - open msn

MPM - save msn�reference targets in missions�������CT1100�3.2.4.2�Target Data Load CSC�Header���3.2.4.2.1�DIA DEX�load���3.2.4.2.2�DIA DEX�load only targets���3.2.4.2.3�DIA DEX�load from storage device���3.2.4.2.4�DIA DEX�load to client���3.2.4.2.5�Unused����3.2.4.2.6�DIA DEX�C4I targets���3.2.4.2.7�DIA DEX�load BCP targets���3.2.4.2.8�DIA DEX�IDB SEF targets���3.2.4.2.9�DIA DEX�bulk replacement���3.2.4.2.10�DIA DEX�bulk updates���3.2.4.2.11��manual bulk updates�������CT1115�3.2.4.3�Target Editor CSC�Header���3.2.4.3.1�MPM - planner target update�maintain target���3.2.4.3.2�DIA Editor�create target���3.2.4.3.2.1�DIA Editor�DBA target creation���3.2.4.3.2.2�MPM - planner target update�MPM target creation���3.2.4.3.2.3�MPM - planner target update�graphical selection���3.2.4.3.2.4�DIA Editor

MPM - planner target update�point selection���3.2.4.3.2.5�DIA Editor�text entry���3.2.4.3.3�DIA Editor�modify target���3.2.4.3.3.1�DIA Editor�DBA modification���3.2.4.3.3.2�MPM - planner target update�MPM modification���3.2.4.3.3.3�MPM - planner target update�MPM modification���3.2.4.3.4�DIA Editor

MPM - planner target update�delete target���3.2.4.3.4.1�DIA Editor�DBA deletion���3.2.4.3.4.2�MPM - planner target update�MPM deletion���3.2.4.3.5�MP-LAN workstation connect/disconnect�edit using JMCIS Server���3.2.4.3.5.1�DBA - Query Tool�TAMPS Server���3.2.4.3.5.2�MP-LAN workstation connect/disconnect�replication from JMCIS���3.2.4.3.5.3�MP-LAN workstation connect/disconnect�updates from JMCIS�������CT1120�3.2.4.4�Target Application Interface CSC�Header���3.2.4.4.1�dit_createTarget()�create���3.2.4.4.2�dit_getTargets()�query���3.2.4.4.2.1�dit_getTargets()�return data���3.2.4.4.2.2�dit_getTargets()�query using geo area and target type���3.2.4.4.3�dit_modifyTargets()�modify���3.2.4.4.4�dit_deleteTargets()�delete���3.2.4.4.4.1��remove from display���3.2.4.4.4.2�dit_deleteTargets()�delete in database and remove from display�������CT1180�3.2.4.5�Target Planning CSC�Header���3.2.4.5.1�adt_target.c�create target���3.2.4.5.2�adt_target.c�remove target in route���3.2.4.5.3�adt_target.c �modify target in route���3.2.4.5.4�aet_CreateRefOAPDialog()�create offset aimpoint���3.2.4.5.5�adt_target.c

adt_tgData.c�pre-defined target���3.2.4.5.6�adt_target.c

adt_tgData.c�create target as point of attack���3.2.4.5.7�adt_target.c�store target relationship���3.2.4.5.8�adt_retrieveTarget()�retrieve target relationship���3.2.4.5.8.1�MPM - open msn�notify when target is modified�������CT2300�3.2.5

3.2.5.1�Data Query Processing

Data Query CSC�Header

Header���3.2.5.1.1�DBA - Query Tool�location of spatial object���3.2.5.1.1.1�DBA - Query Tool�use ilat/ilon���3.2.5.1.1.2�DBA - Query Tool�use WGS-84 lat/lon���3.2.5.1.1.3�DBA - Query Tool�lat/lon radian���3.2.5.1.2�DBA - Query Tool�use active geo filter���3.2.5.1.3�DBA - Query Tool�display symbols���3.2.5.1.3.1�DBA - Query Tool�use symbol info���3.2.5.1.4�DBA - Query Tool�query results in text���3.2.5.1.5�DBA - Query Tool�query results ���3.2.5.1.6�DBA - Query Tool�query results���3.2.5.1.7�dmt_query_save_callback()�save query���3.2.5.1.8�dmt_query_browse_callback()�pre-defined query���3.2.5.1.8.1�dmt_query_new_callback()�add queries���3.2.5.1.8.2�dmt_query_delete_callback()�delete queries���3.2.5.1.8.3�dmt_query_browse_callback()�retrieve queries���3.2.5.1.9�DBA - Database Search�retrieve for execution���3.2.5.1.9.1�dmt_query_execute_callback()

dmt_qfq_execute_callback()�execute query���3.2.5.1.9.2�dmt_qfq_add_callback()�add query���3.2.5.1.9.3�DBA - Database Search�select query���3.2.5.1.9.4�dmt_qfq_delete_callback()�delete query���3.2.5.1.10�dmt_query_edit_callback()�edit query���3.2.5.1.11�dmt_query_delete_callback()�delete query���3.2.5.1.11.1�dmt_query_delete_callback()�delete query���3.2.5.1.11.1.1�dmt_query_delete_callback()�planner delete query���3.2.5.1.11.1.2�dmt_query_delete_callback()�DBA delete query���3.2.5.1.11.2�dmt_query_delete_callback()�inhibit query deletion���3.2.5.1.12�dmt_query_sub_convert_callback()

dmt_query_sub_delete_callback()�sub-query���3.2.5.1.13�DBA - Threat Scenarios�scenario queries���3.2.5.1.13.1�DBA - Threat Scenarios�use scenario queries���3.2.5.1.14�DBA - Threat Scenarios�use operational data���3.2.5.1.14.1�DBA - Threat Scenarios�default to operational�������CT2306

CT2307�3.2.5.2�Object Editor CSC�Header���3.2.5.2.1�oet_createObjectCallback()�create new objects���3.2.5.2.2�oet_det*.c�create with filter���3.2.5.2.2.1�oet_det*.c�single filter column���3.2.5.2.2.2�oet_det*.c�one or more filters���3.2.5.2.2.2.1�oet_det*.c�match columns���3.2.5.2.3�oet_det*.c�wild card character���3.2.5.2.4�Object Hierarchy�DBA stores objects���3.2.5.2.5�Object Hierarchy�DBA retrieves objects���3.2.5.2.6��DBA deletes objects���3.2.5.2.7�oet_editObject()�DBA modifies objects���3.2.5.2.8�oet_invokeSymbolMapping()�associate symbols���3.2.5.2.8.1�oet_invokeSymbolMapping()�one active symbol���3.2.5.2.8.2�oet_invokeSymbolMapping()�default TAMPS symbols���3.2.5.2.9�obt_getBrowserForm()�review Object Hierarchy���3.2.5.2.9.1�obt_getBrowserForm()�no changes in review���3.2.5.2.10�obt_getBrowserForm()�include MIDB GMI info���3.2.5.2.11�obt_getBrowserForm()�include MIDB target info���3.2.5.2.12�oet_tab*.c

oet_col*.c�multiple tables ���3.2.5.2.13�oet_tab*.c

oet_col*.c�multiple databases�������CT2320�3.2.5.3�Query Tool CSC�Header���3.2.5.3.1�dmt_qnecond.c�filter condition���3.2.5.3.1.1�dmt_qnebtw*.c

dmt_qnein*.c�filter conditions���3.2.5.3.1.2�dmt_qneopcb.c�filter condition���3.2.5.3.1.3�dmt_qne*.c�filter condition���3.2.5.3.1.4�dmt_qne*.c�use filter condition���3.2.5.3.1.5�dmt_qne*.c�filter condition���3.2.5.3.1.6�dmt_qne*.c�filter condition���3.2.5.3.2�DBA - Query Tool�retrieve Amp Info/Label���3.2.5.3.3�dmt_qneres.c�retrieve additional data���3.2.5.3.4�DBA - Query Tool�retrieve more than 1 table database���3.2.5.3.4.1�DBA - Query Tool�database joins���3.2.5.3.5�dmt_qne_execute_callback()�execute without saving query���3.2.5.3.5.1�dmt_qne_edit_callback()�edit executed query���3.2.5.3.5.2�dmt_qne_save_callback()�save executed query���3.2.5.3.6�dmt_qne_save_callback()�save query���3.2.5.3.6.1�dmt_qne_save_callback()�prevent replacing saves���3.2.5.3.6.2�dmt_qne_save_callback()�prevent saving to pre-defined queries���3.2.5.3.6.3�dmt_qne_save_callback()�provide save as query�������CT2740�3.2.6.1�Data Archive CSC�Header���3.2.6.1.1�Utilities - Archive/Restore�archive BCP file���3.2.6.1.2�Utilities - Archive/Restore�restore archive file���3.2.6.1.3�Utilities - Archive/Restore�archive MIDB data���3.2.6.1.4�Utilities - Archive/Restore�restore MIDB data�������CT2825�3.2.6.2�Database Utilities�Header���3.2.6.2.1��backup MIDB updates���3.2.6.2.2��restore MIDB backup�������CT2990�3.2.6.2.3�Output - Reports�size of GMI data���3.2.6.2.4�Output - Reports�size of target data���3.2.6.2.5�Output - Reports�size of reference data�������CT3020�3.2.6.2.6�Utilities - Data Removal�delete GMI data���3.2.6.2.7�Utilities - Data Removal�delete target data���3.2.6.2.8�Utilities - Data Removal�delete reference data�������CS0410

CS0420

CS0430�3.2.7

3.2.7.1�TAMPS System Utilities

Alerts CSC�Header

Header���3.2.7.1.1�Alerts CSC�RTM affected���3.2.7.1.1.1�Alerts CSC�DTED updated���3.2.7.1.1.2�Alerts CSC�MIDB GMI updated���3.2.7.1.1.3�Alerts CSC�NID updated���3.2.7.1.2�Alerts CSC�Range Rings affected���3.2.7.1.2.1�Alerts CSC�DTED updated���3.2.7.1.2.2�Alerts CSC�MIDB GMI updated���3.2.7.1.2.3�Alerts CSC�NID updated���3.2.7.1.3�Alerts CSC�forward MIDB alerts���3.2.7.1.3.1�Alerts CSC����3.2.7.1.3.2�Alerts CSC����3.2.7.1.3.3�Alerts CSC���

Assumptions



RTDB #�CSC/CSU�Assumptions����������

Design

Preliminary Design

System Administrator Functions

Design Overview



The System Administrator functions affected by the MIDB are listed below.  These functions are grouped by the external event or HMI menu item that triggers the processing.  Although some of the external events can be initiated through a TAMPS HMI menu item (such as System Shutdown), they are treated here as external events because the processing is performed within the Unix system files rather than the TAMPS applications.



Only external events and HMI menu items that will (or could be expected to) be affected by MIDB processing are listed below, and only the processing associated with the MIDB software is described.

MIDB Product Summary



The System Administrator functions affected by each of the MIDB 2.0 products, services and roles are shown in the table below.  The System Administration role involves the following primary functions: System Installation, MIDB Installation, System Startup, User Administration.



MIDB 2.0 Products,

Services and Roles�Sys Admin Functions 

affected by MIDB 2.0 ��Database Schema�System Installation, MIDB Installation��Application Software���      Installation�MIDB Installation��      Loader���      Production Editors�User Administration��      Query Processing���      COTS�System Installation, MIDB Installation��System Services���      BLTS daemon�MIDB Installation, System Startup, User Administration��      DEX daemon�MIDB Installation, System Startup��      RPCs�System Installation or MIDB Installation��MIDB Roles���      Producer�User Administration��      Analyst�User Administration��      User�User Administration��



The MIDB 2.0 database schema affects primarily the MIDB Installation function, although the System Installation function must identify and reserve disk space for the MIDB 2.0 databases.  The new MIDB Installation function is dependent upon the MIDB 2.0 database schema throughout.  The planned use of GOTS to perform as much of the installation as possible should minimize the exposure of the TAMPS community to future changes in the MIDB database schema 



The MIDB 2.0 Installation Software is used by the MIDB Installation function to perform the installation.  Since TAMPS runs on a limited number of hardware configurations, we expect to be able to utilize the manual installation procedures outlined in the MIDB 2.0 Software Installation Plan  to install the software with a minimum of user intervention.



Utility applications associated with the MIDB 2.0 Production Editors will be required by the User Administration function to ensure that newly created users are assigned the MIDB roles and privileges that correspond to their TAMPS roles and privileges.



The MIDB 2.0 COTS and GOTS packages are installed by the System Installation and MIDB Installation functions.  Those packages which are required for other TAMPS processing (Sybase, for example), and libraries linked into TAMPS applications (ODBC, for example) will be installed by the System Installation function.  Some of these (such as Sybase) are COTS packages already used by TAMPS; we only need to verify that the correct version is installed and configured as required by MIDB 2.0.



The MIDB 2.0 System Services are initialized by the MIDB Installation function for processing by the System Startup function (with the possible exception of the RPC identifiers, which will be easier to initialize at System Installation).  The BLTS Daemon will be used by the User Administration function to ensure that newly created and modified accounts have MIDB access appropriate to their TAMPS roles and privileges.



The MIDB 2.0 User Roles are required by the User Administration function to ensure that newly created or modified accounts have access to the MIDB and to the MIDB 2.0 Production Editors as appropriate to the user’s TAMPS roles and privileges.

Design Summary

The System Administrator functions associated with the MIDB 2.0 software contain two major functions:  installing the MIDB, and ensuring that users have access to the MIDB applications and database.  An additional function included here is generating an alert when MIDB data referenced by a range ring or Radar Terrain Mask has been changed (since we cannot tell which data is actually being referenced by a range ring or RTM, we will generate the alert whenever any data is changed that might be referenced).



Unlike installation of the IDB, MIDB installation has been moved into a separate CSC.  This will enhance maintainability by keeping the related software together, as well as allowing TAMPS installations to be created without MIDB installed (although some functionality will not be available, there is a substantial reduction in the disk space required).  The existing IDB installation processing will be removed from the System Generation CSC.



MIDB installation on a TAMPS system will copy the MIDB software and data files to the appropriate locations.  It will then follow the manual installation procedures outlined in the MIDB 2.0 System Installation Plan for setting up the file permissions and ownership, creating the database schema, procedures, and static data.  It must then set up permissions for all existing TAMPS user accounts, and initialize the connection to the JMCIS MIDB server.



User administration for the MIDB software includes creating the user’s Sybase account (as is already done), initializing the user with the MIDB BLTS software, and assigning permissions appropriate to the user’s roles and privileges using the utility applications associated with the MIDB Production Editors.



There will also be a new TAMPS daemon process which will periodically check to see if any updates have been made to data that might affect the generation of RTMs or Range Rings, and to send an alert if there have been any updates.

Design

Much of the System Administration processing is triggered not by user interaction through a TAMPS HMI, but by external events.  Processing associated with external events are listed first (by event type), since this processing is the majority of the System Administrator processing for MIDB 2.0.  This is followed by processing associated with TAMPS menu items.

System Generation

The System Generation external event is initiated by the System Administrator entering the install TAMPS command at a Unix command line.



System Generation processing requires only a few changes for MIDB 2.0.  Most of the MIDB Installation processing is contained within the MIDB Installation CSC, which may, but is not required to, be called by the System Generation CSC.



The MIDB 2.0 software requires that the Unix operating system be set up  to use the Network Information Service (NIS) or NIS+ to store system information (users, groups, etc).  It is our understanding that the use of NIS+ is already planned for TAMPS 6.2, but it is included here for completeness.



COTS/ packages used both by MIDB and by other TAMPS applications must be installed.  These include Sybase 11.0.2, ODBC, ICS/Motif 1.2.4, and Perl 5.002.  The complete list is TBD.



One change in the installation of Sybase is that MIDB requires that the Sybase “sa” password not be null, as has been TAMPS practice in the past.  This will also improve the security level of the TAMPS system.



Disk space must be allocated for the MIDB software and databases on any TAMPS installation which might want to install MIDB (at System Generation time or in the future), which is expected to be all TAMPS installations except those which will be permanently set up as client workstations on a local area network.  This disk space may be spread across several disk partitions.  The disk space required will vary based on the MIDB configuration to be installed (which can be determined from System Generation parameters). For each MIDB configuration to be installed (except “custom”, which is not supported on fielded systems), there will be a pre-determined set of locations where the MIDB database files will be stored.  No other processing is required at this time with regard to this disk space.  



Note: 	The disk space allocated for the MIDB databases need no longer be on separate raw disk partition(s), as has been the TAMPS custom in the past, as we plan to use Unix filesystem files as the Sybase database devices.  The consensus is that using Unix filesystem files offers much more flexibility in database setup, better use of large disk partitions, potentially easier copying of databases from one machine to another, better integration with RAID devices, and little if any performance degradation (some say better performance can be expected).  The risk is in reduced database integrity should the Unix machine crash without flushing the file system buffers.  Given that TAMPS does not have a high degree of database activity, and does not depend on the Sybase transaction log to maintain up-to-the-minute database recoverability at present, we believe that this risk is not substantially greater than in the present TAMPS environment.  The allocation of space for other TAMPS databases can be on either raw disk partitions, or Unix filesystem files, without affecting MIDB processing.



The System Generation CSC must allow the System Administrator to specify whether the MIDB software and database should be installed and, if so, the System Generation CSC must activate the MIDB Installation CSC.  (If the MIDB is not to be installed at this time, then TAMPS HMI menu items which require the MIDB should be greyed out or removed until the MIDB is installed.  Removing the menu item, or causing the application to display an error dialog, is more consistent with TAMPS HMI guidelines than greying out the menu item)  It is expected that the majority of TAMPS installations will install the MIDB at System Generation time.  The design of the MIDB Installation, along with the associated concerns, issues, and risks, are discussed under the MIDB Installation CSC below.  Some of the issues regarding MIDB Installation may have an effect on the System Generation CSC design.



There are some MIDB Installation tasks that may be more convenient to perform at System Generation time, and which will not interfere with TAMPS processing (or require many system resources) on systems that do not install the MIDB.  These may include:  generating the RPC values (this requires knowing the exact MIDB version).



We will be installing the MIDB BLTS library and applications at System Generation time.  These provide a uniform, and more secure, method of accessing the database whether or not the MIDB is installed.  See the detailed discussion under the MIDB Installation CSC issues, below.



Installation of the IDB database schema and software will be removed from the System Generation CSC.  The System Generation CSC must still create the TAMPS Interim Threat database tables, however.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.1�1�use MIDB Installation CSC���3.2.2�3�restrict maintenance access���3.2.2�3.1�restrict archive access���3.2.2�3.2�restrict restore access���3.2.2�3.3�restrict load access���3.2.2�3.4�restrict MIDB maint.���HMI

The only expected change is that the System Administrator must be offered the option to install the MIDB; if the MIDB will be installed, then any inputs required by the MIDB Installation CSC should also be accepted.

Data Flow



Only a very high-level data flow diagram is presented for the System Generation CSC, since no change is expected in the data flow for this CSC (the data to be processed will change, for example, the specific COTS to be installed).



�
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Control Flow

Only a portion of the System Generation control flow is shown here, since the majority of the System Generation processing will remain unchanged.



�

Figure � STYLEREF 4 \n �4.1.1.2�-� SEQ Figure \* ARABIC �2�  System Generation Control Flow



Assumptions

Solaris 2.5.1 (or higher) is assumed to be already included in the TAMPS 6.2 delivery.  The change to Solaris 2.5.1will require other changes to TAMPS (mostly within the System Generation CSC) that are not described under this SOR.

We are generally assuming that no major MIDB processing needs to take place at System Generation on the system being installed.  Some software needs to be installed in the appropriate directories; some system startup scripts need to be placed into the system startup directory.

We are assuming that the MP-LAN SOR will take care of initializing the connection to the JMCIS Sybase server (specifically, putting an entry into the “interfaces” file in the TAMPS Sybase directory).

It is assumed that we will not need to install or initialize the Apache http daemon included in the MIDB delivery.  (See the discussion under Issues below).

No MIDB applications or libraries are required for minimal TAMPS operation; specifically, no MIDB libraries are linked into TAMPS applications.

Currently, System Generation initializes the TAMPS WSE menu bar so that only users with the Database Administrator role active can access the DBA application.  Since archive, restore, and load operations can only be activated from within the DBA application, this restricts these operations (for MIDB and all other TAMPS databases) to users with the Database Administrator role active.  MIDB maintenance functions are also expected to be activated from within the DBA application, so access to those functions will be similarly limited. 



Concerns / Questions /  Issues

Exactly what COTS packages (and versions) need to be installed at System Generation?  So far, we are aware of:  Solaris 2.5.1 (or higher), Sybase 11.0.2 (or higher), ODBC (package selection TBD), and Perl 5.002.

We will install the BLTS software at System Generation time, and install the system startup files to start the BLTS daemon process at system boot.  This is software which could be of use to other TAMPS processes, and will simplify the User Administration processing slightly.  See the detailed discussion under the MIDB Installation CSC design, below.

MIDB 2.0 requires the use of an HTTP daemon and a browser to display some of its help files (and to display its Characteristics and Performance Reference Database, which TAMPS is not planning to support at present).  It is our understanding that the JSIPS-N integration will require the use of an HTTP daemon and the Netscape browser, and that there will be a Mosaic browser (reviewed for the security issues described below) available on systems with the Performance Support Tools installed.  MIDB 2.0 is delivered with the Apache daemon and the Mosaic browser; however, we are not planning to install this software on TAMPS.  There are serious security issues with Mosaic and all existing browsers that we are aware of, since they allow the user to open and save any Unix file (subject only to the Unix file permissions).  It would require a major inspection of the TAMPS system, and changes to several subsystems, in order for the TAMPS system to be secure under these conditions.  TAMPS has been operating on the assumption that all access to TAMPS files is controlled through TAMPS, and several files (including the TAMPS roles and privileges information) have the Unix permissions set to allow write access, but are assumed to be only written by the TAMPS software.  We must also verify that the browser software will never allow a user access to a Unix shell (except as allowed by the TAMPS roles and privileges).  While it would probably be desirable to review the design of the TAMPS system, and make it more secure with respect to an unprivileged but knowledgeable user, such an effort is beyond the scope of this SOR.  Therefore, we are not planning to install the Apache http daemon and Mosaic browser delivered with MIDB 2.0.  However, if a browser is already installed for which these security issues have already been reviewed, we should be able to use that browser for the MIDB.

We are not aware of all the interconnections between the DIA-provided MIDB applications.  There may be a way for a TAMPS user who has been granted access to a permitted MIDB application to access an application the user would not normally have access to.  It may be possible to control this by disabling the HMI elements within the MIDB application, but even if possible, that could have undesired side effects.

Even if the MIDB is not being installed at System Generation, is there information that can be more easily determined at System Generation that will be required by MIDB Installation?  If so, can this information be stored somewhere for retrieval by MIDB Installation?



Risks

This SOR introduces new versions of existing COTS and new COTS packages to the TAMPS system.  Although no problems have been experienced and none are anticipated, any new COTS introduces some risk.

MIDB 2.0 requires Solaris 2.5.1 or higher.  Although this had already been planned as part of the TAMPS 6.2 delivery, it should be mentioned that the new version of Solaris will require other changes to the System Generation CSC that are not listed here.

Tasks

Identify the exact COTS/GOTS packages that must be installed on the system; verify that the versions of existing COTS are suitable; determine where those packages should reside on the installed TAMPS system; place the software and installation scripts into the appropriate directory on the TAMPS directory tree.

Verify that System Generation will install or upgrade the Solaris operating system such that it uses NIS+ to store system information.  (MIDB is documented to require all system information be stored in NIS or NIS+; it has been noted to require this for at least the RPC identifiers.)

Insert some way for the System Generation CSC to give the System Administrator the option to install the MIDB and, if selected, call the MIDB Installation CSC.  Ideally, if the System Administrator does not elect to install the MIDB, then all TAMPS menu items that require the MIDB should be removed or greyed out.

Are there items from the MIDB Installation CSC that would be better performed at System Generation time even if the MIDB is not being installed until a later time?  An example of this might be the RPC identifiers.

MIDB Installation

The MIDB Installation external event is initiated by the System Administrator selecting the System Admin -> Install MIDB menu item.  It will display an HMI dialog asking for the required inputs, and then pass these inputs to the script which will install the MIDB.



The MIDB Installation external event can also be initiated from within the System Generation CSC, and this is expected to be the method used for the majority of TAMPS installations.  In this case, the required inputs will already have been accepted by the System Generation CSC, which will call the MIDB installation script directly, passing the input values.



The MIDB Installation CSC is expected to follow the Manual Installation Procedures outlined in the MIDB System Installation Plan.  However, before starting this procedure we must identify the configuration to be installed and verify that there is enough available disk space to create the Sybase database container files.



It is expected that we will have the following configurations.  In each configuration, there is assumed to be a known set of disks where MIDB software should be installed, and the MIDB databases created.



“server”: a TAMPS CVIC server machine.  This system will have enough database space allocated to store the complete MIDB world-wide baseload, plus space for transaction logs and replication processing.

“workstation”: a stand-alone TAMPS system, or a TAMPS workstation connected to the MP-LAN.  This system will have enough database space allocated to store a partial MIDB baseload, with minimal updates expected (so less transaction log space), and no replication support.

“remote”: a TAMPS workstation connected to the MP-LAN which is never expected to be disconnected to serve as a stand-alone TAMPS system.  This system will not have a local MIDB database installed.  It will only have the software configured to access the MIDB database stored on a TAMPS CVIC server.



We will also support a “custom” configuration.  This option will use the MIDB “installmidb” application to give the System Administrator complete control over the database segment sizing and location.  This will facilitate installing TAMPS in a non-standard (such as a development system) environment.  However, when using the “custom” option, the MIDB Installation CSC cannot check whether there is sufficient disk space available, nor will the MIDB Installation CSC be able to perform other validity checking or provide help.  The “custom” configuration will be intended for use only by a knowledgeable System Administrator who has access to a copy of the MIDB Software Installation Plan, and it will only be available by running the MIDB installation script from a Unix command line.



In summary, the steps outlined in the SIP are as follows (some of these steps will not be necessary for a “remote” configuration):

Create the required Unix users (http, midb) and groups (http, midbdba, midbpadm, midbuser).

Add the required services, RPCs, and host aliases to the NIS+ tables, and the required syslog.conf entry to the /etc/syslog.conf file.

Copy in (and unpack, if necessary) the MIDB software and support data files.

Update the “site_params/SetMidbEnv.sh” file to update various environment variable settings.  We may be able to deliver a pre-modified version of this file that would depend on TAMPS-defined environment variables for those items that cannot be determined ahead of time (such as host names).

Run the “set_protection” and “CreateDynamic.sh” scripts.

Update the “CreateDevicesAndDatabases.sql” file to reflect the desired configuration of database device segments and database sizes.  We may be able to deliver several pre-modified versions of this file (one for each of a limited number of configurations), and select one file at installation time. 

Run the modified “CreateDevicesAndDatabases.sql” file.

For each database, create the datatypes, tables, defaults, and procedures.

Re-run the procedure creation in the MDUIQU, GMI, and ALERTS databases (is this working around an installation bug?  Will it still be required with the final MIDB 2.0 delivery?)

For each database, load the .BCP static data files.

The MIDB Software Installation Plan suggests that the initial MIDB baseload be loaded at this point.  (It is the most efficient place to do it, since the triggers and indices have not yet been created.)  However, loading the MIDB GMI data at this point does not match the TAMPS expectation of completing the installation process before loading any data, so this loading the GMI data will not be performed as part of MIDB Installation.

For each database, create the triggers and indexes.

Load the SUPPORT data and ALERTS data.

Run the “GrantDbObjectsPermission.sh”, “LoadAccession.pl” and “init_user_access” scripts.

Start the BLTS and DEX servers.

Register the Sybase “sa” password with the BLTS server.



Once the MIDB software, database schema, and static data have been installed per the SIP, we must install script files to be run at system startup to start the MIDB daemon processes (and start the TAMPS MIDB RTM daemon, if required, to watch for data changes that could affect Range Rings or RTMs).



Finally, we need to ensure that each existing TAMPS user is set up as an MIDB user, with the appropriate access to the TAMPS and JMCIS MIDB servers.  We will call the User Administration CSC to perform these actions for each user.



The BLTS daemon process maintains a list of Sybase users along with their encrypted Sybase passwords.  These passwords can then be retrieved by any process running under the Unix account of the same name.  This can be used to connect a user process to Sybase without having to ask the user for the Sybase password, or keeping the Sybase password available in an environment file or other open storage.  The BLTS software also provides interfaces (command-line and API) for creating  and managing Sybase accounts, and for terminating a Sybase process given its Unix process ID and application ID, and several BLTS maintenance functions.



We will install the BLTS software at System Generation so that it will be available for use by any TAMPS application.  This will be more secure (against both release of information and loss/damage of information) than the current TAMPS method of keeping the user’s Sybase password in an environment variable.  It will also simplify the User Administration CSC, since that would no longer need to check whether the MIDB had been installed before attempting to register an account with the BLTS daemon.  The disadvantages of installing the BLTS software at System Generation include losing the flexibility of using a Sybase account name different from the Unix account name (currently used in the development lab, but not, we believe, in a fielded environment), and more complicated setup for a development or limited-use setup that was not planning on using the MIDB, but does require some TAMPS applications.  However, these disadvantages are minor, and are believed to only affect the development systems, so should not have any impact on installed TAMPS environments.



After MIDB Installation is complete, files that are no longer used should be removed from the system to free up the disk space.  However, it is TBD at this time which files from the MIDB directories can be safely removed without impacting the DIA-provided GOTS.  The TAMPS menu item System Admin -> Install MIDB should be removed (or disabled) when MIDB Installation is complete.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.1�1�use MIDB Installation CSC���3.2.1�2�install TAMPS subset���3.2.1�2.1�install BLTS���3.2.1�2.1.1�install BLTS server���3.2.1�2.1.2�install BLTS client���3.2.1�2.1.3�install BLTS startup scripts���3.2.1�2.2�install Production s/w���3.2.1�2.3�install Data Exchange s/w���3.2.1�2.4�install Data Query s/w���3.2.1�2.5�install MIDB schema���3.2.1�2.5.1�three installation types���3.2.1�2.5.1.1�support “server” installation���3.2.1�2.5.1.1.1�“server”: all MIDB tables���3.2.1�2.5.1.1.2�“server”: complete load���3.2.1�2.5.1.1.3�“server”: scenario data���3.2.1�2.5.1.2�support “workstation” install���3.2.1�2.5.1.2.1�“workstation”: all MIDB tables���3.2.1�2.5.1.2.2�“workstation”: subset load���3.2.1�2.5.1.2.3�“workstation”: scenario data���3.2.1�2.5.1.3�support “remote” installation���3.2.1�2.5.1.3.1�“remote”: apps only���3.2.1�2.5.1.3.2�“remote”: needs connection���3.2.1�2.6�install sep from Sys Gen���3.2.1�2.6.1�check for disk space���3.2.1�2.6.2�exit if not enough disk space���3.2.1�2.7�user-specified parameters���3.2.1�2.8�assign MIDB Server ID���3.2.1�2.8.1�use Server ID for SK gen���3.2.1�2.8.2�do not ever repeat SK’s���3.2.1�2.9�initialize access to JMCIS���3.2.2�1�init user access to MIDB���3.2.2�2�user access to JMCIS MIDB���HMI

The following inputs may be required to the MIDB Installation CSC.  It is still TBD whether any of these values can be automatically determined from information already available (using an automatically-determined value is preferable to requesting the user to enter a value). When MIDB Installation is initiated from within the System Generation CSC, the input values should be accepted by the System Generation CSC at the same time as other user input, and passed to the MIDB Installation CSC.

Type of configuration (server, workstation, remote).  This is expected to be determined from the SYSTEM_CONFIG environment variable set by System Generation.

MIDB Server ID.  It is TBD whether this can be generated automatically, although this would be preferable to accepting a manual user entry value.  See the discussion under Concerns below.

RESPROD value assigned to local users. There will probably be a default for TAMPS installations, but there may be a need to override this value -- for example, TERPES.  This is expected to be determined from the SYSTEM_CONFIG environment variable set by System Generation.

 

The Sybase “sa” password. This will be available when called from System Generation, and may be available without user entry (for example, from an environment variable) otherwise.

The JMCIS Sybase server name and other information.

Data Flow
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Control Flow

See the Data Flow diagram above.  

Assumptions

The following items will be required as inputs to the MIDB installation process as outlined in the SIP.  However, these values are expected to be the same for all TAMPS installations, or dependent only on the MIDB configuration selected by the System Administrator, and will not require user input at runtime (except in a “custom” configuration).  The exact values are TBD.

MIDB root directory (perhaps “/opt/midb”)

MIDB output directory (somewhere under “/tamps/dynamic”?)

On a “server” system which will be connected to JMCIS, the JMCIS files “data/user/network_users”, “data/user/user_access”, and “site_params/DbPassword” will be available during the MIDB installation process.  These paths are given with reference to the MIDB root directory on the JMCIS system.  The DSQUERY value used to access the JMCIS Sybase server is also assumed to be available (presumably in an environment variable).

The Manual Installation Procedures from the SIP are a complete description of what needs to be done to install the MIDB software.  According to a comment at the MIDB Developer’s Conference, these procedures have not been thoroughly tested.

We can determine a small number of pre-defined MIDB database configurations that the System Administrator can select from when installing the MIDB. 

Concerns / Questions /  Issues

How do the MIDB Server ID and RESPROD values get set during a manual installation?  These values were not mentioned in the Manual Installation Procedures from the SIP.

Do we need a configuration for a client workstation initially connected to the TAMPS CVIC server?  Or does a client workstation get installed as a standalone workstation, which does an MP-LAN connection immediately following installation?  Does the answer to this vary if we are doing an installation at System Generation vice a later time?

Should the MIDB software and static data files come from the TAMPS installation media, or should we distribute a copy of the DIA MIDB Installation media with the TAMPS distribution?  The advantages of keeping the MIDB software with the TAMPS installation are: easier installation, less distribution hassles, fewer variables (such as version number), and much more chance to pre-configure the software.  The advantage of using the DIA installation media is the ability of a TAMPS installation to use upgrades of the DIA software much more quickly than if they must wait for those upgrades to be included in a TAMPS delivery.  We will be assuming that we will include the MIDB files within the TAMPS installation media, but it will be noted if the behavior would be different if reading from an MIDB installation tape.

Do we need a method to upgrade a “remote” installation to a “workstation” (beyond the transitions supported by MP-LAN connection/disconnection)?

How will the MIDB Server ID values be assigned?  

At last report, it was still TBD by DIA how these values will be assigned.  Most likely, each service will be assigned a block of values, and the Navy will allocate TAMPS a subset of their block.  But we still need a way to assign each TAMPS system a unique ID within this block.

It might be possible to use the host ID or some other system-specific value and map that to the range of valid MIDB server ID’s.  However, this would not guarantee uniqueness. 

Each new or updated MIDB record has a “surrogate key” assigned to it.  This “surrogate key” contains the MIDB server ID, plus a counter to ensure that no two records within the same table have the same surrogate key value.  

Since a MIDB record created by a TAMPS system could be copied to another MIDB database in several different ways (archive/restore, TF export), it is required that each TAMPS system (excepting “remote” installations) have a unique MIDB server ID.  It may seem unlikely that such a record would find its way to another system using the same server ID, but the integrity of the MIDB depends on the uniqueness of the surrogate key values within a database table.

The MIDB Server ID value should not be changed by a restore of a dump (or archive) if there is already an existing Server ID value.

How can we prevent re-generating surrogate key values when a TAMPS system (and the MIDB) is reinstalled?  

Just as we must never assign the same MIDB server ID to two separate TAMPS systems, an MIDB server must never reset the counters used to generate the surrogate keys.  

This is a difficult problem, given that TAMPS System Generation is designed around the principle of re-initializing the system from scratch when a new version of TAMPS is installed (or any time the System Administrator thinks re-installing the software might fix a problem).  

Without a complete redesign of the System Generation software, the best solution to this problem may be to instruct the TAMPS System Administrators to dump their MIDB databases before re-initializing, and restore those databases afterwards.  

Any MIDB upgrades that are delivered must also not destroy and re-create the database from scratch (at least the SUPPORT database, where these values are stored, must be maintained).

Care must be taken when restoring a dump (or archive) of the MIDB database so that the surrogate key counters are updated only if the counters in the database being restored are for the same Server ID, and are higher, and the current database.

It should be possible to restore a dump of the MIDB that was made on another TAMPS system (assuming that the Server ID issue above is worked out).  When restoring a dump from another system, we probably only want to restore the GMI data (including TGT).  Can we detect that the dump was restored on another system?  We may need to define two separate dump capabilities -- a dump for backup purposes, to be restored on the same system in case of database failure, and a dump for transportation purposes.  Restoring a dump taken on a JMCIS system is not supported by Sybase, because the two systems run on different platforms.

What RESPROD value should be used for the TAMPS server?  It is likely that a TAMPS system will not be considered the RESPROD (responsible producer) for any portion of the MIDB.  However, the MIDB installation requires that a RESPROD code be specified.  This issue may depend on the “Local Record” modifications proposed by JMCIS and being worked by DIA.

It would be possible to design the MIDB installation CSC to support installation directly from a DIA-provided MIDB tape.  This could allow the fielded systems to more quickly install a new MIDB version.  However, the potential drawbacks of such a design are many:  If the new MIDB version has not been verified for compatibility with the rest of TAMPS, this would place a risk on the installing system; if TAMPS is required to make changes in any MIDB software or data, this could conflict with those changes; and fielded systems may not have access to the DIA-provided tapes.  Therefore, we do not plan to offer such support.  If we are installing from the DIA MIDB installation media, we will require a foolproof method of determining the correct MIDB version number.  There was some confusion during test installation of the MIDB beta tape, where the version number was expected to be “2.0” (as outlined in the Software Installation Plan), but for this beta delivery was actually “20b”.  There should be a way for TAMPS to determine this value without requiring the user to input it, but the best way to do this is TBD.  (If the MIDB software is delivered as part of a TAMPS delivery, then the installation scripts can be modified if needed to match the current version number.)

Do we need to match RPC numbers with JMCIS?  If so, what values are they using?

What happens if TAMPS and JMCIS both create a user with the same name?  Can we detect this situation before creating the TAMPS account?  Do we need to (and can we) share a common user database?

Although the MIDB software is believed to be unclassified, some of the static data loaded with it may be classified.  This should be taken into consideration when determining where on the TAMPS system the MIDB should be located.  This is not expected to be an issue for System Generation or MIDB Installation, but the possibility should be kept in mind

The manual installation procedures outlined in the MIDB Software Installation Plan only cover what they call a “full” MIDB installation.  We need to know which steps need to be performed for a “remote” configuration, and which steps need to be performed to connect to JMCIS.

The behavior of the MIDB software in a two-server (TAMPS and JMCIS) environment is not clear.  The software does support this environment (many screens have an option menu to select the server to use), but the details of account management, permission setup, etc. need to be investigated.

What is needed to initialize the connection to JMCIS?  We probably need to add their data server to our Sybase interfaces file, so we will need that information.  We may need their SA password.

What steps are necessary to perform a “remote” installation?  If the database is located on the server system, and the software is located on a disk mounted on the server system, is there any setup necessary on a “remote” system?  (If no steps are necessary to perform a “remote” installation, then there is no conflict if we upgrade the system to a “workstation” configuration later.) 

What is needed to support the help menu items from within the MIDB applications?  Some menu items are known to be self-contained within the application; others bring up an HTTP browser displaying a page with the help text.  Are there other help systems in use?  Can any HTTP browser (and daemon) be used?  Supporting the help screens from within the MIDB editors (Production System) should be given priority.

Can we support allowing MIDB edits on the TAMPS server when JMCIS becomes unavailable (and is expected to remain to for an extended period)?  Although it is relatively simple to switch the configuration so that the edits are directed to the TAMPS CVIC server database, resuming the connection to JMCIS would be extremely difficult.  Replication would need to be stopped; the TAMPS and JMCIS databases would need to be brought back into synchronization, and the replication would need to be re-started.  If a dump/restore from JMCIS to TAMPS is feasible, then this recovery could take an hour or so.  However, if the dump/restore is not feasible, then it may not be possible to recover without re-baseloading both JMCIS and TAMPS.  Therefore, we do not plan to support allowing edits when a TAMPS server (configured to expect JMCIS connectivity) cannot connect to JMCIS.

Risks

The MIDB software must be considered a large risk, as this software is still under development.  Due to the schedules of the two projects, TAMPS will be required to run one of the first releases of MIDB 2.0.  There is a risk that this software may contain bugs.  There is also a risk that changes made late in the MIDB development cycle could have an impact on TAMPS.  Also, there is a risk that if the announced MIDB schedule cannot be met by DIA, TAMPS might not receive the official MIDB 2.0 delivery until too late in its development cycle to meet its schedule.

It is still TBD how TAMPS should create new records and modify existing records in such a way that the new records are immediately visible, and the original records are still available if requested.  This is dependent on the “Local Record” proposal written by JMCIS and under consideration by DIA.  There is also a risk that these changes, even if accepted by DIA, will not make it into an early release of MIDB 2.0.  We must create these new and modified records in the same way that JMCIS will, since in a TAMPS-Afloat environment, we will be making modifications in the JMCIS database.

As described above under Concerns, there is a risk of a TAMPS system (or two separate TAMPS systems) generating new or modified records with identical surrogate key values.  The MIDB depends on the uniqueness of the surrogate key values, and at best a duplicate key would lead to the affected record(s) being corrupted.

Interfacing with JMCIS has several risks associated with it.  They may not be running the same version of the MIDB software that we are (especially since their version has been ported from Solaris to HP-UX), and this could cause problems.  If they make local changes to the MIDB (or if TAMPS does), that could cause problems.  This interface will require coordination between the TAMPS and JMCIS System Administrators on several points.  In short, this is a new interface for TAMPS, and there are many risks associated with interfacing to any outside system.

Tasks

Determine the exact configurations to be used for the various TAMPS MIDB configurations (server, workstation, remote).  This includes what disk files should be used for database segments, how big each segment should be, and what MIDB databases should be allocated to each segment.

Write scripts to install the MIDB using the steps described in the Manual Installation Procedure.  Where the procedures call for a file to be edited, provide a pre-edited version of the file whenever possible (or one pre-edited version for each installation configuration).

Determine which of the MIDB Installation tasks need to be performed for a “remote” installation.

Increase communication with JMCIS and DIA personnel with regard to the “Local Record” proposal and the eventual CONOPS for creating and querying new and updated MIDB records. 

Coordinate with development of System Generation CSC to allocate tasks between the two CSCs, and to resolve input value generation.

System Startup

The System Startup external event is initiated by the Unix system when the system is booted up.



No software is delivered under a System Startup CSC.  Instead, script files are installed into the Unix system directories by the System Generation and MIDB Installation CSCs to be run at system startup.



The processing required by MIDB 2.0 at system startup includes:  starting the Sybase data servers, starting the MIDB daemon processes, and starting the TAMPS MIDB RTM daemon (to watch for changes to data that may affect RTMs or Range Rings, and send alerts.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.1�2.1.3�install startup scripts��� 

HMI

Not applicable to this event.

Data Flow

Control Flow



For systems that have not installed the MIDB, the only change will be to start the BLTS server as part of system startup (after Sybase has been started, but before any TAMPS servers that will use the database are started).  For systems that have installed the MIDB, additional startup scripts will be installed to start the DEX server and the new TAMPS RTM server.  The DEX server can be started any time, but will be started at the same time the BLTS server is started.  The new TAMPS RTM server should be started after the TAMPS network and WSE servers have been started.



All existing functionality in this CSC will be left unchanged by this SOR. 
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Assumptions

The existing Sybase startup scripts will handle the Sybase server startup.

The startup scripts delivered with the MIDB software will handle the startup of the MIDB and DEX daemon processes.

If any special processing is required at this time regarding Sybase replication, it will be handled by the MP-LAN software.

Concerns / Questions /  Issues

All the daemon applications, or the startup scripts used to start them, need to be prepared for Sybase not being ready immediately.  The Sybase server will take some time to verify the database consistency and process the transaction log before allowing applications to connect to the databases.

Risks

If the BLTS daemon fails to start, then users would be locked out of MIDB updates, and could be locked out of other database accesses.

If the DEX daemon process fails to start, then no MIDB loads or unloads will be able to be processed.  This should not affect MIDB edits or replication from JMCIS, though.

If the TAMPS MIDB RTM daemon process fails to start, then no alerts will be generated if data that could affect an RTM or Range Ring will be generated.  There will be an alert generated when the TAMPS MIDB RTM daemon is next successfully started.

Tasks

Verify that the scripts provided with the MIDB software are suitable for starting the BLTS and DEX daemons in the TAMPS environment

Write the startup/shutdown scripts for the TAMPS MIDB RTM daemon.

System Shutdown

The System Shutdown external event is initiated by the Unix system when the system is shut down.  Most commonly in a TAMPS environment, this is initiated by the System Administrator selecting the System Admin -> System Shutdown menu item from the TAMPS Workstation Environment (WSE) menu bar.  It is important to note that this processing will not occur if the system does not perform an orderly shutdown -- this might happen, for example, if the power is lost or in case of a Unix system crash.



No software is delivered under a System Shutdown CSC.  Instead, script files are installed into the Unix system directories by the System Generation and MIDB Installation CSCs to be run at system shutdown.



The processing required by MIDB 2.0 at system shutdown includes:  stopping the Sybase data servers, stopping the MIDB daemon processes, and (if required) stopping the TAMPS MIDB RTM daemon.

Requirements

Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.1�2.1.3�install startup scripts���HMI

Not applicable to this event.

Data Flow

No substantial change is being planned for this processing, so no Data Flow diagram is presented. 

Control Flow

For systems that have not installed the MIDB, the only change will be to stop the BLTS server as part of system startup (after any TAMPS servers that will use the database are stopped, but before Sybase has been stopped).  For systems that have installed the MIDB, additional startup scripts will be installed to stop the DEX server and the new TAMPS RTM server.  The DEX server can be stopped any time, but will be stopped at the same time the BLTS server is stopped.  The new TAMPS RTM server should be stopped before the TAMPS network and WSE servers have been stopped.



All existing functionality in this CSC will be left unchanged by this SOR.  Processes are normally stopped in the reverse of the order in which they were started at System Startup. 
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Assumptions

The existing Sybase shutdown scripts will handle the Sybase server shutdown.

If any special processing is required at this time regarding Sybase replication, it will be handled by the MP-LAN software.

The same startup scripts installed for the System Startup event for the MIDB daemon processes and (if required) the TAMPS MIDB RTM daemon process will also handle system shutdown (distinguishing between startup and shutdown by the argument passed in by the Unix system).

Concerns / Questions / Issues

None

Risks

If any of the daemons need to do any Sybase processing , then we must make sure that there is a reasonable time allowed for this before shutting down the Sybase server.

Tasks

Make sure that the startup files can also handle the system shutdown.  The usual way to do this on Unix is to use the same file as the startup file and shutdown file, with the script expecting an argument of “start” for startup and “stop” for shutdown.

User Login

The User Login external event is initiated by the Unix system when a user logs into the system.



No software is delivered under a User Login CSC.  Instead, script files are installed into the user’s home directory and the TAMPS environment directory by other CSCs to be run at user login.



The processing required by MIDB 2.0 at user login includes: setting all environment variables as required for MIDB processing, including setting values to direct MIDB queries and edits to the appropriate data server.  This will be handled by adding an “tamps_midb.env” file to the TAMPS environment directory.



Requirements

Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.1�2.1.3�install startup scripts���HMI

Not applicable to this event.

Data Flow

No substantial change is being planned for this processing, so no Data Flow diagram is presented.

Control Flow

No substantial change is being planned for this processing, so no Control Flow diagram is presented.

Assumptions

The only login processing required is setting environment variables.

Concerns / Questions /  Issues

Initial testing has indicated that the standard MIDB environment file wants to add a fairly large number of directories to the user’s executable search path.  Combined with the number of directories that the existing TAMPS environment places in the search path, the result is too long for the Unix system to process (the error message is “ridiculously long PATH truncated”).  We may not want to source the standard MIDB environment file for normal processing; instead, before starting any MIDB applications, we will source the MIDB environment for that application only.

Should we add to (or modify) the existing “tamps.env” file, or create a new file to be sourced by that?  Currently the only separate environment files that are included are for the MPMs.

Risks

Merging in the TAMPS and MIDB environments may have unintended side effects on the MIDB processes.  In particular, coming up with a combined executable search path may cause application failure if a required directory is left out of the path.

Tasks



User Logoff

The User Login external event is initiated by the Unix system user startup files when a user logs off of the system.  Most commonly, this is initiated by the user selecting the Logoff menu item from the TAMPS WSE menu bar.  It is important to note that this processing may or may not take place in the event of a TAMPS session crash, and will not take place in the event of a Unix system crash (or power loss).



No software is delivered under a User Logoff CSC.  Instead, script files are installed into the user’s home directory and the TAMPS environment directory by other CSCs to be run at user logoff.



No processing is expected to be required by the MIDB 2.0 software for this event.  

Requirements

No new requirements.  This section has been added to this SOR to document the assumption that no processing is required. 



HMI

Not applicable to this event.

Data Flow

No substantial change is being planned for this processing, so no Data Flow diagram is presented.

Control Flow

No substantial change is being planned for this processing, so no Control Flow diagram is presented.

Assumptions

No special processing is required for this event.

Concerns / Questions /  Issues

None.

Risks

None.

Tasks

None

MP-LAN workstation connection/disconnection

The MP-LAN workstation connection external event is initiated by the MP-LAN software when a standalone TAMPS workstation becomes a client of a TAMPS server. The MP-LAN workstation disconnection external event is initiated by the MP-LAN software when a client TAMPS workstation becomes a standalone TAMPS system.  These are not truly external events from a TAMPS system perspective, but they can be most easily considered as such from the MIDB subsystem perspective.  We are dependent on the MP-LAN software to perform most of the processing for this event, and to call the MIDB software for its processing, if required.



The processing (that may affect the MIDB processing) required when a workstation connects to the MP-LAN includes: altering the workstation startup files not to start the MIDB daemon processes, creating accounts for users on the workstation not already on the server; directing MIDB queries to the TAMPS server and MIDB edits to JMCIS.  



The processing (that may affect the MIDB processing) required when a workstation disconnects from the MP-LAN includes:  altering the workstation startup files to start the MIDB daemon processes; create accounts for specified users on the workstation; directing MIDB queries and edits to the local database.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�5.1�standalone edit locally���3.2.3�5.2.1�disable local edit on connect���3.2.3�5.2.2�enable local edit on disconnect���3.2.3�5.3�MP-LAN edit on JMCIS���3.2.3�5.3.2�replication from JMCIS���3.2.3�5.3.3�updates from JMCIS���3.2.4�3.5�MP-LAN edit on JMCIS���3.2.4�3.5.2�replication from JMCIS���3.2.4�3.5.3�updates from JMCIS���HMI

Not applicable to this event, except as described under User Administration CSC.

Data Flow

Data Flow for this event is described in the MP-LAN design.

Control Flow

Control Flow for this event is described in the MP-LAN design.

Assumptions

The MP-LAN SOR will take care of all processing associated with connection and disconnection of workstations from the MP-LAN.  This includes at least:  updating environment files, updating system startup files, creating user accounts.

MP-LAN will call the User Administration CSC as modified by this SOR (described below) to create accounts as required on the client or on the server.  This SOR will provide a function to create an account with access to the MIDB server(s).

Concerns / Questions /  Issues

One issue regarding the client workstations connected to the MP-LAN is the MP-LAN requirement that the databases (including MIDB) be updated regularly.  However, the client workstations are not going to have enough disk space to store the entire MIDB as kept on the TAMPS server.  There will need to be some process to extract a subset of the MIDB data to be downloaded to the client.  It is not clear whether MP-LAN will require functionality from the MIDB SOR to accomplish this task.

Risks

There is a risk in having two SORs that must interface with each other being designed at the same time, by different groups, with the designs constantly changing.

Tasks

See below, under User Administration CSC.



JMCIS MIDB server unavailability/availability

The JMCIS MIDB server unavailability external event occurs on the TAMPS server when the JMCIS MIDB server is detected as having become unavailable (due to JMCIS shutdown, crash, or network failure).  The JMCIS MIDB server availability external event occurs when the JMCIS MIDB server is again available for use after having been shutdown or crashed. We are dependent on the MP-LAN software to detect this event, and to call the MIDB software for its processing, if required.



A request by a TAMPS user (in a TAMPS-Afloat environment) to edit the MIDB while the JMCIS MIDB server is unavailable must be detected and an error message displayed.  If the GMI Editor CSC cannot detect this condition, then the MIDB software must be called on this event to set (or clear) a flag somewhere to indicate that editing the MIDB is not allowed because the JMCIS MIDB server is unavailable.



There may also be processing required to take care of replication.  It is assumed this processing, if required, is performed by the MP-LAN software.



There may be some benefit to allowing the System Administrator to alter the TAMPS server configuration so that edits are allowed on the TAMPS server if JMCIS is expected to be unavailable for an extended period.  If this change was made, then replication could not be resumed again from JMCIS until the two databases had been brought back into sync.  Due to the minimal benefit of this option (and the high cost of the System Administrator selecting this option by mistake), we are not planning to implement this option at this time.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�5.3�edit against JMCIS MIDB���.

HMI

Not applicable to this event.

Data Flow

Data Flow for this event (if any) is described in the MP-LAN design.

Control Flow

Control Flow for this event (if any) is described in the MP-LAN design.

Assumptions

The MP-LAN SOR can detect these events, and will call the MIDB software if required.

The MP-LAN SOR will take care of any processing required for this event to maintain replication.

Concerns / Questions /  Issues

Can the GMI Editor CSC detect that the JMCIS server is unavailable without any processing required by the MIDB software for these events?

If we did implement the option to allow local MIDB edits on the TAMPS server, we would need to work out a detailed CONOPS with JMCIS on how the databases can be resynchronized (especially if the TAMPS edits must be preserved), and with MP-LAN on how to prevent replication until resynchronization is complete.

Risks

The MP-LAN software may not be able to detect these events, or may not be able to detect and process them reliably (for example,  if a “JMCIS unavailable” event was processed but the “JMCIS available” event was lost, TAMPS might prevent MIDB edits when it should allow them).

If the option to allow local MIDB edits was implemented, a TAMPS System Administrator could select this option when it was not appropriate -- thus causing a substantial delay while the databases are resynchronized.

Tasks

If the GMI Editor CSC cannot detect that the JMCIS server is unavailable, then we must write scripts and arrange for MP-LAN to call them when these events are detected.  These scripts should set (and clear) a flag somewhere (probably in the TAMPS database) indicating that MIDB edits are not allowed.  The GMI Editor CSC must then check this flag and, if set, display an error message to the user.

Otherwise, no processing is required by the MIDB software.

TAMPS CVIC server unavailability/availability

The TAMPS CVIC server unavailability external event occurs on the TAMPS client workstations when the TAMPS CVIC server is detected as having become unavailable (due to system shutdown, crash, or network failure).  The TAMPS CVIC server availability external event occurs on the TAMPS client workstations when the TAMPS CVIC server is again available for use after having been shutdown or crashed. We are dependent on the MP-LAN software to detect this event, and to call the MIDB software for its processing, if required.



Processing on the TAMPS CVIC server is covered under the System Shutdown and System Startup external events (or under the TAMPS client workstation unavailability/ availability event, below).



No processing is expected by the MIDB software in this case, since no functionality is required of the client workstations when the CVIC server is not available (except the ability to disconnect from the network and become a standalone TAMPS system -- this is covered under MP-LAN disconnection, above).



It is possible, though unlikely, that there will be processing required to maintain replication between JMCIS and TAMPS.  It is assumed this processing, if required, is performed by the MP-LAN software.

Requirements

The requirements for this event are assumed to be covered under the MP-LAN SOR.  This section was added to this SOR to document this assumption.  

HMI

Not applicable to this event.

Data Flow

Data Flow for this event (if any) is described in the MP-LAN design.

Control Flow

Control Flow for this event (if any) is described in the MP-LAN design.

Assumptions

The MP-LAN SOR can detect these events, and will call the MIDB software if required.

The MP-LAN SOR will take care of any processing required for this event to maintain replication.

No functionality is required of the client workstations while the TAMPS CVIC server except the ability to disconnect from the MP-LAN and become a standalone TAMPS system.

Concerns / Questions /  Issues

None

Risks

None

Tasks

None

TAMPS client workstation unavailability/availability

The TAMPS client workstation unavailability external event occurs on the TAMPS server when a TAMPS client workstation is detected as having become unavailable (due to system shutdown, crash, or network failure).  The TAMPS client workstation availability external event occurs when a known TAMPS client workstation is again available for use after having been shutdown or crashed. We are dependent on the MP-LAN software to detect this event, and to call the MIDB software for its processing, if required.



These events refer only to known clients that become unavailable (presumably temporarily).  Clients planning to disconnect from the MP-LAN are covered under the MP-LAN disconnection external event; new client workstations should perform a MP-LAN connection.  It should be noted, though, that it is possible for the TAMPS CVIC server to become unavailable, and a client workstation to disconnect while the server is unavailable.

In this case, when the TAMPS CVIC server becomes available it would not see a MP-LAN disconnection event; it may see a TAMPS client workstation unavailable event.  Neither of these events, though, are expected to require processing from the MIDB software, and a complete investigation of this sequence of events is left to the MP-LAN design.



No processing is expected to be required for these events by the MIDB software.

Since the workstations are not planned to be involved in database replication, it is not expected that there will be any processing required to maintain replication.  It is assumed that if there is any processing required, it will be performed by the MP-LAN software.

Requirements

The requirements for this event are assumed to be covered under the MP-LAN SOR.  This section was added to this SOR to document this assumption. 

HMI

Not applicable to this event.

Data Flow

Data Flow for this event (if any) is described in the MP-LAN design.

Control Flow

Control Flow for this event (if any) is described in the MP-LAN design.

Assumptions

The MP-LAN SOR can detect these events, and will call the MIDB software if required.

The MP-LAN SOR will take care of any processing required for this event to maintain replication.

Concerns / Questions /  Issues

None.

Risks

None.

Tasks

None.

MP-LAN client database update

This event is generated by the user indicating that the databases on the TAMPS client workstation(s) should be updated from the TAMPS server.  These databases will be used in case the server becomes unavailable and the clients wish to disconnect.  This event may also be referenced from within the MP-LAN client disconnection event, described above.  The details of how this event is initiated, and the overall processing of the event, is described in the MP-LAN SOR.



As part of this update, the TAMPS MIDB software must generate a subset of the MIDB GMI database.  This database will be copied to the client workstation(s), and loaded into the client Sybase server(s), by the MP-LAN SOR.  This subset of the GMI database must be placed within a separate database, which can then be dumped and copied to the clients.



Two methods have been identified for creating this subset.  

The TAMPS MIDB software could be called by the MP-LAN software when a client database update is being prepared.  The TAMPS MIDB software would then run queries to copy the subset of the GMI data into the separate database.

The TAMPS MIDB software could set up and maintain a replication that would continuously maintain the subset of the GMI data.



At this point we are planning to implement the first option -- having the MP-LAN software call this software to prepare the GMI subset data.  Setting up a replication subscription would increase the complexity of the software, and the attendant risks, since all replication issue have been handled by the MP-LAN SOR to date.



We are also planning to implement a tool which will allow the Database Administrator to select which tables should make up this subset.  At this point, we are only planning on allowing this subset to be specified by table name.  If DIA implements a proposed change to the MIDB schema that will allow all tables to be selected by country code, then we should add functionality to this tool that will allow the subset GMI data to be selected based on country code as well as table name.

Requirements

The requirements for this section are derived requirements from the MP-LAN SOR.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.2�4�generate GMI subset���3.2.2�4.1�user specify GMI subset���HMI

This is a tentative HMI diagram for the tool used to create the subset of the GMI data to be downloaded to the client workstation databases.  There are three options for each sub-dataset, All, Some, and None.  If the user selects Some, then a second dialog will pop up, containing a list of tables within that dataset (with the tables to be downloaded selected within the list).  This HMI will be invoked from a new menu item (on the Database Administrator application), Utilities -> MIDB -> GMI Subset.
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Data Flow

TBD.  There will be a new database relation created DD_MIDB_GMI_SUBSET, to save the selected table subset.

Control Flow

TBD

Assumptions

If we create a database containing the subset data, MP-LAN will take care of dumping the database, copying the file to the client, and loading the dump file to the client database.

Concerns / Questions /  Issues

What would be involved if we were to use replication?  

Could we just create a replication subscription and assume that the existing MP-LAN processing will take care of maintaining the replication?

Are there any issues with doing replication from one table to another within the same server?

What impact would there be on the baseload processing?

What tables should be turned on by default?  We have a tentative list of the following tables, along the _TIE table associated with each of these tables.

EQP/EQP_IDX:  EQP, EQP_ELINT_MODE, EQP_IDX

FAC:  FAC

TGT: TGT_DETAIL

UNIT: UNIT

Should there be any sort of sanity checking to make sure that the selected subset is a usable subset?  What rules should be used?  Should there be tables that must always be selected regardless of the user’s input?

How long will it take to perform the download?  Will the time required have an impact on the MP-LAN processing?  Should the MIDB subset processing be a separate operator action from the MP-LAN client data download?

Does the MP-LAN processing run once for each client workstation, and if so, can we avoid creating the subset multiple times?

Will there be a noticeable impact on system performance while the subset is being created?

Is there a better term than “sub-dataset”?  That is a rather awkward term.  The DIA MIDB software and documentation uses the term “view”, but this might be confusing to a TAMPS user.

Risks

Allowing the user to select the set of tables to download may allow the user to select a set of tables that will not be usable on the client workstation.

The database to be used to store the separate database must be the same size as the database on the client workstation.

Allowing the user to select the set of tables to download may allow the user to select a set of tables that will be too large for the subset database.  Can we calculate the size required within the HMI, and warn the user if it may be too big?  That would be desirable, but it may take a significant amount of time to calculate.

Tasks

Work out a final CONOPS on this issue with MP-LAN.

Determine the set of tables to be downloaded by default.  This is dependent on the final MIDB 2.0 database schema.

Write the HMI to allow the subset to be specified.

Write the software to create the subset database.

JMCIS MIDB baseload

It is TBD how this external event will be generated.  A much more detailed CONOPS needs to be worked out with JMCIS and MP-LAN on how processing should proceed when JMCIS does a new MIDB baseload (or a TF update which might overload the replication server).  It is probable that this will end up being two (or even three) external events:  JMCIS beginning baseload, JMCIS completed baseload, TAMPS completed baseload.



The basic design of what needs to happen in this case is:

JMCIS and TAMPS both disallow MIDB editing.

Replication of the MIDB is stopped between JMCIS and TAMPS.

JMCIS does the MIDB baseload.

JMCIS completes the MIDB baseload.

JMCIS begins queueing up replication updates but these must *not* be processed by TAMPS yet.

JMCIS allows MIDB edits (from JMCIS only).

TAMPS does the MIDB baseload (can be done in parallel with 3-6 if two data tapes are available).

TAMPS completes the MIDB baseload.

TAMPS begins accepting replication updates from JMCIS.

TAMPS allows MIDB edits (directed to JMCIS).



The processing required from the TAMPS MIDB software is:

disallow MIDB edits and stop replication while baseload in progress

do baseload using same source as JMCIS

begin accepting replication updates and allow MIDB edits.



It has been proposed that we get our baseload from JMCIS using Sybase dump / restore.  This would require TAMPS to define its MIDB databases to be exactly the same as the JMCIS databases.  This would probably lock us in tighter to JMCIS than we want to be, since we do not know at this point what their database configuration will be.  It would, however, have the advantage that it might be possible to completely automate the processing on the TAMPS system.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�3.12�process JMCIS updates���HMI

TBD.

Data Flow

This data flow is based upon the initial design described above, and is subject to change pending a final CONOPS between TAMPS and JMCIS on this issue.  Also, the diagram shows both a data path from the MIDB baseload tape to the TAMPS GMI database (through DEX) and a data path from the JMCIS GMI database to the TAMPS GMI database (through dump/restore).  Only one of these data paths is expected to be present in the final design.  The dump/restore data path will be selected if we can reliably do a dump on the JMCIS system and restore that dump on the TAMPS system, since this can be more fully automated, and ensures that the two GMI database are identical (as required for replication to be started).  However, doing a dump/restore across different platforms may not be supported by Sybase.



.
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Control Flow

This control flow is also based on the initial design described above, and is subject to change pending a JMCIS/TAMPS CONOPS.  It does not show any error checking or synchronization mechanism between JMCIS and TAMPS; these will be covered in detailed design.  



Depending on the time required for TAMPS to load its database, JMCIS may combine the “start queueing updates” and “begin sending updates” steps into one step, with this step and “allow MIDB updates” to be performed after TAMPS completes its baseload.  However, it seems likely that the TAMPS baseload will take enough time that JMCIS will not want to wait for TAMPS before beginning its MIDB update process.



The control flow as presented assumes that TAMPS will do an MIDB baseload using DEX.  The TAMPS baseload can be started at any time after replication has been stopped.  If we will be copying the database by using dump/restore, then there will be an additional step, immediately after JMCIS’s “perform baseload”, of “dump database” (preferably to be performed on the TAMPS system, so the dump file does not need to be copied from JMCIS to TAMPS), and the TAMPS step “perform baseload” will be replaced by “load database dump”.
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Assumptions

Concerns / Questions /  Issues

This needs to be worked out with JMCIS as soon as possible.

Exactly what is required to be able to reliably do a dump from a database on JMCIS to a database on TAMPS?  Is it sufficient for the TAMPS database to be as large as (or larger than) the JMCIS database?  We must also look into the issue of user access to the database (the same issues that have caused numerous problems in previous version of TAMPS when restoring a database dumped on a different TAMPS system).

Can we automatically detect these events, or are we going to be dependent on the System Administrator walking up to the TAMPS machine and entering a command indicating that JMCIS is beginning its baseload?

How much of this processing will be driver by external events (and thus processed under a System Administration function), and how much should be placed within the MIDB Load CSC?

Risks

This design and implementation involves rather involved coordination with the JMCIS design and implementation, and with the MP-LAN design and implementation.

This processing may require manual intervention by the TAMPS System Administrator or Database Administrator to indicate that JMCIS is performing a baseload.  If this is not done, TAMPS may attempt to edit an MIDB record in the middle of the JMCIS baseload.

If we do not use dump/restore to copy the MIDB baseload, then TAMPS must be sure to load exactly the same baseload version (and DEX filters, if any) used by JMCIS so that the database contents are identical.  If TAMPS loads a different baseload, then replication will not be able to update records properly.

Tasks

TBD.

Alerts CSC

The Alerts CSC is used to watch for changes to MIDB data that may affect generated Radar Terrain Mask and Range Ring calculations.  When such a change is detected, it will send a warning (yellow) alert to the Mission Planner and Database Administrator alert queues.



The Alerts CSC must watch for changes to DTED data, MIDB GMI data, and NID data.



Several mechanisms have been proposed for watching for the changes.  The proposal which seems the most feasible is to create a daemon process (referred to above as the TAMPS MIDB RTM daemon).  This daemon process would wake up periodically and query the database to see if any data has changed.  This query is not expected to have a significant impact on system performance; however, performance tests will be run to verify this and to estimate proper interval between queries.



To monitor the MIDB GMI data, we cannot add a trigger to the GMI tables directly, since the MIDB database schema makes use of triggers, and a table can only have one trigger of each type (insert, update, delete).  We can add a trigger to the history tables, which are updated whenever a record is changed in the GMI database, but that could conflict with future MIDB changes (we would also need to verify what happens in the history tables on an insert or delete).  Instead, it seems best to query the data periodically and look for any records with an MIDB_TIMESTAMP since the last query.



To monitor the NID, the best proposal seems to be to add a trigger to the NID tables, which would then add a record to a table.  This second table would then be monitored by the daemon process; if one or more records were found, then an alert would be sent and the table cleared.  This would be more reliable than querying the contents of the NID, since while most NID tables have a DATE_ROW_CHNG field, it does not appear to have the precision or the reliability required for this purpose, and there are currently no triggers defined on any of the NID tables.



To monitor the DTED, the best proposal seems to be to add triggers to the DTED table, as for the NID tables above.  Other possibilities are to query the TAMPS_CATALOG relation for DTED records (and examine the DATE_LAST_CHG field), or to search the map directories for files modified since the last query time.



In each case, the daemon process will check to see whether any records have been modified, and if so then one alert per data type (MIDB GMI, NID, DTED) is sent and, in the case of the MIDB, the query time is stored for use in the next query; in the case of the NID and DTED, the temporary table is cleared.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.7�1.1�alert on RTM data change���3.2.7�1.1.1�alert on DTED update���3.2.7�1.1.2�alert on MIDB GMI update���3.2.7�1.1.3�alert on NID update���3.2.7�1.2�alert on Range Ring data change���3.2.7�1.2.1�alert on DTED update���3.2.7�1.2.2�alert on MIDB GMI update���3.2.7�1.2.3�alert on NID update���3.2.7�1.3�support MIDB alerts���3.2.7�1.3.1�use data in MIDB alert���3.2.7�1.3.2�refer user to MIDB alert app���3.2.8�1.3.3�send MIDB alert to DBA���HMI

This will use the existing TAMPS Alerts HMI.

Data Flow

TBD.

Control Flow

TBD.

Assumptions

An alert should be sent on any data change, whether that change was part of a TAMPS manual update, or a TAMPS baseload, or, in the case of the MIDB, a change replicated from JMCIS.

Concerns / Questions / Issues

Exactly what tables need to be monitored for changes?  Should any MIDB GMI update cause an alert, or only changes to certain tables?  Presumably this should be only those tables that could be used by RTM or Range Ring calculation.  These include the tables used to specify the “RTM” and “THREAT DENSITY” object actions within the Object Hierarchy, plus NID_RADAR_LAND_ANT_HEIGHT, NID_RADAR_RANGES, NID_SAM, NID_GUN_SYSTEM, DD_SAM_XREF, TAMPS_PLATFORMS, and TAMPS_NID_RANGES (plus the catalog of loaded DTED data).  The list of tables referenced in the two object actions will be determined after the existing object data has been converted from MIIDS/IDB to MIDB.

We are planning on sending out one alert per data type (one if MIDB data has changed, one if NID has changed, one if DTED has changed).  Other possibilities that were considered were one alert if any data has changed, and one alert per record that has changed (this could result in a very large number of alerts).

How often should the daemon process wake up and check to see if an alert needs to be sent?  We will need to determine how much time is required for processing each time the query to complete. 

The MIDB software has its own alert system included.  However, initial investigation has not turned up a way to connect the two alert systems in any useful way.  Therefore, we are not planning on using the MIDB alert software at present.

Risks

Under the current alert system, when an alert is sent to (for example) the Database Administrator role, then there will be a visual indication set on all workstations where the logged-on user has the Database Administrator role.  However, as soon as any user reads and acknowledges the alert, it will disappear from all the workstations.  We may need to come up with a system where the alert is sent to all connected workstations, and is only removed from that workstation when it is acknowledged by a user.  That change, though, is beyond the scope of this SOR (it may be related to the MP-LAN SOR).

When connected to a JMCIS MIDB server, edits will be replicated from JMCIS to TAMPS, and an alert generated when the data on the TAMPS server is changed.  This could lead to a large number of alerts as changes are made gradually on the JMCIS system (edits made by JMCIS users and TAMPS users).  This problem is unlikely to be noticeable in the current environment, but it may become much more noticeable if JMCIS ever begins receiving replication updates from other systems (such as a theater command). 

Tasks

Determine exactly what set of data changes should cause alerts to appear.

System Admin -> User Administration -> Accounts

In order for a TAMPS user to use the MIDB production software, the following must be true:  The user must have a Sybase login with the same name; the user’s Sybase password must be registered with the BLTS daemon; the user must be a member of the “midbuser” and “midbpadm” groups; and the user must have the appropriate production permissions set (using the utility applications associated with the MIDB Production Subsystem).



It is normal TAMPS procedure to create a Sybase account for each new TAMPS user account that is created, so this should cause no change to the existing procedures.

(Although there might be changes required in the development lab environment.)



In a TAMPS-Afloat environment, each user also needs an account on the JMCIS Sybase server, and that account must have the same password as on the TAMPS Sybase server.  We need to check for account name conflicts before actually creating the account.  Our current understanding is that we do not need to register the account with the BLTS daemon running on the JMCIS system.  We need to verify that JMCIS will allow TAMPS to create users in its Sybase database.



If the MIDB BLTS software is installed, then the user’s Sybase account and password must be registered with the BLTS daemon.  If the BLTS software is not installed, then the account will be registered by the MIDB Application CSC calling a routine (provided by the User Administration CSC) to register an account.  For this reason, the User Administration CSC code will be simplified if the BLTS software is known to have been installed at System Generation time.



Sybase password changes must be performed through the BLTS software.  There is both a command-line interface, and an API should it be desirable to change a user’s Sybase password. 



BLTS provides an API to create a Sybase account and register the account with BLTS at the same time.  If we use this route, then the BLTS software must be installed and initialized at System Startup (which we might do anyway, for reasons discussed under MIDB Installation, above).  It is unclear whether BLTS provides an API for managing which databases a Sybase user has access to.



It appears to be possible to register an account with the BLTS daemon from either a shell script or a program API.  Both the account’s Sybase password and the server’s SA password must be known.



Assigning production permissions, though, might be a problem.  The standard MIDB method for assigning these permissions is through a HMI.  There is no known method for assigning these permissions outside of this application.  It might be possible to come up with one; it is possible, though unlikely, that a future MIDB release could invalidate our method of assigning permissions.  The permissions that need to be set also depend on the outcome of the “Local Record” proposal, and the CONOPS of editing records.  Permissions will need to be set on both the TAMPS and JMCIS servers (in a TAMPS-Afloat environment); the permissions on the TAMPS server will normally allow read-only access in this environment.



It is also TBD whether we should:

provide the System Administrator with a button within the User Administration application which will display the MIDB Production Permissions application.  This is the easiest to implement, and gives the System Administrator the most flexibility in assigning permissions.  It does require the most knowledge by the System Administrator of the MIDB database and the associated software.

provide the Database Administrator with a menu item on the TAMPS WSE menu bar which will display the MIDB Production Permissions application.  This is similar to the previous item, but shifts the responsibility to the Database Administrator rather than the System Administrator.  It also requires substantial knowledge by the Database Administrator of the MIDB database and the associated software.

automatically assign MIDB permissions such that all users have MIDB permissions allowing them to create and modify MIDB records (and rely on role/privilege checking within the TAMPS WSE and DBA applications to control who will be able to access the MIDB editors).  In this case, the MIDB permissions are set when the account is created, and will not need to be changed.

automatically assign MIDB permissions so that users who are authorized to have the TAMPS “Modify MIDB” privilege have MIDB permissions allowing them to create and modify MIDB records (and rely on role/privilege checking within the TAMPS WSE and DBA applications to verify that the user has the privilege active before allowing access to the MIDB editors).  In this case, the MIDB permissions are set when the account is created and when the list of authorized roles and privileges for the account is changed.

automatically assign MIDB permissions so that users who have the TAMPS “Modify MIDB” privilege active have MIDB permissions allowing them to create and modify MIDB records.  In this case, the MIDB permissions are set when the account is created, when the list of authorized roles and privileges for the account is changed, and when the list of active roles and privileges for the account is changed.



This choice depends on whether it is feasible to automatically assign MIDB permissions (and how difficult it is to do that).  It may also depend on the final CONOPS for local record creation.



Currently, the only method supported by DIA for assigning MIDB permissions is through the MIDB Production Permissions application.  In addition, the MIDB Production Permissions application allows permissions to be set by table or, in some cases, by country code within a table.  It does require the System Administrator (or Database Administrator) to understand the basic structure of the MIDB.



It appears possible to automatically assign MIDB permissions based on TAMPS roles and privileges. This is done by writing records to the ZP_USER_PERM_TYPE and ZP_USER_PERM_RESPROD tables in the GMI database.  In this case, the three latter items on the list above may be feasible.  These would require little or no knowledge of the MIDB structure, and would allow integrating MIDB permissions with the TAMPS roles and privileges.  However, it should be again noted that writing directly to these tables is not supported by DIA. 



We feel that the best option, based on our current understanding of the MIDB production permissions, is to assign all TAMPS users permission (in the MIDB permission tables) to update the MIDB tables using the MIDB editors, and to use a new TAMPS privilege to control access to the MIDB editor applications.  The new privilege will be called “Modify MIDB”, and will be associated with the Database Administrator role.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.2�1�accts need MIDB permissions���3.2.2�2�accts need JMCIS permissions���3.2.2�3�restrict maint access to DBA���3.2.2�3.4�restrict maint ops to DBA���HMI

This will use the existing TAMPS User Administration HMI, with possibly minor additions (such as the addition of a new DBA privilege, Modify MIDB).

Data Flow



�
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Control Flow

TBD.

Assumptions

JMCIS will allow TAMPS to create user logins to its Sybase server.

TAMPS will be provided with the password of the “sa” username on the JMCIS MIDB server (or some other username with privilege to create logins).

Potential conflicts with JMCIS users can be checked for by querying the “syslogins” table of the JMCIS  master database.

We do not need to perform any BLTS registration or permission assignments on the JMCIS machine.

Concerns / Questions /  Issues

What method should be used to assign MIDB permissions to the users?  Should we just give the System Administrator access to the MIDB Production Permissions application, or should we attempt to automatically assign permissions?  (See the discussion under Design, above).

Need to coordinate with JMCIS that they have no problems with TAMPS creating users in their database (also that they need to check for username conflicts against TAMPS users).  Is there ever a need to create the same username on both JMCIS and TAMPS?

Will the BLTS software be installed at System Generation?  If not, we need to delay registering new TAMPS user accounts with BLTS if BLTS has not yet been installed.

Is there a method other than the isql procedure “sp_adduser” that we should use to specify that a user has access to a database?

Risks

If we attempt to automatically assign MIDB permissions, there is a risk that we might not properly set all the required values (or that a future MIDB release might change the storage method of the permissions), and MIDB editing would not work properly.

Both TAMPS and JMCIS must check for username conflicts, since both systems will need to create Sybase accounts on the JMCIS MIDB server.  There is a risk that one system or the other will not correctly implement the conflict checking,

If a user uses the isql procedure “sp_password” to change an SQL password, it could lock that user out due to the new password not being stored in the BLTS daemon.  If this is done for the “sa” account, then there could be more serious problems (including locking out all users). 

When a workstation is being connected to the MP-LAN, the check for conflicting user names on JMCIS may require a TAMPS user account that is being copied from the workstation to be renamed even when there is no conflicting TAMPS account.  This does not introduce new risks (these risks are covered under the MP-LAN scenario for connecting a workstation to the MP-LAN), but increases the number of cases that will be subject to these risks.  

Tasks

Determine how the MIDB permissions should be assigned (manually or automatically, as discussed under Design, above).  If assigning permissions automatically, determine how to set permissions without user interaction.  

Write a function that other Core CSCs can use to create a Sybase account and register it with the BLTS server, and (if feasible) a function that other Core CSCs can use to create a complete TAMPS account (including Unix account, Sybase account, and BLTS server registration).

System Admin -> System Shutdown

This event is discussed under the external event “System Shutdown”, above.  It is considered as an external event to emphasize that the processing (if any) will take place in the system startup/shutdown files (in the /etc/rc2.d directory), or some other system file rather than in the immediate callbacks of the “System Shutdown” menu item.  Performing the logout processing at this point allows the processing (if any) to be performed not only for a normal TAMPS shutdown, but for other cases in which a System Administrator initiates an orderly shutdown through a shell window.

System Utilities -> User Roles

The processing to be performed under this HMI item depends on the MIDB permissions implementation chosen from the options described under the User Administration CSC, above.  If the MIDB permissions are automatically set based on the user’s active roles and privileges, then we must update the MIDB permissions whenever these privileges change.  The processing required for updating these permissions will be described under the User Administration CSC, above.  Otherwise, there will be no processing required for this SOR for this HMI item.

Logoff

This event is discussed under the external event “User Logout”, above.  It is considered as an external event to emphasize that the processing (if any) will take place in the user’s .xinitrc file, or .logout file, or some other system file rather than in the immediate callbacks of the “Logout” menu item.  Performing the logout processing at this point allows the processing (if any) to be performed not only for a normal TAMPS logout, but for many cases in which the X session crashes and logs the user out.





�Database Administrator Functions

Design Overview



This section describes how the MIDB 2.0 Products affect the major DBA functions.



The following table shows the DBA functions affected by each of the MIDB 2.0 products, services and roles.  The DBA role involves the following primary functions: Load MIDB Data, Edit MIDB, Object Editor, Archive/Restore.  (Load MIDB Data refers to loading MIDB data from a distribution tape or other external source; Edit MIDB refers to displaying MIDB records for a TAMPS user to update, and storing the updated records.)



MIDB 2.0 Products,

Services and Roles�DBA Function 

affected by MIDB 2.0 ��Database Schema�Load MIDB Data, Edit MIDB, Object Editor, Archive/Restore��Application Software���      Installation���      Loader�Load MIDB Data��      Production Editors�Edit MIDB��      Query Processing�Edit MIDB��      COTS���System Services���      BLTS daemon�Load MIDB Data, Edit MIDB, Object Editor��      DEX daemon�Load MIDB Data��      RPCs���MIDB Roles���      Producer�Load MIDB Data, Edit MIDB��      Analyst�Load MIDB Data, Edit MIDB��      User���

All DBA functions associated with threat/intel processing are affected by the MIDB 2.0 database schema.  The DBA query and display functions are supported by integration into the Object Hierarchy.  However, since the dependence of these functions on database schema is captured within the Object Hierarchy, integration of the MIDB 2.0 database schema into the TAMPS object hierarchy will provide the required functionality.  Our design insures that the affect of the MIDB 2.0 database schema on DBA functions will be defined and controlled by the new object hierarchy, and the integration of each design component with the object hierarchy.



The MIDB 2.0 Application Software being integrated into TAMPS affects the DBA functions of Load MIDB Data and Edit MIDB.  The DBA functions of Load MIDB Data and Edit MIDB are dependent on the MIDB 2.0 Loader.  The MIDB 2.0 Production Editors and Query Processing affect the DBA function of Edit MIDB, since TAMPS will use the Production Editors to edit the data.  The MIDB 2.0 Production Editors require the MIDB 2.0 Query Processing - when the editor is used, it first starts the Query Processing to query for the data records the user is requesting to edit.  Our design will tailor each use of the MIDB 2.0 Production Editors to the specific type of data being edited, and where possible, to the specific record(s) of data being edited.  In our design, this is accomplished by initiating the Production Editor with the appropriate options (command line arguments) to limit the type of data (i.e. facility, unit, equipment) and/or the specific data records.   The MIDB 2.0 Production Editor can be initiated to edit a single data record, or a list of multiple records.



Below is a list of all HMI paths to MIDB edits or queries. The list is an indication of the system-wide effect of MIDB integration.  Our design integrates the MIDB 2.0 Production Editor into those portions of TAMPS core that perform edits on the MIDB.  Portions of TAMPS core that query the MIDB will be modified to use an Accessor function or will access the data through the supplied Object Hierarchy objects. The Accessor function provides a general application interface for performing standard queries on the MIDB. As part of our design, the Accessor function will access the MIDB through an ODBC interface; therefore, any application using the Accessor function will be using an ODBC layer for MIDB queries.



DBA main application

 menu item:�Edit or Query�How Affected by MIDB 2.0 ��Display -> Database Search�Query�integrate GMI (non-TGT) tables into OH ODBC;

build queries

multiple databases;

multiple servers��Threat/Intel -> Targets�Query�integrate GMI TGT tables into OH; 

build queries;

multiple databases;

multiple servers��Threat/Intel -> OOB�Query�integrate GMI (non-TGT) tables into OH; 

 multiple databases;

multiple servers��Threat/Intel -> Planner OOB�Query�uses new tables, columns��Threat/Intel -> Range Rings�Query�integrate GMI (non-TGT) tables into OH;

;

��Threat/Intel -> Radar Terrain Mask�Query�integrate GMI (non-TGT) tables into OH;

;

��Threat/Intel -> Threat Density Shading�Query�uses new tables, columns��Update -> Targets�Edit�integrate GMI TGT tables into OH;

uses MIDB Target Editor��Update -> Threats -> OOB�Edit�integrate GMI (non-TGT) tables into OH;

uses MIDB GMI Editor��Update -> Threats -> Merge Planner OOB�Edit�integrate GMI (non-TGT) tables into OH; 

 use new dit functions to copy interim threats to MIDB database��Update -> Data Dictionary�???���Output -> Reports�Query�integrate all GMI tables into OH;

uses MIDB Interface;

ODBC��Output -> Messages�Query�integrate all GMI tables into OH;

uses MIDB Interface;

ODBC��



The MIDB 2.0 System Services affecting DBA functions include the Brokered Login Trusted Service (BLTS) daemon and the Data Exchange (DEX) daemon.  Since all queries of MIDB data that use the MIDB software require the BLTS daemon, then all DBA functions requiring MIDB query capability also require the BLTS daemon. The DBA functions of Load MIDB Data, Edit MIDB, and Object Editor are affected by the MIDB BLTS daemon for this reason.  One affect of the BLTS is that each user will require a separate account and password on each MIDB server.  This affects ownership of data records, since ownership is designated by username.  In the past, “tamps” was the owner of almost everything that was not owned by “system”.  When DBAs are tagged as the owners of data records, now do we tag the owner as “username” or as “DBA”.  Defining who will own what, under what circumstances needs to be well-defined.  The DBA Load MIDB Data function will use the MIDB 2.0 DEX service.  Note that the DBA role involves loading many different datasets (about 14). In terms of loading data, the only dataset affected by this design is the MIDB dataset, and only the MIDB dataset will be loaded using the DEX software.  As part of this design, we considered using the DEX software to perform Archive/Restore MIDB functions. Since MIDB is only one of the 14 datasets that can be archived/restored, and since the DEX software only applies to MIDB dataset, we determined that the effort required to integrate the DEX software into the Archive/Restore function was not justified for this one dataset.



MIDB 2.0 offers access control through the use of Unix account groups, and through its own Production Permissions utility.   However, we do not plan to use the MIDB access control facilities, because they do not interface with the existing TAMPS roles and privileges, and the only supported interface to these controls is though an HMI (no programmatic access).  Instead, we plan to set up all TAMPS users with full MIDB permissions, and use a new TAMPS privilege, “Modify MIDB”, to control access to the MIDB production software (editors). The User Accounts CSC, described under System Administration functions, includes these details. 

Design Summary

This section describes how the  DBA functionality will be affected by MIDB 2.0 integration as viewed by the HMI paths.



The following table shows how the functionality behind the WSE menu items is affected by the MIDB 2.0 integration.  Only WSE main application menu items associated with the DBA role that are affected by this design are listed.



WSE menu items

 affected by MIDB 2.0:�How Affected by MIDB 2.0 ��DBA -> DBA Module�see detailed chart below��DBA -> Object Editor�new OH, multiple DBs, multiple servers��DBA -> Threat Scenarios�REMOVED��



The following table shows how the functionality behind the DBA application’s (ddt_mmi) menu items is affected by the MIDB 2.0 integration.  Only ddt_mmi menu items that are affected by this design are listed.



DBA menu items 

affected by MIDB 2.0:�How Affected by MIDB 2.0 ��Display -> Database Search�new OH, ODBC, multiple DBs, multiple servers��Threat/Intel -> Targets�uses MIDB Interface, ODBC��Threat/Intel -> OOB�uses MIDB Interface, ODBC��Threat/Intel -> Planner OOB�uses MIDB Interface, ODBC��Threat/Intel -> Range Rings���Threat/Intel -> Radar Terrain Mask���Utilities -> Load -> MIDB�uses MIDB Loader��Utilities -> Remote Updates -> JMCIS to TAMPS Threats�REMOVE (automatic)��Utilities -> Remote Updates -> RAAP to TAMPS Threats�REMOVE��Utilities -> Remote Updates -> JMCIS to TAMPS Weather�moved to Util->Load->Envir��Utilities -> Remote Updates -> TAMPS to RAAP Threats�REMOVE��Utilities -> Archive/Restore�IDB dataset changed to MIDB dataset, new support tables��Utilities -> Data Removal -> Dataset�IDB dataset changed to MIDB dataset, new support tables��Utilities -> Tactical Data Backup -> Backup�use GMI dataset��Utilities -> Tactical Data Backup -> Restore�use GMI dataset��Utilities -> IDB -> Rebuild TIDB Indices�REMOVE��Utilities -> IDB -> Extension Tables Initialization�REMOVE��Utilities -> IDB -> Hitlist Values Initialization�REMOVE��Update -> Targets�uses MIDB Target Editor��Update -> Threats -> OOB�uses MIDB GMI Editor��Update -> Threats -> Merge Planner OOB�use new dit functions��Update -> Threats -> Elint -> EPL�now Update->Threats->EPL��Update -> Threats -> Elint -> NERF�REMOVE���Output -> Reports�uses MIDB Interface��Output -> Messages�uses MIDB Interface��





The following tables map HMI paths associated with affected functionality to CSCs.  Only DBA application menu items that are affected by this design are listed.



WSE menu items

affected by MIDB 2.0:�CSC��DBA -> DBA Module�see detailed table below��DBA -> Object Editor�Object Editor, Data Query��DBA -> Threat Scenarios���



DBA menu items

affected by MIDB 2.0:�CSC��Display -> Database Search�Data Query, Query Tool��Threat/Intel -> Targets�Targets��Threat/Intel -> OOB�Interim Threat��Threat/Intel -> Planner OOB�Interim Threat��Threat/Intel -> Range Rings���Threat/Intel -> Radar Terrain Mask���Utilities -> Load -> MIDB�MIDB Load��Utilities -> Remote Updates -> JMCIS to TAMPS Weather�MP LAN SOR��Utilities -> Archive/Restore�Archive/Restore��Utilities -> Data Removal -> Dataset���Utilities -> Tactical Data Backup -> Backup���Utilities -> Tactical Data Backup -> Restore���Update -> Targets�Targets��Update -> Threats -> OOB�MIDB GMI Data��Update -> Threats -> Merge Planner OOB�Interim Threat��Output -> Reports���Output -> Messages���

Any query is executed using the MIDB database on the TAMPS Server.  Changes to records, either updates or deletion, are executed using the MIDB database on the JMCIS Server.  The TAMPS Server MIDB database receives the same updates by the replication server.  The synchronization of the two MIDB databases, TAMPS and JMCIS, is handled by MP-LAN.

Database Schema Changes



Table Name�Action�Description��DD_DATABASES�new�contains the available databases��DD_SCENARIOS�new�contains information about the DBA defined scenarios��DD_MIDB_GMI_SUBSET�new�contains definition of subset of GMI data to download from server to client��DD_DATASET�modify�add columns database_name and archivable; also, may now contain more than one FILE_PREFIX value for a dataset.��RTM_COVERED_RADARS�modify�change EQUIP_CODE to from char(5) to varchar(7).��IDB tables�delete�no longer used��MIDB tables�new�per DIA-defined MIDB schema��

Design

DBA -> Display -> Database Search

The database search functionality within TAMPS will not undergo significant major changes under this SOR.  There are no HMI changes to the Database Search menu items or to the Query Tool Dialog.  Query Processing will be simplified by eliminating stored procedures, thus providing one centralized method of query processing.  Currently, ad hoc queries are performed by constructing a new stored procedure, then the newly created stored procedure is executed.  Our design eliminates this method, and performs all queries “on-the-fly”.  The code modifications are straight forward, and it is estimated that the operational speed of the target hardware will more than compensate for any small loss in query execution time due to lack of a compiled and optimized stored procedure.  The centralized connection point from the Query Processing to the database server will provide ODBC functionality.



During the design process, we considered integrating the DIA Query Tool into TAMPS to satisfy the query requirement.  The justification for integrating the DIA-provided Query Tool is that it is always used by the DIA Production System Editors to query the required data prior to editing; therefore, we are partially migrating to the DIA-provided Query Tool by integrating the DIA Production System Editors.  Since the DIA Query Tool provides capabilities that are equivalent to TAMPS Query Tool capabilities, migration to the GOTS Query Tool is the obvious, preferred path for TAMPS 2000.  However, a complete migration to the DIA Query Tool requires migration to the DIA-provided map tools, layer tools, and report tools because these tools are intimately linked with the TAMPS Query Tool.  The trade reduces to the medium-high cost and risk of full migration of TAMPS query, object hierarchy, maps, layers, reports to DIA-provided products versus the desirability to maximize the usage of GOTS products while achieving TAMPS goals.



The DIA Query Tool will still be required when using the DIA Production System Editors, and it will be available to users with appropriate TAMPS privileges.  While this may result in some confusion for users who must use both tools, this is unavoidable.  The confusion is expected to be minimized by limiting access to the DIA Query Tool to users who are authorized to edit MIDB records (and are therefore expected to be at least somewhat familiar with the MIDB structure).  The DIA Query Tool can also be a troubleshooting tool for the Database Administrator.



The elimination of stored procedures in this CSC does not imply that the use of stored procedures is entirely eliminated from TAMPS.

Requirements

The following requirements are currently met by the TAMPS Database Search capability.



Requirements Section�Requirements 

Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.5.1�7�save as�dmt_query_save_callback()��3.2.5.1�8�select and execute pre-defined�dmt_query_browse_callback()��3.2.5.1�8.1�DBA add queries�dmt_query_new_callback()��3.2.5.1�8.2�DBA remove queries�dmt_query_delete_callback()��3.2.5.1�8.3�select by object�dmt_query_browse_callback()��3.2.5.1�9�retrieve���3.2.5.1�9.1�execute�dmt_query_execute_callback()

dmt_qfq_execute_callback()��3.2.5.1�9.2�add to user list�dmt_qfq_add_callback()��3.2.5.1�9.3�select from user list���3.2.5.1�9.4�remove from user list�dmt_qfq_delete_callback()��3.2.5.1�10�edit�dmt_query_edit_callback()��3.2.5.1�11�delete�dmt_query_delete_callback()��3.2.5.1�11.1�delete�dmt_query_delete_callback()��3.2.5.1�11.1.1�planner query deletion�dmt_query_delete_callback()��3.2.5.1�11.1.2�DBA query deletion�dmt_query_delete_callback()��3.2.5.1�11.2�inhibit query deletion�dmt_query_delete_callback()��3.2.5.1�12�sub-query�dmt_query_sub_convert_callback()

dmt_query_sub_delete_callback()��

HMI

The following illustration shows a representation of the requirements listed above related to the specific HMI component shown.  The requirements sub-section number from the chart above is shown in a box next to the HMI component that satisfies the requirement.  Also shown is the significant functional component that satisfies each requirement.  The illustration is a graphical representation of the information presented in the chart above.
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Data Flow

The Data Query CSC data flow shows that it receives requests from a DBA to edit objects (forwarded to the Object Editor CSC) and it receives requests from a DBA or planner to perform queries (forwarded to the Query Processing CSC).  The database schema from the MIDB database and other TAMPS tactical databases are used by the DBA to create Object Definitions.  Both DBA and MPM send requests for Query Processing and receive results and status.  The Data Query CSC uses the MIDB database that is on the TAMPS server in a stand-alone environment or when connected to JMCIS.
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Control Flow

The Data Query  control flow shows that the DBA is given the capability to use the object editor and the query processing capabilities.  Planners only have the capability to use the query processing capability.
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Assumptions

None

Concerns / Questions / Issues

None

Risks

We determined that full migration to the DIA-provided Query Tool under this SOR would involve the following risks:



The complexity of a full migration to the DIA-provided Query Tool leads to increased cost and technical risk, because the TAMPS software functionality related to maps, layers, object hierarchy, reports would all have to be migrated along with the Query Tool.  Note that this complete migration could be done in steps where one functional component is migrated in each step, keeping the total migration plan in mind during the entire process.  This process would be costly and time-consuming.

The complexity of connecting TAMPS map to the DIA Query Tool

our geo layer information would have to be input to the DIA Query Tool

the query results would need to be sent to TAMPS map, layers, buckets, symbols, amp info, etc.

Complete integration would require that all TAMPS canned queries be translated and stored in the MIDB Query Tool stored procedures.  

Partial integration beyond the minimal amount required by the DIA Editor leads to the promotion of two (2) query tools

Tasks

modify to use ODBC - since access is localized to a few functions

not using stored procedures - so modify code, modify load scripts

WSE -> DBA -> Object Editor

Requirements

The following requirements are currently met by the TAMPS Object Editor.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:�������3.2.5.2�1�create�oet_createObjectCallback ()��3.2.5.2�2�filter condition�oet_det*.c��3.2.5.2�2.1�single column�oet_det*.c��3.2.5.2�2.2�one or more Object Determinators�oet_det*.c��3.2.5.2�2.2.1�use data record of object type�oet_det*.c��3.2.5.2�3�wildcards�oet_det*.c��3.2.5.2�4�store�OH��3.2.5.2�5�retrieve�OH��3.2.5.2�6�delete�oet_deleteObject ()��3.2.5.2�7�modify�oet_editObject ()��3.2.5.2�8�different symbols�oet_invokeSymbolMapping ()��3.2.5.2�8.1�one active symbol�oet_invokeSymbolMapping ()��3.2.5.2�8.2�default to TAMPS symbol set�oet_invokeSymbolMapping ()��3.2.5.2�9�review�obt_getBrowserForm ()��3.2.5.2�9.1�inhibit updates during review�obt_getBrowserForm ()��3.2.5.2�10�any GMI tables�obt_getBrowserForm ()��3.2.5.2�11�any Target tables�obt_getBrowserForm ()��3.2.5.2�12�multiple tables�oet_tab*.c

oet_col*.c��3.2.5.2�13�multiple databases�oet_tab*.c (with mods)

oet_col*.c (with mods)��

HMI

The following illustration shows a representation of the requirements listed above related to the specific HMI component shown.  The requirements sub-section number from the chart above is shown in a box next to the HMI component that satisfies the requirement.  Also shown is the significant functional component that satisfies each requirement.  The illustration is a graphical representation of the information presented in the chart above.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �4� Object Editor HMI





Edit Dialog
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �5� Edit Dialog HMI



Data Flow

The Object Editor data flow shows that only a DBA can create, modify or delete objects.  The Object Editor is integrated with the database schema of the MIDB database and with other TAMPS databases allowing the DBA to create or modify object definitions stored in the object hierarchy database.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �6� Object Editor Data Flow

Control Flow

The Object Editor control flow shows that once an object is selected, then the DBA can delete or edit the object.  The delete and edit conditions represent the action to be performed after the corresponding button has been pressed.  If the object exists, then the database schema, existing object definition, and the parent object definition are retrieved.  If the object is new, then an initial object definition is created.  Once the initial object definition is displayed in the Object Editor, the DBA can edit object components.  If the DBA chooses to save the modified object definition, then the object is saved to the Object Hierarchy, and the new object definition is retrieved and displayed in the Object Editor.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �7� Object Editor Control Flow (1 of 2)
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �8� Object Editor Control Flow (2 of 2)

Assumptions

None

Concerns / Questions / Issues

None

Risks

None

Tasks



Object Editor - top level tasks

modify to handle multiple databases

modify to handle multiple servers

integrate MIDB, GMI, TGT data into Object Hierarchy

modify to use ODBC



Object Editor - Edit object detailed tasks

map old IDB tables, columns, object determinators to new MIDB 2.0 tables, columns, determinators.  If we can not map (i.e. if there is no new column that is an appropriate match for the old column), then modify object definition by dropping columns from the object definition.  We believe that ALL columns that are currently required have an equivalent column in MIDB 2.0.

modify object action columns, tables, attributes

modify values for object determinators - some have changed.

add to list of lat/lon tables (where is this derived from?)

DBA -> Database Search  -> New, Edit  (Query Tool)



There will be no visible changes to the user in the TAMPS Query Tool, except that the IDB-based columns in the lists of available columns will be replaced with MIDB-based columns.



There will be some changes made within the query processing, though, to accommodate the fact that not all of the TAMPS data will be stored within the same Sybase database, as had been the case in the past.



When creating the SQL for any query, it will be necessary to be sure that the correct database is being referenced.  In the case of the object-based queries, the database being referenced will vary, depending on the object being queried, and there will be cases where a join will need to be done between tables located in different databases.  As long as the databases are located on the same Sybase server, this can be accomplished by including the database name in all references to the table name (i.e., instead of “TABLE”, we would use “DATABASE..TABLE”).



If the databases to be joined are located on different Sybase servers, though, then the join is much more difficult.  In that case, we would need to run one query on the appropriate Sybase server, and then running a query on the other Sybase server, and matching up the results.  Depending on the data being processed, it might be better to run the second query once for each record returned from the first query -- although there is overhead involved in running the query multiple times, much less data would be returned and matching the records would be far easier.



Fortunately, our current understanding of the MP-LAN and Trusted TAMPS designs is that only a limited amount of data will not be stored on the same Sybase server as the MIDB data, and that this data will not be referenced by the Object Hierarchy objects.  Therefore, we do not plan to support multi-server queries at this time.



Another consequence of the fact that the data will be spread across multiple databases is that the object-based queries will no longer use stored procedures.  The current TAMPS procedure is to create a stored procedure when an object-based query is saved, and then to reference that stored procedure when running the query.  For a temporary query, a stored procedure is created, immediately executed, and not used again (it is deleted when the user runs a new temporary query).



Instead, we will generate SQL text from the data stored in the DD_QUERY, DD_CONDITIONS, and DD_USER_FIELDS tables, and execute that directly.  No stored procedures will be used for object-based queries.  This is expected to have a small negative impact on the execution speed of pre-defined queries, but the impact is not expected to be noticeable to the user.  The impact on user-defined queries is harder to predict, but is expected to be even smaller than that for pre-defined queries (and may be positive for temporary queries).  This will also increase maintainability, since all the information for the pre-defined queries will now be stored in the DD_QUERY and related database tables (previously it was also stored in the dbt_procedures.sql file).



It should be noted that the removal of stored procedures only applies to queries based on objects in the TAMPS Object Hierarchy.  Other application queries will not be affected.



One additional change, required by the design of the MIDB, is that the object-based queries will now use “outer joins” whenever possible.  Tables containing data which is required for TAMPS to process the object will be considered “required tables”  (This data includes the object determinator for the object, and the latitude and longitude columns for spatial objects.)  All other tables will be considered “optional tables”, and will be referenced in the SQL query text using an “outer join”.  If no data record is found in an optional table, then the object instance will still be retrieved, processed, and displayed -- however, the data columns that referenced that table will contain NULL.



An example of how this would benefit the TAMPS user would be a radar facility.  Most of the columns for that radar might be stored in the MIDB table “FAC”.  However, we could get parametric data from a NID table.  Suppose the user performs a query against this object, and for some reason there is no record in the NID for one of the facilities.  Under the current TAMPS implementation, the facility without the NID data would not be retrieved by the database query, and would not appear on the user’s screen.  Using the “outer join”, the facility would still be retrieved, and would appear on the user’s screen (although some data columns would not be filled in).

Requirements 



The following requirements are currently met by the TAMPS Query Tool.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�4.4�pre-defined queries���3.2.3�4.5�spatial objects���3.2.3�4.6�textual objects���3.2.3�4.7�retrieve “best” data���3.2.3�4.8�retrieve historical data���3.2.3.5�3.1�TAMPS server processes queries���3.2.5�1.1�location of spatial object���3.2.5�1.1.1�use ilat/ilon���3.2.5�1.1.2�use WGS-84 lat/lon���3.2.5�1.1.3�use lat_radian/lon_radian���3.2.5�1.2�use active geo filter���3.2.5�1.3�spatial object display symbol���3.2.5�1.3.1�display symbol into���3.2.5�1.4�textual display���3.2.5�1.5�query results in text and symbol���3.2.5�1.6�text object���3.2.5.3�1�filter condition�dmt_qnecond.c��3.2.5.3�1.1�comparisons: equal to, etc.�dmt_qnebtw*.c

dmt_qnein*.c��3.2.5.3�1.2�and, or , etc.�dmt_qneopcb.c��3.2.5.3�1.3�value�dmt_qnev*.c��3.2.5.3�1.4�user inputs value�dmt_qnev*.c��3.2.5.3�1.5�default value�dmt_qnev*.c��3.2.5.3�1.6�wildcard�dmt_qnev*.c��3.2.5.3�3�additional elements�dmt_qneres.c��3.2.5.3�4�more than 1 table or database���3.2.5.3�4.1�database joins���3.2.5.3�5�exec and display w/o saving�dmt_qne_execute_callback()��3.2.5.3�5.1�edit�dmt_qne_edit_callback()��3.2.5.3�5.2�save�dmt_qne_save_callback()��3.2.5.3�6�save as�dmt_qne_save_callback()��3.2.5.3�6.1�prevent replacing existing query�dmt_qne_save_callback()��3.2.5.3�6.2�prevent replacing pre-defined queries�dmt_qne_save_callback()��3.2.5.3�6.3�save as new query�dmt_qne_save_callback()��

HMI

The following illustration shows a representation of the requirements listed above related to the specific HMI component shown.  The requirements sub-section number from the chart above is shown in a box next to the HMI component that satisfies the requirement.  Also shown is the significant functional component that satisfies each requirement.  The illustration is a graphical representation of the information presented in the chart above.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �9� Query Tool HMI



Data Flow
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �10� Query Tool Data Flow



Control Flow
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �11� Query Tool Control Flow



Assumptions

The queries executed on the client workstations will use the MIDB database on the TAMPS Server.

The current processing for symbol sets will be used.

Concerns / Questions / Issues

Will need to add the database name to the query in order to resolve multiple database query.  This only handles the cases when the databases are on the same server.  Will there be a need to handle queries across multiple servers?

Risks

None

Tasks

no more stored procedures, modify query execution - currently generates a stored procedure for temp queries, then execs the stored procedure

update existing object queries to use MIDB schema objects

no need to load stored procedures

must review existing stored procedures and remove object-based procs.

change DD_DATASETS, must add columns for database_name and dbserver_name

Threat/Intel -> Merge Planner OOB

The Planner Merge OOB dialog is initiated from the DBA->Update->Threat/Intel menu item.  This dialog provides the capability for the DBA to apply the planner threat data to the MIDB database.  The TAMPS_INTERIM_THREAT database table contains the planner threat data to be added to the MIDB database.  Once the data has been added to the MIDB database, the interim threat data is deleted from the TAMPS_INTERIM_THREAT database table.



The current functionality for the DBA add, delete, edit and display interim threats will not be affected by this change.

Requirements

The following requirements are currently met by the Interim Threat capability (not just the Merge Planner OOB capability).



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3.2�1�create�dil_AddInterimThreat.c��3.2.3.2�2�storage�TAMPS_INTERIM_THREAT��3.2.3.2�3�display�dil_DisplayInterimThreats.c��3.2.3.2�3.1�graphic display�dil_DisplayInterimThreats.c��3.2.3.2�3.2�textual display�dil_DisplayInterimThreats.c��3.2.3.2�4�modify�dil_EditThreats.c��3.2.3.2�5�delete�dil_DeleteThreats.c��3.2.3.2�6�ownership�dil_EditThreats.c��3.2.3.2�7�range rings�edt_mera_cb()��3.2.3.2�8�radar terrain mask�ert_int_rtm_init()��3.2.3.2�9�DBA delete interim threat�dil_DeleteThreat.c��3.2.3.2�10�DBA update MIDB�modify dil_DbaAddInterimThreatToIdb.c��3.2.3.2�11�auto delete after update MIDB�dil_DbaAddInterimThreatToIdb.c��

HMI

The following illustration shows a representation of the requirements listed above related to the specific HMI component shown, which will not be changing.  The requirements sub-section number from the chart above is shown in a box next to the HMI component that satisfies the requirement.  Also shown is the significant functional component that satisfies each requirement.  The illustration is a graphical representation of the information presented in the chart above.
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��Data Flow

The data flow diagram shows the additional processing that occurs to save the interim threat data in the MIDB database.  Steps 1 and 3 are currently implemented in the dil_DbaAddInterimThreatToIdb.c source file. Step 2 is the change to be implemented.
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Control Flow

The control flow remains the same except for writing the interim threats to the MIDB database instead of the TAMPS database.

Assumptions

Current interim threat capability meets all requirements

Continue to delete interim threats from TAMPS db when threats are added to MIDB database.

Concerns/Questions/Issues

None

Risks

None

Tasks

Modify dil_DbaAddInterimThreatToIdb.c to add threats to MIDB database.

Target Query

The Targets Query dialog is initiated from the DBA->Threat/Intel->Targets menu item.  This capability is identical to how targets queries are performed by the mission planner.  This capability is discussed in the Mission Planner section of this document.

Threat OOB Query

The Threat OOB Query dialog is initiated from an DBA->Threat/Intel->OOB menu item.  This capability is identical to how threat order of battle queries are performed by the mission planner.  This capability is discussed in the Mission Planner section of this document.

Range Rings

The Range Rings dialog is initiated from DBA->Threat/Intel->Range Rings menu item. This capability is discussed in the Mission Planner Functions section of this document.

Radar Terrain Mask

The Radar Terrain Mask dialog is initiated from DBA->Threat/Intel->Radar Terrain Mask menu item. This capability is discussed in the Mission Planner Functions section of this document.

Target Editor

The Target dialog is initiated from DBA->Update->Targets menu item. The current dialog for updating targets will be replaced with the DIA Production Software.



Currently, when the DBA uses the TAMPS target editor the map display is not updated when the target editor has been exited.  The DBA must initiate a re-query sequence in order to display the target changes that were made while using the editor.  This sequence being (1) using the clutter/declutter feature to delete the current target data from the map display and (2) querying for the target data a second time.



When implementing the MIDB target editor, the desire is to perform the re-query of the target data and re-display the updated target data on the map after using the MIDB editor for the DBA.  The original query that has populated the map display will be saved in the target object in the bucket. The saved query will be executed after the MIDB editor has been exited to retrieve target data that was on the map display.  Any target that was changed while using the MIDB editor will now be redisplayed (with all corresponding edits).



In a JMCIS environment, the DBA will be editing the target records from the MIDB database which is on the JMCIS Server. The updated target data will be replicated back to the TAMPS Server MIDB database.

Requirements

The following requirements are met by the Target Editor (which is the editor supplied by the DIA Production Software.)



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.4�3.1�maintain target���3.2.4�3.3�create targets�DIA Editor��3.2.4�3.3.1�create target�DIA Editor��3.2.4�3.3.4�create target from map point�DIA Editor��3.2.4�3.3.5�create target�DIA Editor��3.2.4�3.4�modify target�DIA Editor��3.2.4�3.4.1�modify target�DIA Editor��3.2.4�3.5�delete target�DIA Editor��3.2.4�3.5.1�delete target�DIA Editor��3.2.4�3.6�JMCIS database�MP LAN��HMI

The Target  dialog is initiated from DBA->Update->Targets menu item. The current dialog for updating targets will be replaced.  The target editor supplied as part of the DIA Production Software will be used by the DBA to add, delete, and modify targets in the MIDB database.  Our design includes a context-sensitive popup menu (right mouse button press in map area) that will allow planner or DBA to modify a target or delete a target directly from the popup menu.  This option is equivalent to DBA->Update->Targets menu item selection.  A picture of the context-sensitive popup menu is shown below.



�

Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC \r 1 �1� Target Context-Sensitive Pop-up Menu HMI

The Delete menu item would launch the corresponding DIA Target Editor for the selected target  object to be deleted for each context-sensitive pop-up menu.

The Modify menu item would launch the corresponding DIA Target Editor for the selected target object to be modified for each context-sensitive pop-up menu.

The Define Target menu item would launch the DIA Target Editor based on the selected target object for each context-sensitive pop-up menu.



Data Flow

The Target Editor data flow shows that the target data in the MIDB database is accessed by using the DIA Production Editor.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �2� Target Editor Data Flow



Control Flow

The Target Editor control flow shows that the displayed targets are saved before the MIDB target editor is called and that the map display is updated after the MIDB target editor has completed.  This control flow starts from the point where the DBA has already selected a target to edit.  When an object has been hooked from the map display, the bucket contains information about the objects and it will include the query which was used.  After the Target editor has completed, the query for the active bucket will be re-executed and the data re-displayed on the map.  If the Target Editor was initiated with-out hooking an object, there is no query to re-execute.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �3� Target Editor Control Flow (1 of 2)
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �4� Target Editor Control Flow (2 of 2)



Assumptions

We plan to move this functionality from aircraft mission planning corelib to the database corelib.  NOTE: Target functions related to aircraft and munitions mission planning will remain in mission tools corelib (see Planner Role section of this document).

If the bucket object does not exist for the target, create it.

Concerns/Questions/Issues

One affect of the BLTS is that each user will require a separate account and password on each MIDB server.  This affects ownership of data records, since ownership is designated by username.  In the past, “tamps” was the owner of almost everything that was not owned by “system”.  When DBAs are tagged as the owners of data records, now do we tag the owner as “username” or as “DBA”.  Defining who will own what, under what circumstances needs to be well-defined.

What is the exact command line to launch each specific instance of an MIDB editor?

What do we type to edit 1 record from the command line?

How do we just query MIDB, what is the command line?

Can we execute the MIDB software without the GUI, i.e. get text only results from a query?

Need to talk about stored (pre-generated) RTMs?

How will this affect above description about requerying the database ?

Risks

Using the DIA Target Editor

Tasks

 integrate MIDB Target Editor

design wrapper code to call the MIDB editor

develop the HMI for this

list all adt_t*.c functions and files that might be useable

OOB Editor

The OOB Editor is initiated from DBA->Update->Threats->OOB menu item. The current dialog for updating threats will be replaced.  The threat editor supplied by the DIA Production Software will be used by the DBA to add, delete, and modify threats in the MIDB database.



When a scenario has been activated, the threat records edited are uniquely tagged in the record_status field for that scenario.



In a JMCIS environment, the DBA will be editing the threat records from the MIDB database which is on the JMCIS Server.  The updated threat data will be replicated back to the TAMPS Server MIDB database.



In a workstation environment, the DBA will be editing the threat record from the MIDB database which is on the TAMPS Server.  No replication will be taking place.

Requirements

The following requirements are met by the OOB Editor (which is the editor supplied by the DIA Production Software.)



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�1.2.7�add scenario data�DIA Editor��3.2.3�1.2.8�remove scenario data�DIA Editor��3.2.3�1.3�maintain threat data�DIA Editor��3.2.3�1.3.1�equipment data�DIA Editor��3.2.3�1.3.2�equipment index data�DIA Editor��3.2.3�1.3.3�unit�DIA Editor��3.2.3�1.3.4�facility�DIA Editor��3.2.3�5.3�JMCIS environment���3.2.3�5.4�create�DIA Editor��3.2.3�5.5�modify�DIA Editor��3.2.3�5.6�delete�DIA Editor��HMI

The threat editor supplied by the DIA Production Software will be used by the DBA to add, delete, and modify threats in the MIDB database.

OOB HMI Overview

Our design includes a context-sensitive popup menu displayed when the user’s right mouse button is pressed over the map.  Similar to other popup menus in TAMPS, it will provide quick access to identical functionality available from the main application menu tree.  The type of object selected (which is saved in the bucket information) determines the menu items displayed in the popup menu, as follows:



If a Facility object is selected, then popup menu contains Define Target, Modify Facility, Delete Facility menu items.

If a Unit object is selected, then popup menu contains Define Target, Modify Unit, Delete Unit menu items.

If any other type of object is selected, then no popup menu will appear.



Proposed context-sensitive popup menu HMIs are shown below.



�

Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �5� OOB Facility Context-Sensitive Pop-up Menu HMI
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �6� OOB Unit Context-Sensitive Pop-up Menu HMI









The Delete menu item would launch the corresponding DIA Editor for the selected object to be deleted for each context-sensitive pop-up menu.

The Modify menu item would launch the corresponding DIA Editor for the selected object to be modified for each context-sensitive pop-up menu.

The Define Target menu item would launch the DIA Target Editor based on the selected object for each context-sensitive pop-up menu.  



The DIA Production System Editor uses data from the MIDB SUPPORT database to determine where to find data for a particular type of “thing” in the MIDB GMI database.  For a TAMPS user to be able to select a TAMPS object off a map and edit data associated with that object using the DIA Production System Editor, then the SUPPORT tables (which the Editor uses) must be in line with TAMPS’ Object Hierarchy for that particular type of “thing”.



As part of our preliminary design, we investigated the need for the creation, modification, and deletion of views in order to support TAMPS requirements.  The design options can be summarized as follows:



1)  Do nothing

	Accept the DIA-provided views

	TAMPS users must learn to use DIA products as is



2) Create additional TAMPS views

	TAMPS views added to DIA-provided views

	TAMPS users get instant access to data they have needed in the past

	More convenient for TAMPS users

	No changes to DIA-provided views



3) Modify DIA-provided views

	A lot of work

	Defeats the purpose of COTS/GOTS

	TAMPS users gain customization, but would be using DIA products in a way that 			is not compatible with external C4I systems



4) Drop all DIA-provided views and create new TAMPS custom views.

	A lot of work

	Defeats the purpose of COTS/GOTS

	TAMPS users gain customization, but would be using DIA products in a way that 			is not compatible with external C4I systems



Our preliminary design choice is option 1 - Do Nothing.  We plan to use the DIA-provided views.  We will not modify nor add to the provided views.  



As part of this preliminary design activity, we generated a preliminary design for option 2.  This design addressed the creation and maintenance of new TAMPS views to be provided as an extension of the DIA views.  This preliminary design for option 1 was generated early in the design process in anticipation of the need to provide TAMPS users with editor screens that display the data in the manner TAMPS users are accustomed to seeing.  The preliminary design for option 2 is presented here to document work performed under this SOR.  We are NOT currently planning to implement design option 2.



TAMPS requires views be created for each family of objects that can be edited from specific TAMPS menu items.  This is because the DIA provided views do not correlate well with the TAMPS definition of Threat->OOBs or Threat->Targets.  For example, editing an AOB in the DIA editor requires the user select “Unit” View, click “Zip Query” tab, click “AOB Query” tab.  In other words, DIA has created a view into the MIDB database that defines an AOB as part of the “Unit” View.  But TAMPS users consider AOBs as part of a “Facility” view.  As part of our detailed design, we are determining the relationship between the TAMPS object hierarchy and the DIA Views.  The details of this relationship will determine the level of design complexity.  One trade-off to consider during the detailed design process will be the work required to create and maintain TAMPS custom views (formally called Production Subsystem Extensions ) versus the effort required to retrain TAMPS users to become accustomed to the new editors.  Since TAMPS users will require training on the new DIA products, then they may become accustomed to the DIA provided views.  During the detailed design process for this SOR, results of design studies and results of trade studies will be presented to the TAMPS FUIWG to make users aware of design issues, choices, limitations, impacts on mission planning.  



Our preliminary design is to create views for each family of objects that can be edited from specific TAMPS menu items.  Subviews will be created for each child object within a family of objects.  For our design, we will create views for the following items:



Update -> Threat -> OOB -> Air

Update -> Threat -> OOB -> SAM

Update -> Threat -> OOB -> Electronic

Update -> Threat -> OOB -> AAA

Update -> Threat -> OOB -> Naval

Update -> Threat -> OOB -> Ground

Update -> Targets



The possibility of creating one (1) TAMPS view containing all required subviews is being considered in this design.  The editor would be initialized to the TAMPS view, and all subviews ( i.e. AOB, EOB, GOB, NOB, AAA, SAM, TGT ) will be available to the user by clicking on a tab.  The DIA Editor dialog first presented to the user would be initialized to the appropriate subview, as determined by menu options the user selected prior to launching the editor.  If the user wishes to change to any of the DIA provided views, then those views would be available on the View pulldown menu in the DIA editor.  As part of this design, we may limit the user to the one (1) particular subview he/she preselected.  Again, these issues, along with design choices and limitations, will be presented to fleet users for input and approval.  



Currently, the preliminary design for integrating the DIA Production System Editor does NOT involve:

1) modifying any GOTS source code

2) modifying any DIA-provided SUPPORT table data (Views)

3) modifying any DIA-provided HMI



Our design involves creation of new views, and the creation of new views is supported by the DIA Production System.  Detailed design activities include defining new HMI dialogs, defining new SUPPORT table data, defining GMI stored procedures used to query a given view window, defining the reuse of existing view functions.  Any new HMI dialogs added to the DIA Production editor must follow DIA’s existing HMI design (look and feel).



Examples of DIA Production Editor screens are shown below for “Create New Unit”, “Equipment Maintenance”, “Create New Installation/Facility”.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �11� TAMPS-DIA Production Data Flow
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �12� DIA Query HMI



Data Flow

The Threat OOB Editor data flow shows the threat data in the MIDB database is accessed by using the DIA Production Editor.

�
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Control Flow

The Threat OOB Editor control flow shows that the threat query used to create the map display is saved in the threat definition before the MIDB threat editor is called.  After the MIDB threat editor has completed, any saved query will be re-executed to update the map display.  When an object has been hooked from the map display, the bucket contains information about the objects and it will include the query which was used.  After the Threat editor has completed, the query for the active bucket will be re-executed and the data re-displayed on the map.  If the Threat Editor was initiated with-out hooking an object, there is no query to re-execute.
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Figure � STYLEREF 4 \n �4.1.2.3�-� SEQ Figure \* ARABIC �14� Threat OOB Editor Control Flow (1 of 2)



�
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Assumptions

Each DIA Threat Editor will be callable from code

The API is callable by specifying various views of the data

use the “-view” argument to launch to the editor

Concerns/Questions/Issues

Since the DIA Facility editor allows the DBA to switch between Air, SAM, AAA records, do we need to provide the OOB sub-menu (Air, SAM, AAA ...) ?

Why try to limit the DIA facility editor to only to one type of facility record?

How does the editor know to assign a unique tag in the record_status field for a scenario?



Other Design Considerations



DIA Production Subsystem Extensions



The following is the design analysis to shows what would need to be implemented to modify the MIDB views.



The TAMPS specific Production Subsystem Extensions will require updating if specific portions of the Object Hierarchy are modified.  Therefore, we are designing a Production Subsystem Extensions Updater, to be integrated into TAMPS core along with the Production Subsystem Extensions we will provide.



Modified components of the Object Hierarchy must be processed for TAMPS specific Production Subsystem Extensions which are editable from the map selections.  If a DBA modifies the object definition of an object in the object hierarchy, then the modified components of the Object Hierarchy will be processed to determine the required updates to specific TAMPS Views in the MIDB SUPPORT tables.  The Production Subsystem Extensions High-Level Data Flow Diagram below shows the relationship between the TAMPS Object Editor, the new TAMPS Production Subsystem Extensions Updater we are providing as part of this SOR, and the MIDB databases.  The diagram also shows that the DIA Production Editor uses data from the MIDB databases to determine where to find GMI data, and how to present the GMI data to the TAMPS user when instantiated from the new MIDB Editor API.
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Risks

Using the DIA Threat Editor

Using the API interface to initiate the editor

Tasks

Integrate MIDB Editor

Design wrapper code to call the MIDB editor

Develop the HMI for this

Utilities -> Remote Updates

The Utilities -> Remote Updates menu item and all sub-menu items will be removed because the functionality is no longer supported, or because the functionality is handled automatically by JMCIS. JMCIS to TAMPS Weather will be processed under the Utilities -> Load -> Environment menu item. JMCIS to TAMPS Weather processing is the responsibility of the MP-LAN SOR.



The actual task of updating the menu item is under the MP LAN SOR, SOR 95-47.



Menu Item�Reason for removal��Utilities -> Remote Updates -> JMCIS to TAMPS Threats�Not supported (automatic)��Utilities -> Remote Updates -> RAAP to TAMPS Threats�Not supported��Utilities -> Remote Updates -> JMCIS to TAMPS Weather�moved to Util->Load->Envir��Utilities -> Remote Updates -> TAMPS to RAAP Threats�Not supported��Utilities -> IDB

The Utilities -> IDB menu item and all sub-menu items will be removed because the functionality is not required due to MIDB 2.0 capabilities.

Requirements

All requirements relating to the Utilities -> Remote Updates are the responsibility of MP LAN SOR, SOR 95-47.

HMI

The picture below shows how the Database Administration Utilities Menu has been modified to delete the Remote Updates and IDB menu item selections and all their submenus.
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Data Flow

No new data flow is needed.

Control Flow

No new control flow is needed.

Assumptions

MP LAN SOR is responsible for JMCIS to TAMPS weather updates.

MP LAN SOR will process JMCIS to TAMPS weather updates under Utilities -> Load -> Environment.

Concerns / Questions / Issues

None

Risks

None

Tasks

Implement new utilities menu

Utilities -> Archive/Restore

The Archive/Restore functionality within TAMPS will not undergo significant major changes under this SOR.  There are no HMI changes to the Archive/Restore Dialog.  Archive/Restore relies upon the DD_DATASET table to determine which database tables to process.  We will add database name and archivable columns to the DD_DATASET table to meet requirements relating to multiple databases and servers.  The GMI data will be considered to be one dataset and archive/restore will be performed on the entire GMI dataset.  The GMI data can be archived, but only as an entire entity and therefore only in dump format.  In a JMCIS environment, the capability to archive/restore the TAMPS database will be prohibited and the menu items will be de-sensitized.  The archivable setting for MIDB would be set to off in the JMCIS environment.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.6.1�1�archive to BCP���3.2.6.1�2�restore from file���3.2.6.1�3�archive MIDB data���3.2.6.1�4�restore MIDB data���

HMI

There are no HMI changes for the Archive/Restore Dialog.

Data Flow

No data flow is needed.

Control Flow

 No control flow is needed.

Assumptions

Current functionality satisfies all requirements.

Concerns / Questions / Issues

None

Risks

None

Tasks

add MIDB dataset processing code

remove IDB processing code

DD_DATASET is used by archive/restore - it must now include database name and server name

Utilities -> Load -> MIDB

The Database Load MMI is initiated from the DBA->Utilitiy->Load menu.  Choosing to load MIDB from the main load dialog will directly launch the DIA DEX (Data Exchange) application.  

Requirements

The following requirements are satisfied by the Load capability.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3.3�1�load GMI into empty db�DIA DEX��3.2.3.3�2�load GMI overwrite�DIA DEX��3.2.3.3�3�GMI bulk updates�DIA DEX��3.2.3.3�4�operational GMI data�DIA DEX��3.2.3.3�5�exercise/scenario GMI data�DIA DEX��3.2.3.3�6�process BCP files�DIA DEX��3.2.3.3�7�process SEF files�DIA DEX��3.2.3.3�8�process IDBTFs�DIA DEX��3.2.3.3�9�load GMI mass storage�DIA DEX��3.2.3.3�10�load to clients from MPLAN���3.2.3.3�11�update to clients from MPLAN���3.2.3.3�12�process updates from JMCIS�Replication Server��3.2.3.3�13�report cannot load�DIA DEX��3.2.3.3�14�report replication failures���3.2.3.3�15�selective extraction of data�DIA DEX��3.2.3.3�16�selective insertion of data�DIA DEX��3.2.3.3�17�define new data profiles�DIA DEX��3.2.3.3�18�default profile - server�DIA DEX��3.2.3.3�19�default profile - workstation�DIA DEX��3.2.4.2�1�load target records�DIA_DEX��3.2.4.2�2�load targets only�DIA DEX��3.2.4.2�3�use external mass storage �DIA DEX��3.2.4.2�4�load client workstation from TAMPS server�DIA DEX��3.2.4.2�5�N/A���3.2.4.2�6�accept C4 I data�DIA DEX��3.2.4.2�7�process BCP files�DIA DEX��3.2.4.2�8�process SEF files�DIA DEX��3.2.4.2�9�process bulk updates�DIA DEX��3.2.4.2�10�verify duplication of targets�DIA DEX��3.2.4.2�11����

HMI

There are no HMI changes to the Utilities -> Load HMI.  

Data Flow

The data flow for the Data Load shows that the DIA DEX (Data Exchange) application will be invoked when MIDB data is to be processed.
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Control Flow

The control flow for data load shows the additional processing that will be done to call the DIA DEX loader which will be used to load GMI data into the MIDB database.
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Assumptions

DIA will provide a method for loading by country code in the near future.

DEX will function as advertised.

DEX is suitable for the requirements of this SOR.

Concerns / Questions / Issues

Can DEX load from a tape?  If not, then we could tar from tape to a file, then process the file with DEX.

Does DEX truncate tables? If not, then it won’t support requirement 3.2.3.3.3.

Is DEX HMI too complicated for TAMPS users?. If so, can we launch DEX and bypass the initial HMI?

Will DIA provide a DEX that can process by country code? If so, when?

We have not been able to make the DEX loader work. (BIG !!)

 Risks

DIA designed DEX for theater level producers. It is not intended to be used for re-baseload.  Some requirements may not be met if DEX cannot re-baseload.

We have not been able to make the DEX loader work. (BIG !!)

Does DEX truncate tables? If not, then it won’t support requirement 3.2.3.3.3.

Tasks

define integration methods and tasks for MIDB Loader

identify functions in dut_ar*.c that are affected

Utilities -> Data Removal -> Dataset -> MIDB

The changes under this menu item are relatively minor.  Dataset removal uses DD_DATASET table from the database.  DD_DATASET will be modified to include database_name and archivable columns.  The new columns will be needed for data removal processing.  In a JMCIS environment, the capability to remove MIDB data will be prohibited and the menu item will be de-sensitized.  The archivable setting for MIDB would be set to off in the JMCIS environment.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.6.2�6�delete GMI data���3.2.6.2�7�delete Target data���3.2.6.2�8�removal of reference data���

HMI

There are no HMI changes for MIDB dataset removal, except that the option button “IDB” will be replaced with “MIDB” as a result of DD_DATASETS being updated.

Data Flow

There are no data flow changes for this menu item.

Control Flow

There are no control flow changes for this menu item.

Assumptions

Data removal of the MIDB is not allowed in a JMCIS environment due to the replication issue.

Concerns / Questions / Issues

should we allow dataset removal of the MIDB dataset ?

does dataset removal remove data from the JMCIS server MIDB database?

Risks

None

Tasks

modify code to support update to DD_DATASET table

add GMI dataset as a row in table

add MIDB menu item to Utilities->Removal->Dataset pull-down menu

Utilities -> Tactical Data Backup



The menu items under this menu are intended to give the TAMPS Database Administrator a method to save tactical updates that been made to the MIDB data, and to re-apply those changes after a new baseload has been performed.  The exact method of selecting those updates that should be backed up will depend on the resolution of the “Local Record” issue, but is expected to be selecting records based on the RECORD_STATUS value.  (For the MIIDS/IDB database, this was done using values placed in the HITLIST field by TAMPS.)  The Tactical Data Backup menu items only apply to the MIDB database (and probably only the GMI tables, including the TGT tables, within the MIDB).

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.6.2�1�backup tactical updates���3.2.6.2�2�restore tactical updates���

HMI

There is no HMI associated with the Tactical Data Backup backup and restore operations beyond the DBA application menu items (which will not be affected).

Data Flow

TBD

Control Flow

TBD

Assumptions

None

Concerns / Questions / Issues

In a JMCIS-connected environment:

Does JMCIS have their own tool for saving/restoring local updates, and if so, is there a conflict with the TAMPS tool?

Does JMCIS have a problem with us re-applying the tactical updates?

Do we need to distinguish updates made by TAMPS users from those made by JMCIS users, and if so, how do we do that?

What is the best way to determine whether the “best” record is the saved local update, or the newly loaded external record?  For the MIIDS/IDB, this was done by selecting the record with the latest DATE_LAST_CHG value.

Do we need to save any TIE table records?  This also depends on the “Local Record” resolution, but we probably will need to save these records.

Would it be better to use the Transaction File generation facility provided by DEX to save the local  records, and then DEX to re-apply them?  This has several problems associated with it (it depends on the MIDB history tables, which may not be populated by JMCIS, and which can be erased by the MIDB administrator, and there may be difficulties if DEX sets any field values when loading the record), but it would provide a way to save the local updates in a way that can be loaded not only back onto the same TAMPS system they were generated on, but any other MIDB-using system.

Do we need to be able to save tactical data from a standalone system, and then re-apply the updates after the system has connected to the LAN?  To do this, every standalone TAMPS must have a unique MIDB server ID -- otherwise, we run the risk of applying two updates which have the same surrogate key values.  Currently, we are not planning on supporting this operation because of this risk.

Risks

The “Local Record” concept has still not been fully worked out by DIA, and this part of the code is dependent on it.

It may not be possible to examine the RECORD_STATUS field in every MIDB table, particularly the TIE tables, and we may need to write special queries to locate the proper records.

Modifying the MIDB through direct access requires care not to violate the integrity of the MIDB, and may be subject to restrictions in a future MIDB release.

If tactical records are saved, and then the TAMPS system is re-installed without taking steps to maintain the MIDB Surrogate Key counters, then the saved tactical records could have the same SK values as newly generated tactical records.

If tactical records are saved, and then copied to another TAMPS system that used the same MIDB Server ID value, then the saved tactical records could have the same SK values as records generated on the new system.

Tasks

Determine method to identify tactical records in a TAMPS MIDB database.

Modify existing code to extract these tactical records, and store them where they can be accessed after an MIDB baseload.

Modify existing code to read the saved tactical records, and apply them to the MIDB database.

The MIDB Interface CSC routines should be used whenever feasible.

Output -> Messages

The modifications to messages functionality will include changing table names and column names to the MIDB table and column names.  Message generation that requires MIDB data will use Accessor functions to query MIDB.  There are no HMI changes under this menu item.  There are no significant design changes under this menu item.

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��CC0410��OBREP ���CC0870��TACELINT�����TACREP���

HMI

The HMI for the Output->Message dialog will not be changed.

Data Flow

There are no data flow changes for this menu item.

Control Flow

There are no control flow changes for this menu item.

Assumptions

Message formats are not changing.

Concerns / Questions / Issues

What other parts of this SOR are affected by dqt_genJoinCond(), dqt_genUserCond()

Risks

None

Tasks

modify dqt_genJoinCond (), dqt_genUserCond () 

pml_*_title_defs.h files ( 3 total ) (* is obrep, tacrep, tacelint )

must be modified to change hard-coded Table.Column names in obrep_title_array to new MIDB 2.0 Table.Column names.

pml_*_data_defs.h files ( 3 total ) (* is obrep, tacrep, tacelint )

must be modified to change hard-coded Table.Column names in *_data_array to new MIDB 2.0 Table.Column names.

must be modified to change hard-coded Table.Column data lengths in *_data_array to new MIDB 2.0 Table.Column names lengths.

pml_assign_*_table () (* is OBREP, TACREP, TACELINT )

insure that *_TABLE_DEFS array elements match OUT_ACTION_DATA values ( Table.Column ) from Object Hierarchy for new MIDB 2.0 tables and columns

pml_*_bind() (* is obrep, tacrep, tacelint )

uses OBREP_DATA_DEFS for data lengths - no changes needed

use ODBC function for binds

pml_*_sql.c (3 files)

modify to use MIDB Accessor Function

pml_sybase.c

pml_query_* () will be modified to use new MIDB Accessor Function

pml_format_*.c

probably no modifications necessary, however, check to see if any required fields are no longer available

Output -> Reports

The modifications to reports functionality will include changing table names and column names to the MIDB table and column names.  Report generation that requires MIDB data will use Accessor functions to query MIDB.  The reports affected by this SOR are Aircrew -> Target Attack and Aircrew -> Threat Assessment.  The System->Order of Battle report will be deleted.

Requirements

The following requirements are met by the Output Reports dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.6.2�3�size of GMI data���3.2.6.2�4�size of target data���3.2.6.2�5�size of reference data���

HMI

The HMI for the Output->Reports dialog will not be changed.

Data Flow

There are no changes in data flow for this menu item.

Control Flow

There are no changes in data flow for this menu item.

Assumptions

Removing the System -> Order of Battle report

We are providing a low level Accessor Function for ODBC connectivity?

Concerns / Questions / Issues

None

Risks

None

Tasks

completely rewrite the following files using new MIDB Accessor Functions:

( System -> Order of Battle ) prl_obrpt_sql.c - uses new MIDB tables, columns

( System -> Targets ) prl_target_sql.c - uses new TAMPS target tables with MIDB 2.0 Target table schema

prl_sybase.c

modify prl_Initialize (),prl_exec_cmd (), prl_beginTrans (), prl_*_bind (), prl_query () to use ODBC connectivity for MIDB queries or Target queries ( possibly provided by low level Accessor Function )

prl_format_target_*.c, prl_format_threat_*.c

modify column headings, if needed, to match new MIDB 2.0 column names

provide additional column headings and formatting for any new fields

Threat Scenarios

The Threat Scenarios dialog is initiated from the DBA->Setup->Defaults menu item.  This dialog allows the DBA the capability to establish threat scenarios from which mission planners can execute against. When a scenario is selected, from the Threat Scenario dialog, only the threat data defined for that scenario will be used.  The DBA activities will not be changed but the activities will be based upon the scenario that has been selected. In a JMCIS environment, threat scenario data can be updated through replication.



The dialog allows the DBA to add and delete scenarios from the available list of scenarios.

The Threat Scenarios menu item will be added to the Defaults pull down menu by modifying source file dmt_menu.c.



The Threat Scenario selection from the WSE->DBA pull-down menu will be deleted because there is no longer a need to activate and deactivate the scenario capability.

Requirements

The following requirements are met by the Threat Scenarios dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�1.1�using operational data���3.2.3�1.2�mission planning���3.2.3�1.2.1�storage for 17 scenarios���3.2.3�1.2.2�query access to 1 scenario���3.2.3�1.2.3�create access to 1 scenario���3.2.3�1.2.4�modify access to 1 scenario���3.2.3�1.2.5�delete access to 1 scenario��������3.2.3�1.2.9�access to 1 scenario data���3.2.3�1.2.10�stop access to 1 scenario data���3.2.3�4.3.1�query operational data���3.2.3�4.3.2�query scenario data���3.2.3�4.3.3�query using 1 scenario dataset���3.2.3�4.3.4�select scenario dataset���3.2.3�4.3.5�default to operational data���3.2.5�1.13�specify scenario queries���3.2.5�1.13.1�use scenario queries���3.2.5�1.14�use operational data���3.2.5�1.14.1�default to operational data���HMI



From WSE menu bar:



The Threat Scenarios menu item from the DBA pull-down menu will be deleted.





From DBA menu bar:



The DBA will initiate the Threat Scenarios dialog from the Setup->Defaults pull-down menu. .  This menu item will display a dialog which allows the DBA to select a scenario to use.  The following diagram shows the pull down menu where the Threat Scenarios menu item will be added.
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When the DBA selects a scenario from the dialog, any activities that are 

performed (add, update and modify threats) make changes to that scenario.  



The scrolled list displays the current list of available scenarios.  The default selection will be set to “Operational”.



The “Selected scenario” field provides the DBA with the capability to add a new scenario or to change the name of an existing scenario.  When 17 scenarios are already defined and the DBA attempt to create a new scenario, a warning message will be displayed indicating the maximum number of scenarios have been defined.  A warning message will be displayed if the new scenario to be added/name modified to already exists.



The “OK” push button is used by the DBA when an item has been selected from the list or a new scenario name has been entered in the add field.  The scenario selected becomes the repository for the subsequent activities performed by the DBA and the Threat Scenario dialog is removed from the display.



The “Apply” push button is used by the DBA to continuously create scenario names.  The Threat Scenario dialog remains on the display.



The “Delete” push button is used by the DBA to delete the selected scenario in the list.  A warning message is displayed when (1) no scenario is selected or (2) the highlighted selection is Operational.  A confirmation pop-up message is displayed when a scenario has been selected. The Threat Scenario dialog remains on the display.



The “Cancel” push button is used by the DBA to leave this dialog with out changing the current data selection.  The Threat Scenario dialog is removed from the display.



The “Help” push button is used to display the help text for this dialog.



The following is the pop-up list dialog displayed to the DBA to perform scenario operations.  When the dialog is displayed the actual names of the scenarios would appear.  If no scenarios have been defined the only item in the select list would be “Operational”.



�



Data Flow

Currently, the threat scenario support data is loaded into the IDB table using shell scripts, database scripts and bcp files.  For each scenario, there is a set of stored procedures which are used during the DBA and mission planner activities.  The scenario stored procedures will be deleted and a single set of queries will be used to retrieve threat data will be implemented.  Data for a specific scenario will be retrieved by specifying unique scenario key  which will be a valid value in the record_status field for the MIDB threat objects.



The names of the scenario and the record_status value will be saved in the TAMPS DD_SCENARIOS table.  This table will also contain the date and time the scenario was created (in one field).
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Control Flow





The following diagram describes the control flow when the DBA selects threat scenarios from the Setup menu item on the application toolbar.  When the scenario is added to DD_SCENARIO the next available record_status value is determined.  The scenario name, record_status  and date/time of the create is added to this table.











�
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Assumptions

A threat record is uniquely tagged within record_status field as being assigned to a scenario. 

The record_status value is determined from a valid values list for this field.

If a planner selects a scenario for which the DBA has not created data, any subsequent queries requested by the planner will result in no data being returned.

query tool

queries during processing

Concerns/Questions/Issues

Deleting the requirement for 5 megabyte size restriction.



Other  design considerations



On the one server for MIDB create a GMI database for each scenario. As each scenario is created by the DBA, another GMI database would be created on the same server.  This design was rejected because the MIDB software expects only one GMI database to be resident on the server.



Another design option would be to create one server and database for each scenario.  This would remove the processing overhead off the MIDB server.  This design was rejected because it requires too much overhead just to enable 5 megabytes of scenario data to execute.  It would require more disk space to duplicate the MIDB GMI and support databases, more memory to have multiple databases assessable and more processing time to  have multiple databases up and running.

Risks

Uniquely tagging scenario threat records within record_status is not currently supported by MIDB.

Tasks

Define the unique tagging of a threat record assigned to a scenario.

Delete the Threat Scenarios menu item from the WSE->DBA pull-down menu.

Update menu on DBA and MPM toolbar to include Threat Scenario menu item.

Provide function to return scenario access.

Provide function to return scenario selection.

Delete existing scenario stored procedures

Build Threat Scenario dialog

Add DD_SCENARIOS table to TAMPS database

Add record_status to all queries

Utilities -> MIDB

This new sub-menu, available on the Database Administrator  application menu, contains utility function unique to the MIDB.  These include defining the subset of GMI data to be downloaded to the client workstations, and accessing several MIDB utility applications that could be useful to the Database Administrator.



The exact set of MIDB utility applications to be made available is TBD.  These utility applications will be run as delivered by DIA.  We do not plan to extensively test these utility functions, nor will we provide documentation on them beyond what is provided by the DIA MIDB software.



This sub-menu replaces the previous Utilities -> IDB sub-menu, which will be removed.

Requirements

See also the “MP-LAN client data download” event, described above under “System Administrator Functions”.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.6.2�5�size of reference data���

HMI

�
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Data Flow

For the GMI Subset utility, see the “MP-LAN client data download” event, described above under “System Administrator Functions”.



For the DIA utility applications, these are GOTS applications and no internal design is available.

Control Flow

For the GMI Subset utility, see the “MP-LAN client data download” event, described above under “System Administrator Functions”.



For the DIA utility applications, these are GOTS applications and no internal design is available.

Assumptions

None

Concerns/Questions/Issues

Which DIA utilities are suitable for a TAMPS database administrator to use?

What documentation is available on these utilities beyond the help screens?

Do any of the help screens require special support (such as a Web browser)?

Risks

While we will select applications which will not update the database, there might be unexpected interactions between some of the utilities and other applications..

Tasks

Determine which DIA MIDB utilities are suitable for use, and how they can be invoked from outside the DIA menus.



Archive/Restore

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:���������������������������



HMI

The Archive/Restore HMI is initiated from DBA->Utilities->Archive/Restore menu item.

Data Flow

Control Flow

This control flow shows that the DBA can archive data from the MIDB database or restore data to the MIDB database.  When archiving, the DBA can select the entire MIDB database or select individual datasets to archive.  Any problems that occur during the archive are reported back to the DBA.  When restoring, the DBA can select the entire MIDB data or select individual dataset to restore.  Any problems that occur during the restore are reported back to the DBA.  The DBA is able to specify the format of the archive output data as Sybase BCP or database dump file.
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Assumptions

Concerns / Questions / Issues

None

 Risks

None

Tasks

add MIDB dataset processing code

remove IDB processing code

DD_DATASET is used by archive/restore - it must now include database name and server name

Database Load

The Database Load operation will be modified to support loading the MIDB data into the database.  When the user selects MIDB GMI from the list of options, the DIA DEX HMI will be called and all control is turned over to DEX at this time.

Requirements

HMI

The Database Load HMI is initiated from the DBA->Utility->Load menu.  This HMI will not change except for adding a list item to select MIDB GMI Data Load.  The dialog below shows an example of the Database Load HMI.



�
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Tasks

integrate DIA DEX software

identify functions in dut_ar*.c that are affected

modify code to accommodate new tables, including support tables for GMI and targets





�Mission Planner Functions

Design Overview



This section describes how the MIDB 2.0 Products affect the major Mission Planner functions.



The mission planner will not be significantly affected by the migration to the MIDB 2.0 products.  The planner will continue to use the “Threat/Intel” menu to display threat data.  The mission planner will notice changes to the AMP info displays which define fields pertaining to the threat data object selected, due to the corresponding MIDB definition changes.  The mission planner functionality remains the same and there will be no loss of TAMPS data with the usage of the MIDB software.

Product Summary

Below is a list of all HMI paths to MIDB edits or queries as performed by an MPM planner.



MPM main application

 menu item:�Edit or Query�How Affected by MIDB 2.0 ��Threat/Intel -> Targets�Query�integrate MIDB TGT tables into Object Hierarchy

ODBC��Threat/Intel->Planner Target Updates�Edit���Threat/Intel -> OOB�Query�integrate GMI (non-TGT) tables into Object Hierarchy

build queries

multiple databases

multiple servers��Threat/Intel -> Range Rings�Query�uses GMI (non-TGT) tables integrated into Object Hierarchy��Threat/Intel -> Radar Terrain Mask�Query�uses GMI (non-TGT) tables integrated into Object hierarchy��Output -> Reports�Query�integrate all GMI tables into Object Hierarchy

uses MIDB Interface

ODBC�� Output -> Messages�Query�integrate all GMI tables into Object Hierarchy



uses MIDB Interface

ODBC��



Design Summary



The mission planner processing to be implemented falls into two categories:

(1)  usage of the MIDB data and (2) usage of the planner target.  The TAMPS_Target  database table will be replaced by a new table called Planner Targets.  The specific areas where the MIDB data affect the mission planner is the following:



Open Mission  	Obsolete data checks are performed on the target data (referenced in a route) with the target data in the MIDB database.



Save Mission	The target data referenced in a route is saved in the Planner Targets table.



Target Query	The target data available for query is found in the Planner Targets table or the MIDB database.



Threat Query	The threat data available for query is found in the MIDB database.



Planner Target Updates	A new HMI provides the planner the capability to define and modify target data.



Range Rings  	The threat data will also be from the MIDB database.



Radar Terrain Mask	The threat data will also be from the MIDB database.



Edit Flight Parameters	The target data will use MIDB schema.



There will also be minor HMI changes which reflect the new schema definitions of the objects, such as targets, in the MIDB database.



The following table shows how the functionality of the MPM main application menu items are affected by the MIDB 2.0 integration.  Only MPM main application menu items that are affected by this design are listed.



MPM Module menu items 

affected by MIDB 2.0:�How Affected by MIDB 2.0 ��File-> Open Mission�uses MIDB Target Interface��File-> Save Mission�uses MIDB Target Interface��Threat/Intel -> Targets�uses MIDB Interface, ODBC��Threat/Intel -> Planner Target Updates�uses new target table, ODBC��Threat/Intel -> OOB�uses MIDB Interface, ODBC��Threat/Intel -> Range Rings�new OH table definitions��Threat/Intel -> Radar Terrain Mask�new OH table definitions��Output -> Reports�uses new MIDB Interface��Output -> Messages�uses new MIDB Interface��

For any MPM, queries are executed using the MIDB database on the TAMPS Server.

Database Changes



Table Name�Action�Description��TAMPS_TARGET�delete���PLANNER_TARGETS�new�maps to the MIDB TGT_DETAIL table��

Specific MPMs

TERPES

This MPM accessed and modified the IDB facility and equipment data.  Public functions will be developed to provide the capability to modify MIDB facility and equipment records.

HARM

This MPM accessed the IDB data by using embedded SQL calls to stored procedures.  The IDB stored procedures will be converted to use the MIDB database tables.  Public functions will be created for this MPM to execute the stored procedures.

JSOW/SLAM



Design

This section describes how the MPM planner functionality will be affected by the MIDB 2.0 migration as viewed by the HMI paths where there is MIDB database access.

Open Mission

The Open Mission dialog is initiated from MPM->File->Open Mission menu item.  The current open mission processing will not be changed, except to add validity checks which will verify the targets used by the mission exist in the MIDB database and have not been modified.  When all targets have been checked the planner is notified with an error message pop-up window if the mission contains obsolete or deleted targets.



The planner is responsible for resolving the obsolete target references within the mission.

The obsolete or deleted MIDB targets will not be automatically removed from the mission.



The TAMPS target schema, Planner Target table, will be changing to correspond to the schema of the MIDB target.  The TAMPS Planner Target database table will contain a surrogate key column which will defined whether the target was created by a planner or is defined in the MIDB database.  It will also be defined with a column which identifies the date and time of the MIDB target.  This will be used to determine if the MIDB target has changed.

Requirements

The following requirements are met by the Open Mission dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.4�1.5�retrieve target data�modify adt_retrieveTargets()��3.2.4�5.8�retrieve target�modify adt_retrieveTargets()��3.2.4�5.9�alert message���HMI

The HMI dialog to open a mission will not be changed.  New pop-up message windows will be displayed when the mission is referencing target data which does not exist in the MIDB database or if the target data is different than that stored locally.

Data Flow

When a mission is opened, the target data for that mission is retrieved from the Planner Target database.  The Open Mission processing queries the database for all targets associated with the mission.  Each target referenced by the mission is either a target created by the planner or a target defined in the MIDB database.  All targets that are not planner targets will be checked against the MIDB database to verify that the target still exists.  The planner will receive obsolete target message for targets that have been modified or that are not defined in the MIDB database.  After verification of the target information, the display is updated with the target symbols for targets that do exist and are not obsolete.
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Control Flow

The Open Mission control flow shows the additional work to be done to verify the target data referenced in a mission.  If the mission contains obsolete or obsolete targets an error message is displayed to the planner about the target inconsistencies.  Once the error message has been responded to, it is the planner’s responsibility to resolve the target inconsistencies.  The workstation log will contain message which identify which targets were found to be obsolete or deleted.
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Assumptions

The TAMPS Planner Target  database table is identical (field by field) to the MIDB target database table.

There will be extra columns to added to the Planner Target table to contain the surrogate key, owner and timestamp of the reference target record.

A log message will be sent for each obsolete or modified target in the mission.

Concerns/Questions/Issues

In addition to sending messages to the logger, would a dialog with a scrollable list that contained all the obsolete or modified targets provide the planner with an easier mechanism to address the target changes?

Risks

Converting to new TAMPS Planner Target table

Resolving obsolete targets within MIDB database

Tasks

Implement new TAMPS Planner Target  database table

Loop through each target defined in mission and check for existence in MIDB database

Send message to logger for individual targets which are obsolete or undefined

Define new pop-up message for missing or modified target data

Save Mission

The Save mission dialog is initiated from MPM->File->Save menu item.  The current save mission processing remains the same except for saving the target information in the Planner Target database table.

Requirements

The following requirements are met by the Save mission (and Save As mission) dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.4�1.4�storage for target�modify adt_insertTargets()��3.2.4�5.7�save target�modify adt_insertTargets()��Data Flow 

The Save mission data flow shows that the Planner Target database table is updated with the targets referenced in the mission.
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Control Flow

The Save mission control flow outlines the additional processing that occurs to save the referenced targets in the route to the Planner Targets database table.
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Assumptions

None

Concerns/Questions/Issues

None

Risks

None

Tasks

Write save target function to Planner Target database table

Targets Query

The Targets Query dialog is initiated from the MPM->Threat/Intel->Targets menu item.  This dialog provides a list of available target queries and is used by the planner to perform queries on planner targets in the Planner Target database table and/or queries on DBA targets in the MIDB database. The map display is updated with the results of the target queries selected by the planner.  The functionality of the dialog control buttons (OK, Cancel, Help) will not be changing.



The Object Hierarchy will be changed  to map to the schema of the new TAMPS Planner Target database table which is the data store for the targets defined by MPM planners.  The old TAMPS target database table will be deleted.

Requirements

The following requirements are met by the Targets dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.4�1.1�display query results�mmt_featOKCallback()��3.2.4�1.2�textual display�mmt_featOKCallback()��3.2.4�1.3�use Object Hierarchy�mmt_featOKCallback()��3.2.4�1.5�retrieve target�mmt_featOKCallback()��3.2.4�1.10�display in horizontal datum���3.2.4�1.13�retrieve location coordinates�mmt_featOKCallback()��3.2.4�1.14�display location coordinates���3.2.4�1.16�retrieve horizontal datum�mmt_featOKCallback()��3.2.4�1.18�retrieve horizontal location accuracy�mmt_featOKCallback()��3.2.4�1.20�retrieve vertical location accuracy�mmt_featOKCallback()��3.2.4�1.21�display horizontal accuracy value and unit of measurement���3.2.4�1.22�display vertical accuracy value and unit of measurement���3.2.4�1.24�retrieve confidence data�mmt_featOKCallback()��3.2.4�1.25�display confidence data���3.2.4�1.26�store JTIM targets���3.2.4�1.27�retrieve JTIM target���3.2.4�1.28�display JTIM target���3.2.4�1.29�TAMPS targets vs others���HMI

The HMI for the target query dialog will not be changed.  The OK, Apply, Cancel and Help button functionality will not be changed.

Data Flow

 When the planner selects the targets menu item, the data dictionary table DD_MENU  is  queried for the list of available target queries.  From the list of target queries, the planner selects a query to execute.  There are two types of target queries that the planner can select, and the type of query determines the source of the target data.  The two types of queries are (1) Planner only targets - the targets are retrieved from the TAMPS Planner Target Data; (2) DBA only target - the targets are retrieved from the MIDB Target Data.(  The “all targets” capability will no longer be supported, since the target data will be residing in two different databases (MIDB and TAMPS).



The query is constructed from DD_USER_FIELDS and DD_CONDITIONS and the query is executed against the database for which the data is to be retrieved.  The overlay manager updates the bucket with the target data retrieved from the database(s).  Lastly, the map display is updated with the target symbols using the objects in the bucket. 



The same data flow processing occurs when the DBA queries for target data.
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Control Flow

 The Targets Query dialog control flow shows the processing that occurs once the planner selects a specific target query to display.  The planner is provided with a list of target queries to execute, and the target query list information is retrieved from the Data Dictionary.  The planner has the option to select a target query or to not perform any queries.  When a target query is selected, the query is constructed and the target data is retrieved from the Planner Target database table or the MIDB Target database table.  Each target is added to the overlay bucket and the display is updated by using the overlay bucket object(s).
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Assumptions

The Object Hierarchy will be updated to map the schema of the MIDB target tables.

Queries have been created and added to the menus.

Concerns/Questions/Issues

How are the JTIM targets to be differentiated from TAMPS targets ? Is there a condition setting to know the originator of the target data? and what field is it?

Risks

None

Tasks

Update Object Hierarchy to map to the schema of the new Planner Target database table 

Create new Planner Target queries

Implement  accesser functions to Target data

Planner Target Updates

The Planner Target Updates dialog is initiated from the MPM->Threat/Intel->Planner Target Updates menu item.  This is a modification to the current “Define User Target” dialog used by the planner to create, modify and delete targets.  The target data is saved in the Planner Target table in the TAMPS database.

Requirements

The following requirements are met by the Planner Target Updates dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.4�1.4�store target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.5�retrieve target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.6�modify target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.7�define target by geo coordinates and unique id�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.8�convert datum�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.9�< 1% conversion error�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.11�location coordinates�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.12�save location coordinate precision�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.13�retrieve location coordinate precision�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.14�display loc coordinates�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.15�save horizontal datum�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.16�retrieve horizontal datum�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.17�save horizontal location accuracy and unit of measurement�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.18�retrieve horizontal location accuracy and unit of measurement�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.19�save vertical location accuracy and unit of measurement�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.20�retrieve vertical location accuracy and unit of measurement�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.23�save confidence data�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.24�retrieve confidence data�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.25�display target confidence�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.26�store target (JTIM)�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.29�differentiate between TAMPS targets and external targets�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�1.30�planner target vs DBA target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.1�maintain targets���3.2.4�3.2�create target���3.2.4�3.2.2�new db target record�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.2.3�create target from object�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.2.4�create target from map point�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.2.5�create text target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.3�modify target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.3.2�modify target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.3.3�planner modifies own targets�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.4�delete target�modify btt_deftgt.c

modify btt_deftgtcb.c��3.2.4�3.4.2�planner deletes own targets �modify btt_deftgt.c

modify btt_deftgtcb.c��HMI

The Planner Target Updates dialog is used by the mission planner to create, modify, and delete targets.  Targets created through this dialog will be linked to the currently open mission and will be stored in the local TAMPS Planner Target data table.  This dialog will be modeled after the  current “Define User Target” dialog, and will use the new data fields defined in the MIDB TGT_DETAIL table to support target definition.



The following diagram shows the currently dialog which will be replaced by the Define User Target dialog.



�







The new fields on the Planner Target Updates dialog are as follows:



HMI Change�Purpose��Details button�displays more information about the target  (if available)

- minimally this will contain correspond to the Amp Info capability but probably will be more detailed��Target Name field�defined the name of the target��Width field�width of the target value between 0 and 100,00��Width option menu�values are feet, meters (default: feet)��Height field�height of the target value between 0 and 100,000��Height option menu�values are feet, meters (default: feet)��Length field�length of the target value between 0 and 100,000��Length option menu�values are feet, meters (default: feet)��Orientation Horiz field�horizontal orientation of the target (value between 0 and 360)��Orientation Horiz option menu  �values degrees true, degrees mag (default: user’s default for bearing)��Orientation Vert field�vertical orientation of the target (value between 0 and 360)��Orientation Vert option menu�values degrees true, degrees mag (default: user’s default for bearing)��Hardness option menu�values are hard, medium, soft  (default: hard)��Shape field�shape of the target��Horiz Confidence field�horizontal confidence of the target (value between 0 and 99)��Vert Confidence field�vertical confidence of the target (values between 0 and 99)��

 The high precision toggle button has been deleted because the MIDB target object does not support this field.



The target is defined in terms of geospatial coordinates and a unique identifier.  The location coordinates can be specified to 1/100th of an arc-second.  A target will retain the accuracy of the horizontal/vertical location values, the unit of measurement for the horizontal/vertical location values, horizontal datum and confidence data when it is stored and retrieved from the database.
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Data Flow

When the planner selects the Planner Target Updates menu item, the Planner Target Updates dialog is displayed.  When the planner defines a new target, the Planner Target database is updated with the new target data, the overlay manager updates the bucket object with the new target, and the display is updated with the new target.  



When the planner modifies an existing target, the Planner Target database is updated with the modified target data, the overlay manager updates the bucket with the modified target, and the display is updated with the modified target.  



When the planner deletes an existing target, he is given the option to (1) delete the target from the display or (2) to delete the target from the database.  When the planner chooses to delete the target from the display, the overlay manager deletes the target from the bucket and the display is updated to remove the target.  When the planner chooses to delete the target from the database, the target is deleted from the Planner Target database, the overlay manager deletes the target from the bucket and the display is updated to remove the target.



The Planner Target Updates data flow shows the Planner Target Data is updated with the targets defined by the planner.
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Control Flow

The Planner Target Updates control flow shows that the dialog is waiting in the Main XT event loop.  This event loop is exited when the planner uses one of the control buttons (OK, Cancel, Apply, Help).



When the planner presses the OK button, the target data is added/modified to the Planner Target database, the database is queried again to retrieve the target data, and the map display is updated with the new target.  The Planner Target Updates dialog is removed from the display.



When the planner presses the Apply button, the target data is added/modified to the Planner Target database, the database is queried again to retrieve the target data and the map display is updated with the new target.  The Planner Target Updates dialog remains on the display.



When the planner presses the Delete button, a confirmation pop-up window is displayed to the user, where a “no” response will return the planner to the target dialog.  When the planner  selects the yes on the delete confirmation window, the target data is deleted from the Planner Target database, the database is queried again to retrieve the target data and the map display is updated with only the targets return from the last query.  The Planner Target Updates dialog remains on the display.



When the planner presses the Cancel button, any modifications made by are planner on the dialog are not updated in the Planner Target database and the map display is also not updated. The Planner Target Updates dialog is removed from the display.



When the planner presses the Help button, the help window for this dialog is displayed.



This HMI uses the Planner Target database table to store/retrieve the target information.



The map display will be updated when a target is added, deleted, or modified when using this HMI.
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Assumptions

The current functionality to define targets will be used as a starting point.

Concerns/Questions/Issues

None

Risks

None

Tasks

Delete old target table from TAMPS database

Create new Planner Target table which matches the MIDB target table

Callbacks for new HMI dialog

target confidence

horizontal accuracy

vertical accuracy

location coordinates

Threat OOB Query

The Threat OOB Query dialog is initiated from an MPM->Threat/Intel->OOB menu item.  The Threat OOB Query dialog functionality  for the control buttons (OK, Apply, Cancel, Help) for Air, Ground, Naval, Electronic, SAM, AAA, and Other will not change, but the queries which retrieve the order of battle information will use the MIDB database. The map display is updated with the threat data requested by the planner.

Requirements

The following requirements are met by the Threat OOB queries dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�1.3�query threat data�modify iot*.c��3.2.3�1.3.1�equipment data�modify iot*.c��3.2.3�1.3.2�equipment index data�modify iot*.c��3.2.3�1.3.3�unit�modify iot*.c��3.2.3�1.3.4�facility�modify iot*.c��3.2.3�4.1�display query results���3.2.3�4.2�textual display���3.2.3�4.3�query using Object Hierarchy�iot*.c��3.2.3�4.4�pre-defined queries�Object Hierarchy��3.2.3�4.5�query for spatial objects�Object Hierarchy��HMI

Several changes are being implemented for the Threat OOB menu and sub-menus which will coincide with the MIDB data.



Air Query



Currently, the “Select” push-button is a pull down menu with sub-query options.  The “Select” push-button will be deleted from the Air sub-menu and the menu options moved to the Threat OOB menu as cascading options for the Air menu item.  The following two diagrams show the current dialog and the recommended change to the Threat OOB menu.



�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �17� Old OOB Air Query Selection 









�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �18� New OOB Air Query Menu Selection





This diagram shows the individual Air  Order of Battle Query list dialogs where the mission planner would select a specific query to execute.



�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �19� OOB Air Query List Dialog HMIs





SAM Query



The FIXED and TACTICAL categories are planned to be replaced with a single category in the near future.  This is a DIA production issue over which we have no control.  Eliminating these categories from the dialog will merge the queries into a single list, which should be acceptable to the planners.  Also, in order to provide a simpler list of SAM queries to be more consistent with the other OOB dialogs, a separate menu to provide a list of Unit SAM queries will no longer be provided.  Access to Unit SAMs will still be provided, but it will be through the SAM menu list.



The three SAM menus will be replaced by a scrolled list dialog containing the queries to retrieve individual SAM types, as well as all SAMs.  This will be displayed when the planner selects the SAM menu item from the MPM->Threat/Intel->OOB menu.  There will be no loss of functionality for the planner.  The following dialog will be deleted.





�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �20� Deleted OOB SAM Query Selection 





AAA Query



The AAA sequence of selecting a query is the same as the SAM query selection and the same type of change will be implemented.  The dialog which specifies Facility, Unit Equipment, and Fire Control Radars will be deleted.  When the planner selects the AAA menu item from the MPM->Threat/Intel->OOB menu, a scrolled list dialog will be displayed which provides the planner with all the available AAA queries.

Data Flow 

When the planner selects an OOB menu item,  the data dictionary table DD_MENU is  queried for the list of available threat queries for that menu item.  From the list of threat queries, the planner selects a query to execute.  The query is constructed from DD_USER_FIELDS and DD_CONDITIONS and the query is executed against the MIDB Database.  The overlay manager updates the bucket with the threat data retrieved from the MIDB Database.  Lastly, the map display is updated with the threat symbols using the bucket object(s). 



The data flow diagram outlines the processing of the Air menu item selection.  The same processing is used for each OOB menu item selection.





�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �21� OOB Query Data Flow



Control Flow

The OOB Query control flow shows the processing that occurs once the planner selects a specific OOB type to display.  The planner is provided with a list of threat queries to execute, this information is retrieved from the Data Dictionary.  When the planner selects a query to execute, the query is constructed and the threat data is retrieved from the MIDB database.  The retrieved data is added to the overlay bucket and the bucket object(s) are used to update the map display.



�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �22�  OOB Query Control Flow (1 of 2)



�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �23�  OOB Query Control Flow (2 of 2)

Assumptions

The Object Hierarchy will be updated to map the schema of the MIDB threat tables.

Queries have been created and added to the menus.

Concerns/Questions/Issues

None

Risks

None

Tasks

Update Object Hierarchy to use the MIDB threat table structure

Modify current list of threat queries to coordinate with MIDB threat table structure

Range Rings Dialog

The Range Rings dialog is initiated from MPM->Threat/Intel->Range Rings menu item.  The Range Rings menu item dialogs (Display Threats and Selected Threats) processing will not be changed.  The range rings will be created using threat data which has been retrieved from the MIDB database or threat data retrieved from TAMPS_Interim_Threat table.



The range ring algorithm processing which includes accessing the elevation data from the DTED database and the SAM/AAA equipment data from the NID database will not be changed.

Requirements

The following requirements are met by the Range Ring dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�2.7�use interim threat data�edt_mera_cb()��3.2.3�1.5�use SAM threats�edt_mera_cb()��3.2.3�1.6�use AAA threats�edt_mera_cb()��HMI

The HMI for the range rings dialog will not be changed.

Data Flow

The threat data is selected by using the query capability which is described in the section for MPM->Threat/Intel->OOB. The threat data is retrieved from the MIDB database by a query based upon the OOB menu item selection.  The threat data from the query is added to the bucket, and using the bucket object(s) the threat data is displayed on the map.  The planner selects which threat objects to generate the range ring information.  The range ring polygon information is saved with the threat object in a new bucket.  The map display is updated with the bucket object(s).



The same processing sequence applies when interim threat data is selected for display from MPM->Threat/Intel->Planner  OOB->Planner Only.   The interim threat data is retrieved from TAMPS_Interim_Threat table.





�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �24� Range Rings Using SAM Objects Data Flow

Control Flow

An individual control flow for range rings is not provided since the range ring processing is not affected by the MIDB migration.  The control flow for the update of the display with threat data is described in the MPM->Threat/Intel->OOB query section.

Assumptions

The range ring processing uses threat data which is currently being displayed on the map.

The range rings dialog will not be changed.

The mission planner will be sent an alert message as notification when the MIDB data has changed upon completion of a load or update operation.

Range Ring object action needs to exist on appropriate object

Concerns/Questions/Issues

Does the range ring access/retrieval code have a dependence on the MIDB data elements?

Risks

None

Tasks

No tasks required for range rings processing but there is a dependence upon the tasks described in OOB Query section. 

Determine if the processing needs to handle the 7 character EQP_CODE.

Radar Terrain Mask Dialog

The Radar Terrain Mask dialog is initiated from MPM->Threat/Intel->Radar Terrain Mask menu item.  The radar terrain mask dialog processing will not be changed.  The radar terrain masks will be created using threat data which has been retrieved from the MIDB database or threat data retrieved from TAMPS_Interim_Threat table.



The radar terrain mask processing which includes accessing the RTM server and the radar parameter data in the NID database will not be changed.  The RTM Server is responsible to checking the polygon values against DTED. Requirements

The following requirements are met by the Radar Terrain Mask dialog.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�2.8�use interim threat data�ert_int_rtm_init()��3.2.3�1.4�use equipment data�ert_ini_rtm_init()��HMI

The HMI for the radar terrain mask dialog will not be changed.

Data Flow

The threat data is selected by using the query capability which is described in the section for MPM->Threat/Intel->OOB.  The threat data is retrieved from the MIDB database by a query based upon the OOB menu item selection The threat data from the query is added to the bucket, and using the bucket object(s) the threat data is displayed on the map.  The planner selects which threat objects to generate the range ring information.  The range ring polygon information is saved with the threat object in a new bucket.  The map display is updated with the bucket object(s).





The same processing sequence applies when interim threat data is selected for display from MPM->Threat/Intel->Planner  OOB->Planner Only.  The interim threat data is retrieved from the TAMPS_Interim_Threat table. 



The data flow diagram outlines the processing when Electronic objects are used to generate radar terrain mask.  The same processing applies when interim threat objects are used to generate radar terrain masks.



�

Figure � STYLEREF 4 \n �4.1.3.2�-� SEQ Figure \* ARABIC �25� Radar Terrain Mask Data Flow



Control Flow

 An individual control flow for  radar terrain mask is not provided since the radar terrain mask processing is not affected by the MIDB migration.  The control flow for the update of the display with threat data is described in the MPM->Threat/Intel->OOB query section.

Assumptions

The radar terrain mask processing uses threat data which is currently being displayed on the map. 

The radar terrain mask dialog will not be changed.

The mission planner will be sent an alert message as a notification when the MIDB data has changed upon completion of a load or update operation.

Radar Terrain Mask object action needs to exist on appropriate object

Concerns/Questions/Issues

Determine if the processing needs to handle the 7 character EQP_CODE.

Risks

None

Tasks

No tasks required for radar terrain mask but there is a dependence upon the tasks described in OOB Query section.

Edit Flight Parameters

The Edit Flight Parameters dialog is initiated from MPM->Route->Edit Flight Parameters menu item.  This provides the capability for the planner to create, modify, and delete points in the mission.  On this dialog the planner has the option to reference a target in the mission by using the Attack Target selection.  No changes will be made to this processing. 

Requirements



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�5.1�create multiple target references�adt_target.c��3.2.3�5.2�remove target reference�adt_target.c��3.2.3�5.3�modify target reference�adt_target.c��3.2.3�5.4�create offset aimpoint�aet_CreateRefOAPDialog()��3.2.3�5.5�select pre-defined target�adt_target.c

adt_tgData.c��3.2.3�5.6�create new target as route point�adt_target.c

adt_tgData.c��3.2.3�5.7�store target relationship�adt_target.c��3.2.3�5.8�retrieve target relationship�modify adt_retrieveTarget()��3.2.4�1.31�associate targets and missions�adt_target.c��HMI

There are no HMI changes for Edit Flight Parameters.

Data Flow

There are no data flow changes for Edit Flight Parameters.

Control Flow

There are no control flow changes for Edit Flight Parameters.

Assumptions

None

Concerns/Questions/Issues

None

Risks

None

Tasks

None

Threat Scenarios

The Threat Scenarios dialog is initiated from the MPM->Setup->Defaults menu item. The planner activities will not be changed but the activities will be based upon the scenario that has been selected.  Even though a scenario is defined in the list does not imply that the DBA has created data records associated for that scenario.  In this instance, queries performed on this type of scenario will return no data.

Requirements

The following requirements are met by the Threat Scenarios.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�1.1�using operational data���3.2.3�1.2�mission planning���3.2.3�4.3.1�query operational data���3.2.3�4.3.2�query scenario data���3.2.3�4.3.3�query using 1 scenario dataset���3.2.3�4.3.4�select scenario dataset���3.2.3�4.3.5�default to operational data���3.2.5�1.13�specify scenario queries���3.2.5�1.13.1�use scenario queries���3.2.5�1.14�use operational data���3.2.5�1.14.1�default to operational data���

HMI

The scrolled list displays the current list of available scenarios.  The default selection will be set to “Operational”.



The “OK” push button is used by the planner when an item has been selected from the list or a new scenario name has been entered in the add field.  The scenario selected becomes the repository for the subsequent activities perform by the planner and the Threat Scenario dialog is removed from the display.



The “Cancel” push button is used by the planner to leave this dialog with out changing the current data selection.  The Threat Scenario dialog is removed from the display.



The “Help” push button is used to display the help text for this dialog.



The following is the pop-up list dialog displayed to the DBA to perform scenario operations.  When the dialog is displayed the actual names of the scenarios would appear.  If no scenarios have been defined the only item in the select list would be “Operational”.

If the planner has already selected a scenario during a previous selection of the Threat Scenario menu item (during the same session), that scenario is highlighted.



�

Data Flow

This data flow shows that the data displayed in the scrolled list is retrieved from the TAMPS DD_SCENARIOS table.





�

Control Flow

The control flow shows the processing that occurs when the planner uses the Threat Scenario dialog.  A selection of a scenario defines the threat data that will be used for all subsequent queries.

�

�

Assumptions

If a planner selects a scenario for which the DBA has not created data, any subsequent queries requested by the planner will result in no data being returned.

query tool

queries during processing

The scenario selected remains the same when the mission is changed.

Concerns/Questions/Issues

See DBA section 

Risks

See risks defined in DBA section

Tasks

See tasks defined in DBA section

Application Interface CSC

The GMI Application Interface encapsulates the function to access the MIDB database tables programmatically.  The calling program will have query access to the facility, equipment, unit and remarks data.  A discrete set of fields from each table will be available for query access.  Users will be shielded from changes to the MIDB database tables which do not affect their application.





The MIDB schema objects that will be supported includes the following:

Equipment

Equipment Index

Units

Facility

Remarks

Targets 

Observation



Requirements

The following requirements are met by the Application Interface.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.3�6.1�query facility data�new  dit_getMidbData()��3.2.3�6.2�query equipment data�new  dit_getMidbData()��3.2.3�6.3�query unit data�new  dit_getMidbData()��3.2.3�6.4�query using geo bounding box and threat type�new  dit_getMidbData()��3.2.3�6.5�request fields to be returned�new  dit_getMidbData()��

HMI

There is no HMI for Application Interface CSC.

Data Flow

The dit_getMidbData interface returns a list of UZT_HANDLES where each handle represents a record from the database table or view returned by the query.  The user will need to provide the following input parameters:

specify what type of data is to be returned

specify what column data is to be returned

specify any conditional data which will be used to limit the amount of data to be returned

provide a pointer to a list structure where the data to be returned



The dit_getMidbData interface will build a database query from the user inputs and it will use the pointer to the list structure provided by the user to return the queried data.  Also, a status indicator will be returned to provide the user with  increased error handling diagnostics.



�

Control Flow



�

Assumptions

Defaults will be provided for the data server name and the database name.

Concerns/Questions/Issues

Will the calling program need to specify the data server name and/or the database name?

Risks

Using ODBC

Tasks

Write dit_getMidbData

Provide handle functions for the user to call dit_getMidbData

Target Application Interface CSC

The Target Application Interface encapsulates the functions to access the planner target database table programmatically.  The calling program will have access to the target data.  The functions provided to access the target data are: create, modify, delete and query.  A discrete set of columns from the table will be available for planner access.



The Target Application Interface functions will use TAMPS PLANNER_TARGETS database object. 

Requirements

The following requirements are met by the Target Application Interface.



Requirements Section�Requirements Sub-section�Requirements 

Keywords:�Satisfied by:��3.2.4�4.1�create target�new  dit_createTarget()��3.2.4�4.2�query target�new  dit_getTargets()��3.2.4�4.2.1�request target fields to be returned�new  dit_getTargets()��3.2.4�4.2.2�specify query conditions�new  dit_getTargets()��3.2.4�4.3�modify target�new  dit_modifyTarget()��3.2.4�4.4�delete target�new  dit_deleteTarget()��3.2.4�4.4.1�delete target from display���3.2.4�4.4.2�delete target�new  dit_deleteTarget()��HMI

There is no HMI for Target Application Interface CSC.

Data Flow

The Target Application Interface data flow is split into the four requirement areas for targets: create, modify, delete and query.



Create Target



The dit_createTarget interface provides the capability for the planner to programmatically create targets in the PLANNER_TARGET database table.  This function uses the input parameter to build a sql query to insert a target record.  This function returns a status indicator to provide the user with error handling diagnostics.



�



Modify Target



The dit_modifyTarget interface provides the capability for the planner to programmatically modify targets in the PLANNER_TARGETS database table.  The user will need to provide the following two input parameters:

specify the field values of the target to be modified

specify the surrogate key for the target to be modified



This function returns a status indicator to provide the user with error handling diagnostics.



�



Delete Target



The dit_deleteTarget interface provides the capability for the planner to programmatically delete targets from the PLANNER_TARGETS database table.  This function uses the input parameter to build a sql query to delete a target record.  This function returns a status indicator to provide the user with error handling diagnostics.



�



Get Targets



The dit_getTargets interface returns a list of UZT_HANDLES, where each handle represents a record from the database table or view returned by the query.  The user will need to provide the following input parameters:

specify what field data is to be returned

specify any conditional field data which will be used to limit the target data to be returned

if no conditional field data is provided, the sql query will not be constrained

provide a pointer to a list structure where the data to be returned



The dit_getTargets interface will build a database query from the user inputs and it will use the pointer to the list structure provided by the user to return the queried data.  Also, a status indicator will be returned to provide the user with  increased error handling diagnostics.



�

Control Flow



Create Target



The dit_createTarget control flow describes the steps to create a target from the TAMPS PLANNER_TARGETS database table.  The sql create command is built from the input parameter.  This function will return status of the sql create command.



�



Modify Target



The dit_modifyTarget control flow describes the steps to modify a target from the TAMPS PLANNER_TARGETS database table.  The sql modify command is built from the input parameters.  This function will return status of the sql modify command.



�



Delete Target



The dit_deleteTarget control flow describes the steps to delete a target from the TAMPS PLANNER_TARGETS database table.  The sql delete command is built from the input parameter.  This function will return status of the sql delete command.

�



Get Targets



The dit_getTargets control flow describes the steps to query the TAMPS PLANNER_TARGETS database table for planner targets.  The sql query is built from the input parameters.  This function will return status of query and any records found by the query.



�



Assumptions

Only mission planners will need the Target Application Interface functions. The DBA will use the MIDB Target Editor for target edits.

Concerns/Questions/Issues

What are the required fields in order to create a target?

What is the format for the surrogate key?

Is there sufficient need to also supply a Merge Planner Target capability for the DBA to move planner targets to MIDB database?

Risks

Using ODBC

Tasks

Write dit_createTarget

Write dit_modifyTarget

Write dit_deleteTarget

Write dit_getTarget

Provide handle functions for the user to call the Target Application Interface functions
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�Modifications

MIDB Installation CSC



Source Location�Action�Description���new ���

System Administration CSC



Source Location�Action�Description

��/tamps/src/libs/zsystem/zet�new�initialize BLTS server connection��/tamps/include/zsystem

   zrt_defines.h�

modify�

add new roles and privileges���modify�handle multiple databases��

MIDB Data CSC



Source Location�Action�Description���new�use new MIDB schema, tables, software��

MIDB Dataload CSC



Source Location�Action�Description���new�create new load scripts��/tamps/src/libs/dbase/dlt

   dlt_aiccb.c

   dlt_aicTape.c

   dlt_bcp.c

   dlt_bcpcb.c

   dlt_bcpIn.c

   dlt_cc_db.c�

modify modify

modify

modify

modify

modify�

use new DIA Loader for MIDB tables��/tamps/src/libs/util/ust

   ust_utils.c�

modify�

delete ust_dropUpdTriggers() function��/tamps/src/libs/util/utt

   utt_finds.c�

modify�

update queries looking for IDB% in sysobjects��

MIDB Interface CSC



Source Location�Action�Description��/tamps/src/libs/dbase/dat

   dat_delete.c

   dat_insert.c

   dat_update.c

   dat_tab_defs.c�

delete

delete

delete

delete�

not used

not used

not used

not used��/tamps/src/libs/dbase/dft

   dft_getOrderOfBattle.c

   dft_getTargetData.c



   dft_IDBF.c

   dft_IDBFQL.c

   dft_IDBFSITE.c

   dft_IDBU.c

   dft_IDBUL.c

   dft_IDBUQL.c�

modify

modify



delete

delete

delete

delete

delete

delete�

use new accessor functions to MIDB tables

use new accessor function to TAMPS target table

��/tamps/src/libs/dbase/dit�new�create accessor functions to MIDB tables��/tamps/src/libs/dbase/dmt

   dmt_DbaCoreManUpdate.c

   dmt_menu.c�



modify�



add Midb menu items��/tamps/src/libs/dbase/drt

   drt_remakrs.c

   drt_remkMMI.c

   drt_reUtils.c�

modify

modify

modify�

use new accessor functions to MIDB tables��/tamps/src/libs/dbase/include

   dft_priv_proto.h

   dil_priv_proto.h�

modify

modify�

delete idb functions

delete idb functions��/tamps/include_prot/dbase

   dft_prot_proto.h�

modify�

delete idb functions��

Data Archive CSC



Source Location�Action�Description��/tamps/src/libs/dbase/dut

   dut_datasets.c

   dut_dbucb.c

   dut_idb.c

   dut_matchRecs.c

   dut_archive_restore.c�

modify

modify

delete

delete�

modify references to IDB

update commentary

obsolete

not used

verify calls to utt functions��/tamps/src/libs/dbase/include

   dut_priv_proto.h�

modify�

delete dut_match_uql_to_uql_ext() function and dut_match_p_to_p_ext() function��

Interim Threat CSC 



Source Location�Action�Description��/tamps/src/libs/dbase/dil

   dil_DbaAddInterimThreatTo

      Idb.c

   dil_DeleteThreat.c

   dil_EditThreat.c

   dil_DbaThreatEditor.c

   dil_DataBucketRoutines.c



   dil_IdbQueries.c

   dil_IdbfQueries.c

   dil_IdbflQueries.c

   dil_IdbuQueries.c

   dil_InsertIdbRow.c

   dil_InsertIdbfRow.c

   dil_InsertIdbfqlRow.c

   dil_InsertIdbuRow.c

   dil_UpdateIdbData.c�

modify



modify

modify

modify

modify



delete

delete

delete

delete

delete

delete

delete

delete

delete�

use new accessor functions to MIDB threat data





update for object hierarchy changes



update image obj class structures��/tamps/include_prot/dbase

   dil_prot_proto.h�

modify�

delete idb functions��

MIDB Editor CSC



Source Location�Action�Description��/tamps/src/libs/intel/iot

   iot_aaa.c

   iot_aob.c

   iot_aobfix.c

   iot_eob.c

   iot_sam.c

   iot_samfix.c�

delete

delete

modify

modify

delete

modify���/tamps/src/libs/system/sit

   sit_defaultsMenu.c�

modify�

use new DIA Editors for each MIDB table��

Data Query CSC



Source Location�Action�Description���new�add multiple database capability��

Object Editor CSC 



Source Location�Action�Description���new�add MIDB objects to Object Hierarchy���new�add target object to Object Hierarchy����������

Query Processing CSC



Source Location�Action�Description������

Query Tool CSC



Source Location�Action�Description���new�add multiple database capability��

Target Data CSC



Source Location�Action�Description��/tamps/src/libs/a_msn_plan/adt

   adt_tgData.c

   adt_msn.c

   adt_genretr.c

   adt_obsoleteCHK.c�

modify

modify

modify

modify�

update insert and retrieve functions

use new accessor to retrieve target data

use new accessor to insert target data

add obsolete check for target data������/tamps/src/libs/products/prl�modify�use new accessor functions to target data��

Target Dataload CSC



Source Location�Action�Description���new �use new DIA Loader���new�create new load scripts����������

Target Editor CSC



Source Location�Action�Description��/tamps/src/libs/b_msn_tools/btt

   btt_deftgt.c

   btt_deftgtcb.c�

modify

modify�

update for new Planner Target dialog

update for new Planner Target dialog��

Target Interface CSC



Source Location�Action�Description������/tamps/src/libs/dbase/dit�new�new accessor functions to target data��/tamps/src/libs/maps/mmt�modify�use new accessor functions to target data��

Target Planning CSC



Source Location�Action�Description��/tamps/src/libs/a_msn_plan/adt�modify�use new accessor functions to target data������

�Interface Design Updates

Proposed IDD Modifications

adt_getTarget



Calling Sequence: ST_PUBLIC LIST *adt_getTarget

			   (short msn_id, int target_id, char *where_clause)



Description: 	This function retrieves targets from the database.  Returns a pointer to a list of target structures.  If no targets are found a NULL pointer is returned.  If the where clause (3rd argument) is null all targets are returned.  It is called by MPMs that require the ability to retrieve TAMPS targets from the database.  By default, this function returns all targets, unless arguments are specified.  This function must be modified because it currently uses accessor functions which will be deleted, and it will use the new accessor functions being developed under this SOR.

Proposed IDD Deletions

Proposed IDD Additions



dit_defines.h



The defines are used with the dit functions to query and modify data from the MIDB database.  Handle objects are used to provide an interface which will protect the user from changes to the MIDB database which do not affect MPM processing.



Arguments used in a query are added to the handle by using the uzt_setArg function.  The valid arguments are provided in this source file.  The handle is then used as a parameter to the MIDB query/update functions.  Each function uses the handle to determine which fields are being used.



The following is not a complete list of MIDB fields available to the user for query or update.



#define  dit_ALLEGIANCE	“allegiance”

#define  dit_BE_NUMBER	“be_number”



#define  dit_CATEGORY	“category”

#define  dit_CC	“cc”

#define  dit_CLASS_LVL	“class_lvl”

#define  dit_COORD	“coord”

#define  dit_COORD_BASIS	“coord_basis”

#define  dit_COORD_DATETIME	“coord_datetime”

#define  dit_COORD_DATUM	“coord_datum”

#define  dit_COORD_DERIV	“coord_deriv”

#define  dit_COORD_ROA	“coord_roa”

#define  dit_COUNTRY_CODE	“country_code”



#define  dit_DATETIME_CREATED	“datetime_created”

#define  dit_DATETIME_FIRST_INFO	“datetime_first_info”

#define  dit_DATETIME_LAST_CHG	“datetime_last_chg”

#define  dit_DATETIME_LAST_OBS	“datetime_last_obs”

#define  dit_DEGREE_INTEREST	“degree_interest”

#define  dit_DOMAIN_LVL	“domain_lvl”



#define  dit_ECHELON	“echelon”

#define  dit_ELEVATION	“elevation”

#define  dit_ELNOT	“elnot”

#define  dit_EQP_CODE	“eqp_code”

#define  dit_EQP_ID_NUM	“eqp_id_num”

#define  dit_EVAL	“eval”



#define  dit_FAC_NAME	“fac_name”

#define  dit_FUNCT_PRIMARY	“funct_primary”

#define  dit_FUNCT_SECONDARY	“funct_secondary”







#define  dit_LOC_REASON	“loc_reason”



#define  dit_MIL_GRID	“mil_grid”

#define  dit_MSN_PRIMARY	“msn_primary”

#define  dit_NOMEN	“nomen”

#define  dit_NUCLEAR_CAP	“nuclear_cap”



#define  dit_OB_TYPE	“ob_type”

#define  dit_OPER_STATUS	“oper_status”

#define  dit_OSUFFIX	“osuffix”



#define  dit_PIN	“pin”

#define  dit_QTY_OH	“qty_oh”

#define  dit_QTY_OH_EVAL	“qty_oh_eval”



#define  dit_RECORD_STATUS	“record_status”

#define  dit_RES_PROD	“res_prod”

#define  dit_REVIEW_DATE	“review_date”

#define  dit_RMK_TYPE	“rmk_type”

#define  dit_RMK_TEXT	“rmk_text”



#define  dit_UNIT_ID	“unit_id”

#define  dit_UNIT_NAME	“unit_name”

#define  dit_WAC	“wac”



#define DIT_SET_ON	“1”

#define DIT_SET_OFF	“0”

dit_enums.h



The following enumerations are used with the dit functions to query and modify data from the MIDB database. 



This enumeration is the return value for each of the dit functions.



	enum  DIT_STATUS 	{ DIT_SUCCESS = 0, DIT_FAILURE,

	DIT_NO_DATA_FOUND,

	DIT_MIDB_NOT_INSTALLED, 

	DIT_QUERY_FAILED,

	DIT_CREATE_HANDLE_ERROR,  DIT_CREATE_DATA_ERROR, DIT_MODIFY_DATA_ERROR, DIT_DELETE_DATA_ERROR, 

	DIT_MEMORY_ERROR }



This enumeration is used to identify the type of data being defined in the associated handle parameters in the dit functions.



	enum  dit_midbDataType 	{ DIT_FACILITY = 1, 

	DIT_EQUIPMENT, 

	DIT_UNIT, 

	DIT_TARGET, 

	DIT_ELINT,

	DIT_REMARKS 

	DIT_FACILITY_BY_EQP, 

	DIT_FACILITY_BY_UNIT,

	DIT_UNIT_BY_EQP, 

	DIT_UNIT_BY_FAC, 

	DIT_EQUIPMENT_BY_FAC, DIT_EQUIPMENT_BY_UNIT }



This enumeration is used as a parameter for the dit_createHandle function to identify how the handle will be used:



DIT_SELECT_FIELDS 	indicates that the handle defines the fields to retrieve from the MIDB database object



DIT_DATA_FIELDS	indicates that the handle defines the fields and their values to limit the records returned by the query



	enum  dit_itemType	{ DIT_SELECT_FIELDS, DIT_DATA_FIELDS }

DBPROCESS *dat_open_dbproc(const char *db_name, Boolean for_update)



This function will return a Sybase data connection to the database specified by the db_name parameter.



The for_update flag is used for a replicated database, where updates must be directed to the replication source, but queries can be directed to the local copy.  Initially, the only database that will use the for_update flag will be the MIDB database “GMI”, and only in a JMCIS-connected environment (if the flag is True, then the connection will be opened to the JMCIS database server, otherwise, the TAMPS database server will be used). This flag will be ignored for all other databases.  There is currently no plan for Core to attempt to detect and prevent updates of a database opened with a for_update value of False.

If there is already a connection open to the specified database, then that existing connection will be returned and a reference count for the connection will be incremented.  If not, it will open a new connection, change the current database to that specified, and return the new connection, setting the reference count to 1.  



It is recommended that dat_close_dbproc() be called when the connection is no longer needed by the calling routine.  If dat_close_dbproc() is not called, then the connection will remain open for the life of the application; it will, however, be returned by any future call to dat_open_dbproc() for the same database.  



The Sybase password will be obtained from the BLTS daemon.  The routine will return NULL on error.



void dat_close_dbproc(DBPROCESS *dbproc)



This function will close a Sybase data connection opened by dat_open_dbproc() if no other routine is using that connection.  It decrements the reference count associated with that connection, and, if the count reaches 0, closes the data connection.



SQLHDBC dat_open_odbc(const char *db_name, Boolean for_update)



This function is similar to the dat_open_dbproc() described above, except that it returns an ODBC database connection handle.  (SQLHDBC is an ODBC type definition for a database connection handle.)



The for_update flag is used for a replicated database, where updates must be directed to the replication source, but queries can be directed to the local copy.  Initially, the only database that will use the for_update flag will be the MIDB database “GMI”, and only in a JMCIS-connected environment (if the flag is True, then the connection will be opened to the JMCIS database server, otherwise, the TAMPS database server will be used). This flag will be ignored for all other databases.  There is currently no plan for Core to attempt to detect and prevent updates of a database opened with a for_update value of False.



If there is already an ODBC connection open to the specified database, then that existing connection will be returned and a reference count for the connection will be incremented.  If not, it will open and return a new connection, setting the reference count to 1.  



It is recommended that dat_close_odbc() be called when the connection is no longer needed by the calling routine.  If dat_close_odbc() is not called, then the connection will remain open for the life of the application; it will, however, be returned by any future call to dat_open_odbc() for the same database.  



The password will be obtained from the BLTS daemon.  The routine will return SQL_NULL_HDBC on error.



void dat_close_odbc(SQLHDBC hdbc)



This function will close an ODBC data connection opened by dat_open_odbc() if no other routine is using that connection.  It decrements the reference count associated with that connection, and, if the count reaches 0, closes the data connection.



The following are new protected TAMPS functions (expected to be available to all Core libraries and applications) that are envisioned for this SOR.  The exact names and parameter lists are tentative and subject to change.





dit_createHandle



Calling Sequence:  ST_PUBLIC UZT_HANDLE dit_createHandle 

			(enum dit_midbDataType dataType, enum dit_itemType itemType)



Description:	This function returns a handle object which represents a pointer to an object for the user to retrieve data for GMI queries.  The dataType input parameter specifies the type of data that will be associated in the handle.  The itemType input parameter specifies whether the handle will be used for identifying or storing data.  If the handle could not be created, a NULL handle is returned.

dit_deleteHandle



Calling Sequence: ST_PUBLIC DIT_STATUS dit_deleteHandle

			(UZT_HANDLE handle, dit_midbDataType dataType)



Description:	This function provides the user the capability to delete handle used to retrieve GMI data.  A status indicator is returned to the user which indicates any errors that may occur.

dit_getMidbData



Calling Sequence: ST_PUBLIC DIT_STATUS dit_getMidbData

			(enum dit_midbDataType dataType, 

			 UZT_HANDLE getFieldHndl, 

			 UZT_HANDLE queryFieldHndl, 

			 LIST *  returnData)



Description:	Thtbis function provides the user the capability to programmatically retrieve GMI data from the MIDB database.  The dataType input parameter indicates the type of GMI data to be retrieved.  The getFieldHndl input parameter specifies the column data to be retrieved for the specific GMI data type.  The queryFieldHndl input parameter specifies the conditional data which is used to limit the amount of data to be returned by the query.  The returnData input parameter is used to return the records found by the sql query.  Each item on the list is a handle to each record of GMI data.  When no records are found, the list will be empty.  A status indicator is returned to the user which indicates any errors that may occur.

dit_createMidbData



Calling Sequence: ST_PUBLIC DIT_STATUS dit_createMidbData

			(enum dit_midbDataType dataType,

			 UZT_HANDLE handle)



Description:	This function provides the user the capability to programmatically add new GMI record to the MIDB database.  The dataType input parameter indicates the type of GMI data to be created.   The handle input specifies the fields and values to create a new row in a GMI database table.  A status indicator is returned to the user which indicates any errors that may occur.

dit_modifyMidbData



Calling Sequence: ST_PUBLIC DIT_STATUS dit_modifyMidbData

			(enum dit_midbDataType dataType, int dataSK, 

			 UZT_HANDLE handle)



Description:	This function provides the user the capability to programmatically modify a record in a GMI table.  The dataType input parameter indicates the type of GMI data to be modified. The dataSK input parameter identifies which record is to be modified.  The handle input parameter identifies the new values of the record to be modified.  A status indicator is returned to the user which indicates any errors that may occur.  

dit_deleteMidbData



Calling Sequence: ST_PUBLIC DIT_STATUS dit_deleteMidbData

			(enum dit_midbDataType dataType, int dataSK)



Description:	This function provides the user the capability to programmatically delete a record from a GMI table.  The dataType input parameter indicates the type of GMI data to be modified. The dataSK input parameter identifies which record is to be deleted.  A status indicator is returned to the user which indicates any errors that may occur.

dit_createTargetHandle



Calling Sequence:  ST_PUBLIC UZT_HANDLE dit_createTargetHandle 

			(enum dit_itemType itemType)



Description:	This function returns a handle object which represents a pointer to an object for the user to retrieve data for target queries.  The itemType input parameter specifies whether the handle will be used for identifying or storing data.  If the handle could not be created, a NULL handle is returned.

dit_deleteTargetHandle



Calling Sequence: ST_PUBLIC DIT_STATUS dit_deleteTargetHandle 

			(UZT_HANDLE handle)



Description:	This function provides the user the capability to delete handle used to retrieve target data.  A status indicator is returned to the user which indicates any errors that may occur.

dit_createTarget



Calling Sequence: ST_PUBLIC DIT_STATUS dit_createTarget (UZT_HANDLE handle)



Description:	This function provides the user the capability to programmatically add a new target to the TAMPS PLANNER_TARGETS database table.  The handle input parameter specifies the fields and the values to create a new target row in the database table.  A status indicator is returned to the user which indicates any errors that may occur.



	The arguments in the handle are added by using the uzr_setArg function.  The valid arguments to create a target are defined in “dit_defines.h”.

dit_modifyTarget



Calling Sequence: ST_PUBLIC DIT_STATUS dit_modifyTarget 

			(int targetSK, UZT_HANDLE handle)



Description:	This function provides the user the capability to programmatically modify a target in the TAMPS PLANNER_TARGETS database table.  The target surrogate key and the fields identified in the handle are used to modify a target in the database table.  A status indicator is returned to the user which indicates any errors that may occur.



	The arguments in the handle are added by using the uzr_setArg function.  The valid arguments to modify a target are defined in “dit_defines.h”.

dit_deleteTarget



Calling Sequence: ST_PUBLIC DIT_STATUS dit_deleteTarget (int targetSK)



Description:	This function provides the user the capability to programmatically delete a target in the TAMPS PLANNER_TARGETS database table.  The target surrogate key input parameter is used to delete the target from the database table.  A status indicator is returned to the user which indicates any errors that may occur.

dit_getTargets



Calling Sequence: ST_PUBLIC DIT_STATUS dit_getTargets

			(UZT_HANDLE getFieldHandle, 

			 UZT_HANDLE queryFieldHandle,

			LIST * returnData)



Description:	This function provides the user the capability to programmatically retrieve target data from the TAMPS PLANNER_TARGETS database table. The getFieldHandle input parameter specifies the column data to be retrieved for the target data.  The queryFieldHndl input parameter specifies the conditional data which is used to limit the amount of data to be returned by the query.   The returnData input parameter is used to return the records found by the sql query.  Each item on the list is a handle to each record of target data.  When no records are found, the list will be empty.  A status indicator is returned to the user which indicates any errors that may occur.



Notes

Task Description

Within the following effort/task description, the software development tasks have, for the most part, been partitioned into what we consider the most reasonable breakdown.  The following table is provided as a key to what each sub-task contains, along with the CSCs defined in the SOF/SRS that these tasks can be mapped to.



TASK DESCRIPTION��Task�Description�SOF/SRS CSC��System Generation

Installation

Administration�All tasks that have to do with creating initial TAMPS environment, creating user accounts, setting up required COTS/GOTS, creating/initializing servers/databases.�System Generation 

MIDB Installation

System Administration ��MIDB Load�All tasks that have to do with loading/updating the MIDB database, including Archive/Restore.�MIDB GMI Data Load

MIDB Target Data Load

TAMPS Data Archive��MIDB DBA  Integration�All tasks that have to do with providing the DBA the capability to maintain the MIDB database, except for data load/update. Includes Add/Edit, JMCIS,  Target Definition, Scenario support.�MIDB GMI Data

MIDB GMI Editor

MIDB Target Data

MIDB Target Editor��MIDB Accessor API�All tasks that have to do with accessing the MIDB data from within an application. Includes API functions, as well as modifications to RTM/MERA, Messages, Reports.�MIDB GMI Interface

MIDB Target Interface��Object Database/Hierarchy�All tasks that have to do with accessing the MIDB data through the TAMPS object hierarchy. Includes the Object Editor, Query Tool, conversion scripts, and the underlying databases/data tables.�MIDB GMI Query

TAMPS Data Query

TAMPS Object Editor

TAMPS Query Tool ��MIDB MPM Integration�All tasks that have to do with integrating the various MPM capabilities with MIDB.�Interim Threat

Target Planning

Reports

Messages

RTM/Range Ring��



Source Lines of Code Estimates



CSC Name�New�Modify�Delete�Other��System Generation CSC�100�25��50��System Administration CSC�400�300��0��MIDB Installation CSC�1000�0����MIDB Data CSC�0�0����MIDB Dataload CSC�2000�2000����MIDB Interface CSC�2000�5000����Data Archive CSC�1000�500����Interim Threat CSC�400�1000��0��MIDB Editor�500�0����Data Query CSC�1000�1000����Object Editor CSC�1500�1500����Query Processing CSC�500�1000����Query Tool CSC�0�1300����Target Data CSC�500�1500����Target Dataload CSC�500�0����Target Editor CSC�500�0����Target Interface CSC�2000�0����Target Planning CSC�500�300����Total�� =SUM(ABOVE) �14400��� =SUM(ABOVE) �15425�����

Dependencies



DIA Software

to provide create scripts for the MIDB schema 

to provide load scripts to populate the MIDB objects

to provide individual editors for each MIDB object



MP LAN

to provide MIDB database updates to the client





ODBC

to provide public interface access to Sybase database



Sybase Replication Server

to provide replication from JMCIS CDBS to each client MIDB database



Risks



DIA software 

The load scripts may not work as advertised causing extra working to be done which impacts the schedule.

The table editors may not work as advertised causing extra working to be done which impacts the schedule.

The API functions to the editor may not work

Subsequent delivers of the software could cause re-work to be done



MP LAN 

may not do what we expect it to do

may not be available to use



ODBC 

might require extra code in order to work

learning time



JSIPS-N and targeting

difference in schema between JSIPS-N ETF/MTFs and TAMPS MIDB target tables

schedule migration of ETF/MTFs to MIDB schema format

configuration and control of data in target tables

Schedule









�Appendices



Appendix A TAMPS MIDB 2.0 Data Element Requirements



A.1  Introduction



This appendix is provided to document the columns required by various TAMPS Core software, as well as existing MPMs and planned MPMs.  



Only the tables and columns specifically identified as Core or MPM requirements are included in this appendix.  However, we may also need to create functions for certain other tables such as tie tables.  FAC_TIE, RMK_TIE, EQP_TIE, EQP_ELINT_MODE, SOURCE, and SOURCE_TIE are the likely candidates.  We may also need to create functions for certain views; this is still under investigation.  We will eventually include Unit of Measure (UM) fields, wherever they are appropriate.



The key to understanding the following tables is:



I	Interim Threat Update

O	Object Hierarchy

Q	Query

U	Update



For example, FAC.BE_NUMBER is critical to the Core Object Hierarchy, updated via the Interim Threat Update function, updated by TERPES, and queried by TAMMAC.  These tables are still incomplete, and may also change when the MIDB schema is baselined by the Defense Intelligence Agency (DIA).



�A.2 Facility Data Set

FAC Table



Column Name�Type�CORE

�A/C MPM�PGM MPM�TERPES�TAMMAC�JSIPS-N��access�char 9��������allegiance�char 3��������be�char 1�����Q���be_number�char 10�O,I���U�Q���category�char 5�O,I���U�Q���cc�char 2�O����Q���class_lvl�char 1�O���U�Q���condition�char 4�I����Q���coord�char 21�O���U�Q���coord_basis�char 2����U�Q���coord_datum�char 3�O����Q���coord_deriv�char 2����U�Q���coord_roa�float����U����datetime_created�char 14����U����datetime_first_info�char 14����U����datetime_last_chg�char 14�O���U����degree_interest�char 1����U����domain_lvl�char 2����U�Q���eval�char 1�O���U�Q���elevation�float��������fac_name�char 54�O,I���U�Q���fac_sk�positive int�O�������funct_primary�char 4�O���U����graphic_ed_date�char 8�����Q���graphic_ed_num�int�����Q���graphic_scale�int�����Q���graphic_series�char 5�����Q���graphic_sheet�char 15�����Q���ilat�int�O���U����ilon�int�O���U����last_chg_userid���������mil_grid�char 15�O�������oper_status�char 3�O,I���U�Q���osuffix�char 5�O,I���U����pin�char 5�O���U����record_status�char 1����U�Q���review_date�char 8�O����Q���wac�char 4����U����

�A.3 Equipment Data Set

EQP Table



Column Name�Type�CORE

�A/C 

MPM�PGM 

MPM�TERPES�TAMMAC�JSIPS-N��allegiance�char 3�O�������capacity�float��������capacity_max�float��������cc�char 2�O,I�������class_lvl�char 1�O,I���U����coord�char 21�O���U����coord_datetime�char 14����U����coord_roa�float�O���U����condition�char 4��������datetime_created�char 14����U����datetime_first_info�char 14����U����datetime_last_chg�char 14�O,I���U����datetime_last_obs�char 14�O���U����degree_interest�char 1����U����domain_lvl�char 2�I�������elevation�float��������eqp_code�char 7�O,I���U����eqp_id_num�char 3�O,I���U����eqp_sk�positive int�O�������eval�char 1�O���U����funct_primary�char 4�O���U����funct_secondary�char 4����U����height��O�������ilat�int�O,I���U����ilon�int�O,I���U����last_chg_userid���������loc_reason�char 9����U����max_demo_use�char 30��������mil_grid��I�������nomen�char 54�O,I���U����ob_type�char 1��������oper_status�char 3�O,I���U����qty_oh�int�O,I�������qty_oh_eval�char 1�O�������qty_pa�int��������qty_wa�int��������record_status�char 1�I���U����res_prod�char 2����U����review_date�char 8�O,I�������wac�char 4����U����





EQP_ELINT_MODE Table 



Column Name�Type�CORE

�A/C MPM�PGM MPM�TERPES�TAMMAC�JSIPS-N��class_lvl�char 1�O�������datetime_last_chg�char 14�O�������domain_lvl�char 2��������elnot�char 5�O���U����eqp_elint_mode_sk�positive int�O�������eqp_id_num�char 3����U����last_chg_userid���������record_status�char 1��������review_date�char 8�O�������



A.4 Equipment Index Data Set

EQP_IDX Table



Column Name�Type�CORE

�A/C MPM�PGM MPM�TERPES�TAMMAC�JSIPS-N��class_lvl�char 1�O�������datetime_last_chg�char 14�O�������domain_lvl�char 2��������eqp_code�char 7�O,I�������eqp_idx_sk���������eqp_type�char 30��������last_chg_userid���������nomen�char 54�O�������record_status�char 1��������review_date�char 8�O�������



�A.5 Unit Data Set

Unit  Table



Column Name�Type�CORE

�A/C MPM�PGM MPM�TERPES�TAMMAC�JSIPS-N��allegiance�char 3�O�������cc�char 2�O�������class_lvl�char 1�O�������coord�char 21�O�������condition�char 4�O�������datetime_last_chg�char 14�O�������domain_lvl�char 2��������duty_status�char 1��������echelon�char 4�O�������elevation�float��������eval�char 1�O�������funct_role�char 3��������ilat�int�O�������ilon�int�O�������last_chg_userid���������loc_reason�char 9��������msn_primary�char 4�O�������mil_grid�char 15��������nuclear_cap�char 1��������ob_type�char 1�O�������oper_status�char 3�O�������record_status�char 1��������review_date�char 8�O�������unit_id�char 10�O,I�������unit_name�char 54�O�������unit_num�char 6��������unit_sk���������wac�char 4��������



�A.4 Remarks Data Set

RMK Table



Column Name�Type�CORE

�A/C MPM�PGM MPM�TERPES�TAMMAC�JSIPS-N��class_lvl�char 1�O�������datetime_last_chg�char 14�O�������domain_lvl�char 2��������last_chg_userid���������rmk_sk���������rmk_type�char 4�O�������record_status�char 1��������review_date�char 8�O�������



RMK_LINE Table



Column Name�Type�CORE�A/C MPM�PGM MPM�TERPES�TAMMAC�JSIPS-N��class_lvl�char 1�O�������datetime_last_chg�char 14�O�������domain_lvl�char 2��������last_chg_userid���������rmk_line_sk���������rmk_text�char 255�O�������record_status�char 1��������review_date�char 8�O�������



�A.6 Tgt_Detail



Column Name�Type�CORE�A/C MPM�PGM MPM�TERPES�TAMMAC�JSIPS-N��azimuth�char 1��������azimuth_ref�char 5��������cc�char 2�O�������class_lvl�char 1�O�������coord�char 21�O�������coord_deriv�float�O�������coord_deriv_acc�float�O�������coord_deriv_acc_um�char 9�O�������coord_basis�char 2�O�������coord_datetime�char 14�O�������coord_roa�float�O�������coord_roa_conf_lvl��O�������coord_roa_um�char 9�O�������datetime_created�char 14��������datetime_last_chg�char 14�O�������domain_lvl�char 2��������dmpi_id�char 30�O�������elevation�float�O�������elevation_acc�float�O�������elevation_deriv�char 2�O�������elevation_deriv_acc�float�O�������elevation_deriv_acc_�char 9�O�������elevation_datum�char 3�O�������elevation_um�char 9�O�������hardness�char 1�O�������height�float�O�������height_um�char 9�O�������ilat�int�O�������ilon�int�O�������jmem_type�char 54�O�������last_chg_userid�char 8�O�������length�float�O�������length_um�char 9�O�������mil_grid�char 5�O�������mil_grid_sys�char 3�O�������record_status�char 1��������review_date�char 8�O�������shape�char 4�O�������tgt_detail_name�char 54�O�������tgt_detail_sk���������utm�char 16�O�������vertical_orient�float�O�������wac�char 4��������width�float�O�������width_um�char 9�O�������

Appendix B. MIIDS/IDB<-->MIDB 2.0 Mappings



B.1 Table Mapping



MIIDS/IDB Table Name�MIDB 2.0 Table�Comments��IDBF�FAC�Exceptions include: MSL_SYS_ID, which maps to EQP_IDX.EQP_CODE, and a few non-critical fields which map to EQP.  A tie table can be used to join “FAC and EQP_IDX.”��IDBFQL�EQP�Exceptions are that some “identifying” fields for the facility map to fields in FAC and are not repeated in EQP.  A tie table can be used to join “EQP and FAC.”��IDBFQL_ELINT_NOTE�EQP_ELINT_MODE�Exceptions are that some “identifying” fields for the facility and equipment map to fields in FAC and EQP, respectively.  These fields are not repeated in EQP_ELINT_MODE.  A tie table can be used to join “EQP_ELINT_MODE and FAC” and “EQP_ELINT_MODE and EQP.”��IDBQ�EQP_IDX�This is a clean map for all critical fields.��IDBR�RMK�Exceptions are that some “identifying” fields for the facility map to fields in FAC and are not repeated in RMK.  A tie table can be used to join “RMK and FAC.”��IDBR_TEXT�RMK_LINE���IDBU�UNIT�This is a clean map for all critical fields.  IDBU and IDBUL were combined into a single UNIT table.��IDBUL�UNIT�This is a clean map for all critical fields.  IDBU and IDBUL were combined into a single UNIT table.��IDBUQL�EQP�Exceptions are that some “identifying” fields for the facility and equipment map to fields in FAC and EQP, respectively.  These fields are not repeated in EQP.  A tie table can be used to join “EQP and FAC” and “EQP and EQP.”��



�B.2 IDBF Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��BE_NUMBER�FAC�BE_NUMBER���CATEGORY�FAC�CATEGORY���CLASS_LEVEL�FAC�CLASS_LVL���COORD_DERIVATION�����COORD_TYP_ACC�����COUNTRY_CODE�FAC�CC���DATE_FIRST_INFO�FAC�DATETIME_FIRST_INFO���DATE_LAST_CHG�FAC�DATETIME_LAST_CHG���DOMAIN�FAC�DOMAIN_LVL���FAC_COND�FAC�CONDITION���FAC_NAME�FAC�FAC_NAME���FAC_OPER_STAT�FAC�OPER_STATUS���GEODETIC_ELEV�����HEIGHT�����HARDNESS�����HITLIST���No mapping��LAST_OBSERVATION���No mapping��LATITUDE�FAC�COORD���LAT_HEMIS���Combined in COORD��LAT_RADIANS�FAC�ILAT���LONGITUDE�FAC�COORD���LONG_HEMIS���Combined in COORD��LONG_RADIANS�FAC�ILON���MAX_DEMO_USE�EQP�MAX_DEMO_USE���MSL_SYS_ID�EQP_IDX�EQP_CODE�FAC-->EQP_IDX via FAC_TIE value of “S B” (supported by).

EQP_IDX-->FAC via EQP_TIE value of “S  “ (supports).��NR_MSL_LAUNCHERS�EQP

EQP�CAPACITY

CAPACITY_MAX���OSUFFIX�FAC�OSUFFIX���RDESIG���No mapping��RECORD_STATUS�FAC�RECORD_STATUS���REVIEW_DATE�FAC�REVIEW_DATE���RMK_FLAG���No mapping��SITE_FUNC�FAC�FUNCT_PRIMARY���SUBJECT���No mapping��TGT_WIDTH�����TGT_MIL_GRID�FAC�MIL_GRID���TGT_GRAPHIC_REF���No mapping��VALIDITY�FAC�EVAL���WAC�FAC�WAC��� �B.3  IDBFQL Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��ANT_HEIGHT�EQP�HEIGHT���BE_NUMBER�FAC�BE_NUMBER���CATEGORY�FAC�CATEGORY���CLASS_LEVEL�FAC�CLASS_LVL���COUNTRY_CODE�EQP�CC���DATE_FIRST_INFO�EQP�DATETIME_FIRST_INFO���DATE_LAST_CHG�EQP�DATETIME_LAST_CHG���DOMAIN�EQP�DOMAIN_LVL���EQUIP_CODE�EQP�EQP_CODE���EQUIP_ID_NUMBER�EQP�EQP_ID_NUM���EQUIP_NOMEN�EQP�NOMEN���EQUIP_OPER_STAT�EQP�OPER_STATUS���EQUIP_QUANTITY�EQP�QTY_OH���EQUIP_QUANTITY_EVAL�EQP�QTY_OH_EVAL���FAC_NAME�FAC�FAC_NAME���HITLIST���No mapping��LAST_OBSERVATION�EQP�DATETIME_LAST_OBS���LOCATION_TYPE�����LATITUDE�EQP�COORD���LAT_HEMIS���Combined in COORD��LAT_RADIANS�EQP�ILAT���LONGITUDE�EQP�COORD���LONG_HEMIS���Combined in COORD��LONG_RADIANS�EQP�ILON���MODE���No mapping��OSUFFIX�FAC�OSUFFIX���PEQUIP_FUNC�EQP�FUNCT_PRIMARY���PIN�FAC�PIN���RDESIG���No mapping��RECORD_STATUS�EQP�RECORD_STATUS���REVIEW_DATE�EQP�REVIEW_DATE���ROA�EQP�COORD_ROA���SUBJECT���No mapping��VALIDITY�EQP�EVAL���

�B.4  IDBFQL_ELINT_NOTE Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��BE_NUMBER�FAC�BE_NUMBER���CATEGORY�FAC�CATEGORY���CLASS_LEVEL�EQP_ELINT_MODE�CLASS_LVL���DOMAIN�EQP_ELINT_MODE�DOMAIN_LVL���ELINT_NOTE�EQP_ELINT_MODE�ELNOT���LATITUDE�EQP�COORD���LAT_HEMIS���Combined in COORD��LAT_RADIANS�EQP�ILAT���LONGITUDE�EQP�COORD���LONG_HEMIS���Combined in COORD��LONG_RADIANS�EQP�ILON���MODE���No mapping��RECORD_STATUS�EQP_ELINT_MODE�RECORD_STATUS���SEQUENCE���No mapping��



B.5  IDBQ Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��CLASS_LEVEL�EQP_IDX�CLASS_LVL���DATE_FIRST_INFO�EQP_IDX�DATETIME_FIRST_INFO���DATE_LAST_CHG�EQP_IDX�DATETIME_LAST_CHG���DOMAIN�EQP_IDX�DOMAIN���EQUIP_CODE�EQP_IDX�EQP_CODE���EQUIP_COMMON_NAME�EQP_IDX����EQUIP_NOMEN�EQP_IDX�NOMEN���HITLIST���No mapping��NICKNAME�EQP_IDX_AKA����RDESIG���No mapping��SUBJECT���No mapping��

�B.6  IDBR Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��BE_NUMBER�FAC�BE_NUMBER���CATEGORY�FAC�CATEGORY���CLASS_LEVEL�RMK�CLASS_LVL���DATE_FIRST_INFO�RMK�DATETIME_FIRST_INFO���DATE_LAST_CHG�RMK�DATETIME_LAST_CHG���DOMAIN�RMK�DOMAIN_LVL���EQUIP_CODE�����HITLIST���No mapping��RDESIG���No mapping��RMK_TYPE�RMK�RMK_TYPE���SITE_ID�����SUBJECT���No mapping��UNIT_ID�����

B.7  IDBR_TEXT



To be supplied.



B.8  IDBU Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��ALLEGIANCE�UNIT�ALLEGIANCE�Field is now 3 characters��CLASS_LEVEL�UNIT�CLASS_LVL���DATE_FIRST_INFO�UNIT�DATETIME_FIRST_INFO���DATE_LAST_CHG�UNIT�DATETIME_LAST_CHG���DOMAIN�UNIT�DOMAIN_LVL���DUTY_STATUS�UNIT�DUTY_STATUS���ECHELON�UNIT�ECHELON���FUNCTIONAL_ROLE�UNIT�FUNCT_ROLE���HITLIST���No mapping��MISSION_SPECIALTY�UNIT�MSN_PRIMARY_SPECIALTY���NUCLEAR_CAPACITY�UNIT�NUCLEAR_CAP���OB_TYPE�UNIT�OB_TYPE���PMISSION_TYPE�UNIT�MSN_PRIMARY���RDESIG���No mapping��RECORD_STATUS�UNIT�RECORD_STATUS���RMK_FLAG���No mapping��SUBJECT���No mapping��UNIT_ID�UNIT�UNIT_ID���UNIT_NAME�UNIT�UNIT_NAME���UNIT_READINESS�UNIT�OPER_STATUS���VALIDITY�UNIT�EVAL���

�B.9  IDBUL Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��CLASS_LEVEL�UNIT�CLASS_LVL���DATE_FIRST_INFO�UNIT�DATETIME_FIRST_INFO���DATE_LAST_CHG�UNIT�DATETIME_LAST_CHG���DOMAIN�UNIT�DOMAIN_LVL���HITLIST���No mapping��LATITUDE�UNIT�COORD���LAT_HEMIS���Combined in COORD��LAT_RADIANS�UNIT�ILAT���LONGITUDE�UNIT�COORD���LONG_HEMIS���Combined in COORD��LONG_RADIANS�UNIT�ILON���LOCATION_TYPE�UNIT�LOC_REASON���MODE���No mapping��RDESIG���No mapping��RECORD_STATUS�UNIT�RECORD_STATUS���REVIEW_DATE�UNIT�REVIEW_DATE���SUBJECT���No mapping��UNIT_ID�UNIT�UNIT_ID���UNIT_NAME�UNIT�UNIT_NAME���

�B.10  IDBUQL Column Map



Column Name�MIDB 2.0 Table�Column Name�Comments��BE_NUMBER�FAC�BE_NUMBER���CATEGORY�FAC�CATEGORY���CLASS_LEVEL�EQP�CLASS_LVL���COUNTRY_CODE�EQP�CC���DATE_FIRST_INFO�EQP�DATETIME_FIRST_INFO���DATE_LAST_CHG�EQP�DATETIME_LAST_CHG���DOMAIN�EQP�DOMAIN_LVL���EQUIP_CODE�EQP�EQP_CODE���EQUIP_CONDITION�EQP�CONDITION���EQUIP_ID_NUMBER�EQP�EQP_ID_NUM���EQUIP_NOMEN�EQP�NOMEN���EQUIP_QUANTITY�EQP�QTY_OH���EQUIP_QUANTITY_EVAL�EQP�QTY_OH_EVAL���HITLIST���No mapping��LATITUDE�EQP�COORD���LAT_HEMIS���Combined in COORD��LAT_RADIANS�EQP�ILAT���LOCATION_TYPE���No mapping��LONGITUDE�EQP�COORD���LONG_HEMIS���Combined in COORD��LONG_RADIANS�EQP�ILON���MOBILITY_STATUS���No mapping��MODE���No mapping��OSUFFIX�FAC�OSUFFIX���OB_TYPE�EQP�OB_TYPE���PEQUIP_FUNC�EQP�FUNCT_PRIMARY���RDESIG���No mapping��RECORD_STATUS�EQP�RECORD_STATUS���REVIEW_DATE�EQP�REVIEW_DATE���SUBJECT���No mapping��UNIT_ID�UNIT�UNIT_ID���UNIT_NAME�UNIT�UNIT_NAME���VALIDITY�UNIT�EVAL���� �Appendix C Core Object Hierarchy Modifications

C.1  Introduction



This appendix is provided to document the changes expected in the Core Object Hierarchy .  



The planned changes include:

Remove object data related to RAAP

Remove object data related to the JMCIS tactical tables

Replace IDB object data with MIDB object data

Merge facility equipment objects and unit equipment objects into a single set of equipment objects

Consolidate Fixed SAM facility objects and Tactical SAM facility objects into a single set of SAM facility objects, in preparation for the CATEGORY field data fill change



Another change being considered, but not addressed in Figure C-1, is the creation of a “SAM variant” parent for the SAMs that have multiple variants.  This would simplify the individual queries provided to the planner.  Since the Fixed and Tactical SAMs will be combined into one set, the list of individual SAM facility queries will be quite long without consolidating the variant queries.  We will still provide specific symbols for each variant.



It is important to realize that object definitions are highly dependent on data fill.  The MIDB data will be reviewed constantly to ensure that the objects are defined properly.  We currently have a small set of MIDB test data.  We expect additional test data this summer.  



There are no known dependencies of MPMs on the object hierarchy definitions, except for the MPM Symbol Set import/export.  This only affects MPMs who have chosen to install an MPM symbol set and have mapped Core objects to MPM symbols.  Every effort will be made to keep the OBJECT_IDs the same from 6.1 to 6.2 (which will eliminate any impact to MPMs), but this will not be possible in all cases for the MIDB objects.  However, any problems resulting from an OBJECT_ID change can be taken care of during integration testing by editing the text file containing the MPM OH_GRAPHIC.BCP file.



Figure C-1 is provided to show the changes as they will appear in the object browser viewed through the TAMPS Core Object Editor or Query functions.  Root objects are shown in the leftmost column, their children are shown in the next column, and so on until there are no more ancestors.  Root object names are in alphabetical order from the top of the figure to the bottom of the figure, just as in the object browser display.  An object’s children are also in the same order as they appear in the object browser.  The difference between the object browser display and Figure C-1 is that a parent object name is shown many times if the object has more than one child.  This is a bit confusing, but it was the only way to easily capture the essence of the object hierarchy in a spreadsheet.



Modified objects are shown in Bold.  Objects which will be deleted are shown as Strikethrough.  Rearranged objects are shown as Underline.  Objects which need a name change are shown in Italic. Objects which may need to be changed or replaced due to changes in data fill for the CATEGORY field are shown in Shadow.

�
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�Appendix D Database Allocation Table







Database

 Name�Database Size (MB)��Log Device Size� NOTEREF _Ref388670052 �2�,��

Database

Description�TAMPS:

create

schema?�TAMPS:

load

data?��replicate

from

JMCIS?��Alerts�20�5�used by MIDB editors to process alerts.�Y�N�N��ASUP_DB�50�20������CONSTRAINTS�10��used in valid values checking within MIDB.�Y�Y�N��DB_SUPPORT�10�������GAZ�800��Gazetteer data�N�N�N��MDUIQU�10�������MS�20�5������OBSCON�10�5������SA�175�������SIR�20�5������SR_DB�15�10�Support Rule database used to validate MIDB data.�Y�Y�N��SUPPORT�50�25��Y�Y�N��TAPE_TOC�5�������UEW�10�������WORK_DB�500���holds temporary results from the DIA Query Tool�Y�N�N��tempdb�546� NOTEREF _Ref388670488 �5��������GMI�1800� NOTEREF _Ref388670488 �5��500�holds General Military Intelligence data -- the data used by TAMPS�Y�Y�Y��





� 

� As recommended by  the MIDB Software Installation Plan

� If no log size is entered, then the default log segment should be used.

� Data is loaded at MIDB Installation, except for GMI data

� If additional space is available, these databases should be increased in size
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dmt_qfq_delete_callback()

dmt_qfq_add_callback()

dmt_qfq_execute_callback()





9.1



8.1



9.4



9.2



9.1



10



8.2, 11



12



9.3



8, 8.3



7



dmt_query_browse_callback()

dmt_query_list_callback()

dmt_query_new_callback()

dmt_query_edit_callback()

dmt_query_delete_callback()

dmt_query_save_callback()

dmt_query_sub_convert_callback()

dmt_query_sub_delete_callback()

dmt_query_execute_callback()



1



6



8



obt_getBrowserForm()



oet_invokeSymbolMapping()



oet_editObject()



oet_deleteObject()



oet_createObjectCallback()



9



11, 12



11,12,13



3.2.5.3, 3.2.5.4



3.2.7.2



oet_tab*.c

oet_col*.c

oet_det*.c



oet_ll*.c



oet_sym*.c



oet_pick*.c



2



oet_actAttrs.c

oet_actMMI.c

oet_addAction.c

oet_attrMMI.c



2,3



2



9



3.2.5.1



dmt_qne_execute_callback()

dmt_qne_save_callback()

dmt_qne_delete_callback()

dmt_qne_edit_callback()

dmt_qne_cancel_callback()



1



1.1



1.2



1.3



1.4



1.5



1.6



3



4



5



5.1



5.2, 6



dmt_qnecond.c



dmt_qnepar.c



dmt_qnebtw*.c

dmt_qnein*.c



dmt_qneopcb.c



dmt_qnev*.c



dmt_qneres.c



DBA -> Update -> Threats



3



1

4

5,9



10, 11



dil_DisplayInterimThreats.c



dil_AddInterimThreat.c

dil_EditThreat.c

dil_DeleteThreat.c



dil_DbaAddInterimThreatToIdb.c



 MPM



 PDR



 PDR 








